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About This Guide

The IBM® WebSphere® Business Integration (WBI) Monitor™ Deployment guide will guide
you through the steps for deploying WBI Monitor. It also provides a technical background
about the WBI Monitor client-server architecture.

Introduction: Provides an introduction to the WBI Monitor architecture and a description of
the steps necessary to deploy the WBI Monitor in order to use it for monitoring business
processes.

Part 1 IBM WBI Monitor Architecture and Requirements

Chapter 1: WBI Monitor Architecture is intended for technical IT personnel interested in
learning about the client-server architecture of the WBI Monitor. In this chapter, you learn
about the WBI Monitor's main components, their communications flows and their
communications with other related applications.

Chapter 2: Necessary Requirements before Deployment lists the needed Hardware,
Software and System requirements in order to deploy WBI Monitor.

Part 2 IBM WBI Monitor Deployment on Windows, AIX® and Solaris Platforms

Chapter 3: Database Configuration describes the general steps for creating the Monitor
database and configuring both the Monitor and EventQueue databases.

Chapter 4: WBI Monitor Deployment on Windows, AIX and Solaris Platforms describes the
steps for deploying WBI Monitor on IBM WebSphere Application Server automatically using
the automated deployment wizard on Windows, AlX and Solaris platforms.

Appendix A: Manual Deployment of WBI Monitor on WebSphere 4.0.2 describes the manual
steps of deploying WBI Monitor on IBM WebSphere 4.0.2.

Appendix B: Manual Deployment of WBI Monitor on WebSphere 5.0 Describes the manual
steps of deploying WBI Monitor on IBM WebSphere 5.0 for both editions Application Server
and Network Deployment.

Appendix C: IBM DB2® 7.2 Database Server Configuration describes the detailed steps for
creating the Monitor database and configuring both the Monitor and EventQueue databases
on IBM DB2 Universal Database™ v7.2 as an example of the Database configuration’s
detailed steps.

Appendix D: Controlling the Logging Service in IBM WBI Monitor v4.2.4 describes the
detailed steps for controlling the logging service and setting the debugging level in order to
determine the message types that should be recorded in the log files.

Part 3 IBM WBI Monitor Deployment on OS/390° and z/OS™ Platforms
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Chapter 5: WBI Monitor Deployment on OS/390 and z/OS Platforms describes the steps for
creating the Monitor database and deploying WBI Monitor on IBM WebSphere on OS/390
and z/OS platforms.

Part 4 Upgrading your Existing Version of WBI Monitor to the Recent Version

Chapter 6: Upgrading your Existing Version of WBI Monitor to the Recent Version Describes
the steps required for upgrading your existing version of WBI Monitor to the recent version

Glossary: Includes detailed definitions of the terms mentioned in this guide.
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Introduction

Efficient business process management and continuous process improvement
require managers to monitor their business processes regularly. Competitive
pressures require management to effectively identify and rigorously assess
process changes that are needed to meet the demands of market changes.
Assessment of the effectiveness of changes in business strategies requires
monitoring of business processes.

The WBI Monitor has been built to fulfill these requirements. WBI Monitor is a
Java-based and Web-based client/server application that allows operation on
virtually any platform. The following sections give a brief introduction to the WBI
Monitor architecture and a description of the steps necessary to deploy the WBI
Monitor in order to use it for monitoring business processes.
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Chapter 1: WBI Monitor Architecture

The WBI Monitor consists of the Monitor Server, which is hosted on an
application server such as IBM WebSphere, and the following four distinct user
clients:

- Administration Utility
- Workflow Dashboard
- Business Dashboard
- Notifications
- Monitor Portlets
The Monitor Server consists of the following six modules:
- Client Agent EJB
- Monitor Engine
- Monitor Service
- Monitor Web Application
- Monitor Data Model
- Monitor API

The Monitor Server communicates with IBM MQSeries® Workflow, IBM
WebSphere MQ Integrator (WMQI) (or IBM WBI Message Broker), and IBM
WebSphere InterChange Server (WICS) through the Event Collector Triggers.
Those triggers are installed on the MQSeries Workflow runtime database in
case of using the MQSeries Workflow as the engine, or installed on the Monitor
database in case of using WMQI or WICS as the engine. These triggers copy
the events with the container data to the Monitor Event Queue tables. The data
in the tables stay in the database waiting for processing by the Monitor Engine.
The Monitor Server polls those tables to retrieve, process, and finally delete
these events from the Monitor Event Queue tables when processing is done.

© Copyright IBM Corp. 2002, 2004 7
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1.1 Monitor Server

The server works behind the scene to handle all the operations of the four user
clients. As mentioned before, it consists of six components:

- Client Agent EJB
- Monitor Engine
- Monitor Service
- Monitor Web Application
- Monitor Data Model
- Monitor API
These components are responsible for:
- Cleaning up the Monitor database tables
- Providing Data Security
- Importing the XML (modeling data) created in IBM WebSphere
Business Integration (WBI) Workbench™
- Handling the communication with user clients

- Handling the events coming from MQ Workflow, WebSphere MQ
Integrator (WMQI), WebSphere Business Integration Message
Broker, or WebSphere InterChange Server (WICS).

- Encapsulating the SQL statements for data access.

1.1.1 Client Agent EJB

This Session Enterprise Java Beans (EJB) is responsible for administering the
Monitor Server, and the communication between the Monitor Server and the
Monitor Clients. It handles the WBI Monitor database tables cleanup, data
security, and importing the XML file created in WBI Workbench.

1.1.2 Monitor Engine

This module handles events coming from MQ Workflow, WebSphere MQ
Integrator (WMQI), WBI Message Broker or WebSphere InterChange Server
(WICS). The Monitor Engine picks up the events, processes them, and stores
the output in the database for later retrieval by the clients. The processed
events are deleted after processing.

1.1.3 Monitor Service

The Monitor Service runs as a continuously running servlet, to asynchronously
call the Monitor Agent EJB to fetch the MQ Workflow, WMQI and WICS events

© Copyright IBM Corp. 2002, 2004 9



and process them. It is loaded at application startup from inside the Bootstrap
servlet.

1.1.4 Monitor web application

The Monitor web application contains all necessary web resources to run the
Monitor clients. These include JSP pages, servlets, HTML pages, images, etc...

1.1.5 Monitor Data Model

The Monitor Data Model is the database access layer of the Monitor Server.
The Monitor server uses Java Database Connectivity (JDBC). All Database
SQL statements are encapsulated in this layer.

1.1.6 Monitor API

The Monitor API is the Application Programming Interface layer of WBI Monitor.
It hides the details of the server implementation, and gives any developer the
capability to develop a customized user interface on top of the Monitor.

WBI Monitor client is actually built on top of this API. It has a published
documentation in the form of Javadoc HTML format. It can be used to:

- Develop customized reports user Interfaces

- Extract data from WBI Monitor, whether current or historical, to be used
in data warehousing for example.

- Access WBI Monitor Administrative functions

10 IBM WBI Monitor - Deployment Guide



1.2 WBI Monitor Administration Tools

The WBI Monitor Administration Tools allow users to perform all the necessary
steps to import the modeled business processes with their associated Business
Measures. It also provides the capability to maintain the Event Queue and
Monitor Database through managing the creation and dropping of these
databases’ tables, starting and stopping the event queue triggers, and cleaning
up unnecessary data.

1.2.1 WBI Monitor Administration Utility

The WBI Monitor Administration Client is a Web-based client that allows users
to do the following:

- Stop/restart the Event Queue triggers and create / Drop the Monitor
and Event Queue database tables.

- Import WBI Workbench's XML files that contain the organizations and
their processes and the Business Measures defined in WBI
Workbench.

- Delete the unnecessary process instances and history data that were
stored cumulatively in the monitor database after monitoring business
processes. This enables users to automatically clean up the WBI
Monitor database periodically as specified by a user-defined interval.

© Copyright IBM Corp. 2002, 2004 11



1.3 Monitor User Clients

The Monitor User Clients allow users to monitor the modeled business
processes and their associated Business Measures.

1.3.1 Workflow Dashboard

The Workflow Dashboard is an HTML-based client that allows users to monitor

the business processes at run time. The Workflow Dashboard allows users to
view the:

« Built-in and user-defined Business Measures.

« Status of Process, Activity, Work Item, and Employee Instances for the
whole Organization or for a particular Organization Unit.

1.3.2 Business Dashboard

The Business Dashboard is an HTML-based client that allows users to retrieve
and view the historical data of the monitored business processes and to view
and keep track of aggregated historical business measures.

1.3.3 Notifications

The Notifications is an HTML-based client that allows users to view all
notifications sent from process instances of a process at run time. A notification

is created and sent to specific user(s) according to the result of evaluating a
specific Boolean business measure.

1.3.4 Monitor Portlets

There are four WBI Monitor Portlets:
» Workflow Dashboard Portlet.
 Business Dashboard Portlet.

* Notification Portlet.

* Process Diagram Portlet.
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Chapter 2: Necessary Requirements
before Deployment

The following chapter describes the requirements for deploying the WBI
Monitor. It lists the hardware, system, and software requirements for the
Monitor Server and Web Clients.

© Copyright IBM Corp. 2002, 2004
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2.1 Monitor Server Requirements

2.1.1 Hardware Requirements

2.1.1.1 Windows Server

- Pentium 1ll 650 MHz or higher

- 512 MB RAM or higher (1 GB RAM recommended)

- 50 MB Disk space, in addition to sufficient disk space for database
2.1.1.2 AIX Server

- IBM RS/6000®
- 1 GB RAM or higher

- 50 MB Disk space, in addition to sufficient disk space for database.

2.1.1.3 Solaris Server

- Sun server machine
- 1 GB RAM, or higher

- 50 MB Disk space, in addition to sufficient space for database.

2.1.1.4 z/OS or s/390 Server

- IBM zSeries 900 or S/390 system
-1 GB RAM, or higher

- 50 MB disk space, plus sufficient space for database

2.1.2 System Requirements

2.1.2.1 Windows Server

- MS-Windows NT 4.0 (with Service Pack 4 or Higher) or MS-Windows
2000 Server

2.1.2.2 AIX Server
- AlX 4.3.3 or AIX 5.1 or later

2.1.2.3 Solaris Server

- Solaris 8, maintenance level August 2001 or later

14 IBM WBI Monitor - Deployment Guide



2.1.2.4 z/OS or s/390 Server

- OS/390 Version 2.8, Version 2.9, Version 2.10, or
- z/OS Version 1.1 or Version 1.2

2.1.3 Software Requirements

2.1.3.1 Windows, AIX, and Solaris Platforms

- IBM DB2 Universal Database version 7.2 with Fixpack 10, or IBM DB2
UDB V8.1

- Oracle 8i Database Server release 8.1.7.1 or Oracle 9i Database
Server release 9.0.1

- IBM WebSphere Application Server 4.0.2 Advanced Edition.Or
- IBM WebSphere Application Server v5.0 fixpack 1. Or

- IBM WebSphere Deployment Manager (Network Deployment) v5.0
fixpack 1.

- IBM MQSeries® Workflow 3.3.2 or IBM WebSphere MQ Workflow V3.4

- IBM MQSeries Workflow 3.3.2 Web Client or IBM WebSphere MQ
Workflow V3.4 Web Client. Either of these Web Clients should be
installed, but it is not necessary to be configured.

- IBM WebSphere MQ Integrator (WMQI) v2.1 or IBM WBI Message
Broker v5.0

* For WMQI v2.1:
- WMQI v2.1 CSD 6, or
- WMQI v2.1 CSD 5 with fix for APAR PQ77984, or
- WMQI v2.1 CSD 4 with fix for APAR PQ77984
* For WBI Message Broker v5.0:
- WBI Message Broker v5.0 CSD 1 (CSD 2 recommended).

[z%_| To monitor WebSphere Business Integration Message Broker and

oy WebSphere MQ Integrator Broker event flows, the WebSphere
Business Integration Message Broker MonitorEmitter node
SupportPac is required. This SupportPac named IBO1 and can be
downloaded free of charge from the WBI Message Broker support
Website.

- IBM WebSphere InterChange Server 4.2.2.1 Fix Pack.
- IBM WebSphere Portal Enable 4.2.0

- Java-enabled browser (IE 5.5 or higher).

© Copyright IBM Corp. 2002, 2004 15
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2.1.3.2 z/0OS and OS/390 Platforms

- IBM DB2 Universal Database for OS/390, Version 7.1 or higher
- IBM WebSphere Application Server V4.0.1 for z/OS and OS/390

- IBM MQSeries Workflow V3.3.2 SP3 or IBM WebSphere MQ Workflow
V3.4

- IBM MQSeries Workflow 3.3.2 Web Client or IBM WebSphere MQ
Workflow V3.4 Web Client.

- IBM WebSphere MQ Integrator (WMQI) v2.1.0 for z/OS:
* WMQI v2.1 CSD 6, or
* WMQI v2.1 CSD 5 with fix for APAR PQ77984, or
* WMQI v2.1 CSD 4 with fix for APAR PQ77984

To monitor WebSphere Business Integration Message Broker and
WebSphere MQ Integrator Broker event flows, the WebSphere
Business Integration Message Broker MonitorEmitter node
SupportPac is required. This SupportPac named IB0O1 and can be
downloaded free of charge from the WBI Message Broker support
Website.
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2.2 Monitor Clients Requirements

2.2.1 Hardware Requirements

- Pentium 111 650 MHz or higher
- 128 MB RAM or higher (256 MB RAM is recommended)

2.2.2 System Requirements

- Windows 98, Windows NT 4.0, Windows 2000, or Windows XP

2.2.3 Software Requirements

- Java-enabled browser (IE 5.5 or higher)

© Copyright IBM Corp. 2002, 2004
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IBM WBI Monitor
Deployment on
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Chapter 3: Database Server
Configuration

This chapter provides you with the configuration parameters and steps needed
for configuring your database server by creating the Monitor database and
configuring both the Monitor database and the Event Queue database (the IBM
MQSeries Workflow or the IBM WebSphere MQ Workflow database).

The instructions in this chapter assume that you are creating the WBI Monitor
database for the first time. If you have an earlier version of WBI Monitor and
there is an existing Monitor database that already contains data stored in its
tables, then you need to upgrade your database to adhere to the latest
modification in the current version of WBI Monitor 4.2.4 database, and migrate
the stored data to the upgraded database. Please refer to the chapter entitled:
Upgrading your Existing Version of WBI Monitor to the Recent Version for
details about the database migration.

The sections below will guide you through creating and configuring the
databases for IBM DB2 and Oracle database servers using all supported
versions in Windows, AIX and Solaris platforms. Please refer to the IBM DB2
and Oracle documentation for the required steps of creating and configuring the
databases.

You can refer also to Appendix C of this guide for an example of the detailed
steps of creating the Monitor database and configuring both the Monitor
database and the Event Queue database using IBM DB2 7.2 with fixpack 5 on
Windows platform.

© Copyright IBM Corp. 2002, 2004 21



3.1 Configuring IBM DB2

The following sections are for the required parameters for configuring IBM DB2
database for both IBM DB2 7.2 and IBM DB2 8.1 on Windows, AlX and Solaris
platforms:

Make sure that IBM DB2 Server is configured for JDK 1.2 or higher.

3.1.1 Create the Monitor Database

Create a new Database for Monitor. No specific name is required, though IBM
WBI Monitor recommends WFMDB as the Monitor database name.

3.1.2 Configure the Monitor Database

22

To enhance the performance and increase the system throughput, you should
configure Monitor database as well as the DB2 Instance hosting it by adjusting
the following configuration settings with the following values, and then restart
the DB2 instance:

Configuring the DB2 Instance Parameters:

Run the following database commands from the command line to set the
following instance parameters:

e db2set DB2_RR_TO_RS=YES

» db2set DB2_HASH_JOIN=Y

» db2set DB2_EXTENDED_OPTIMIZATION=ON
Configuring the Monitor database (WFMDB) Parameters:

Adjust the following Database configuration parameters with the following
values:

Parameter Name DB2 Parameter Name Parameter Location | Value

Maximum Storage for LOCKLIST Performance Tab/ 50000

Lock list Section

Application Heap Size | APPLHEAPSZ Performance Tab/ 4096
Section

Application Control APP_CTL HEAP_SZ Performance Tab/ 4096

Heap Size Section

Maximum Lock per MAXLOCKS Application Tab/Section | 50

application

Lock timeout LOCKTIMEOUT Application Tab/Section | 60

Group commit count MINCOMMIT Logs Tab/Section 3
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¢ Increasing the minimum commit count requires increasing
=5 the size of the transaction log to hold the transactions in the
i memory.

« In order for the above parameters to take effect, you must
bounce the DB2 instance for the instance parameters and
restart WebSphere Application Server for the database
parameters.

3.1.3 Calculate the Page Size

If one of the business processes in the organization file (.org) contains more
than 55 business measures, you should calculate the page size by performing
the following steps:

1. From the .org file, calculate the maximum number of business measures
in any process of the model

Divide the calculated number by 55

3. Round the result number up to the nearest integral value. (e.qg. if the
result is 1.3 then the you should round it up to 2)

4. Multiply the last value by 4K.

Round the result up to the nearest value of 8K, 16K, 32K, etc. This will
be the required page size. (E.g. if the result is 12K, then the required
page size is 16K)

3.1.4 Create a Buffer Pool

Create one or more Buffer Pools (No specific name is required) to be assigned
to the TableSpaces that will be created in the next step. Set the Page Size of
each of these new Buffer Pools to be equal to the calculated page size you
calculated in the previous step.

The performance of the WBI Monitor client’s dashboards depends on the size of
the created buffer pool that will be used to create the Monitor TableSpaces. For
dashboards reports that aquire large volumes of data, it is strongly

recommended to increase the Buffer Pool size to achieve better response time.

B *« You must bounce the DB2 instance to be able to use the
¥ created Buffer Pool.

« If you have created this Buffer Pool before, then you can
alter it to increase its size. and in this case you must bounce
the DB2 instance in order to use the Buffer Pool with the
new size.
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3.1.5 Create the Required TableSpaces

Create the required TableSpaces in both the Monitor Database (WFMDB) and
the EventQueue Database (FMCDB). WBI Monitor allows you to control the
distribution of the Monitor and the EventQueue Database tables and indices
into a number of TableSpaces. The database tables and indices are grouped
and categorized so that each category can be assigned to a separate
TableSpace.

This number is the maximum number of TableSpaces to which you can assign
the database tables and indices. This means you do not have to create all these
TableSpaces, but you can create part of them. In this case, during the
deployment steps, you can assign more than one group of tables or indices to
the same TableSpace.

Please refer to the section named Database Tables and Indexes Allocation with
Multiple TableSpaces below for details about the distribution of the Monitor and
EventQueue database tables and indexes on multiple TableSpaces.

For each created TableSpace, add the TableSpace container and specify its
name and directory.

5, The page size value of the MQ Workflow database table spaces is not
= affected by the number of business measures in the organization file
processes.

3.1.5.1 DMS vs. SMS TableSpaces

In DB2, there is a trade off between low maintenance and high performance
regarding the type of the used TableSpaces. System Managed Spaces (SMS)
provide low maintenance overheads with low performance, while Database
Managed Spaces (DMS) provide high performance but with higher maintenance
overheads than SMS TableSpaces.

Splitting a database table and its indices on two different TableSpaces is a
feature of DMS TableSpaces only.

[E5, For DMS TableSpaces, it is strongly recommended to use the same size
= for each container of the same tablespace to achive the optimum 1/O
operation.

25| Important Note: Please refer to IBM DB2 documentation for details about
¥ DMS Maintenance procedure
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3.2 Configuring Oracle Database

In case you decide to create a Database Instance for WBI Monitor, follow the
coming steps:

1. Create a new Database Instance for Monitor (No specific name is
required, but IBM WBI Monitor recommends WFMDB as the Monitor
Database Instance name).

2. Create the required TableSpaces in both the Monitor Database
(WFMDB) and the EventQueue Database (FMCDB). WBI Monitor
allows you to control the distribution of the Monitor and the EventQueue
Database tables and indices into a number of TableSpaces. The
database tables and indices are grouped and categorized so that each
category can be assigned to a separate TableSpace.

This number is the maximum number of TableSpaces to which you can
assign the database tables and indices. This means you do not have to
create all these TableSpaces, but you can create part of them. In this
case, during the deployment steps, you can assign more than one group
of tables or indices to the same TableSpace.

Please refer to the section named Database Tables and Indexes
Allocation with Multiple TableSpaces below for details about the
distribution of the Monitor and EventQueue database tables and indexes
on multiple TableSpaces.

3. For each created TableSpace, make sure that you allocate enough
storage for the expected growth rate of the data size.

4. Enable the Java VM on both the WFMDB instance that you have created
as the Monitor database, and the FMCDB database instance (the MQ
Workflow Database), which is usually created by the fmczutil
configuration utility of MQ-Workflow without the Java VM option.

24| You need to enable the Java VM option only if you have two separate

s database instances for the Monitor database and the EventQueue
database. In case you are using the FMCDB instance as the Monitor
database (Single Instance), then you don’t need to perform this step.

5. Create a new user that will be used by the WBI Monitor server to access
the Monitor database.

- Make sure that the UNLIMITED TABLESPACE System Privilege is
Granted for this user.

If you decide to use the FMCDB Instance (The MQ Workflow database) as the
Monitor database instance (single instance for both), then the WBI Monitor will
use the Monitor Connection User (WFM) to access the FMC Schema (the MQ
Workflow database schema) in order to perform the following database actions:

- DDL actions
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* CREATE TABLE & DROP TABLE
* CREATE TRIGGER & DROP TRIGGER

* CREATE SEQUENCE & DROP SEQUENCE
- DML actions

*

*

*

*

SELECT
INSERT
UPDATE
DELETE
EXECUTE TYPE
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3.3 Database Tables and Indexes
Allocation with Multiple
TableSpaces

3.3.1 In the Monitor Database (WFMDB):

« Administration tables and indexes can be assigned to Admin data Tables
and Admin Data Indexes TableSpaces respectively. The Monitor database
tables that will be associated with the first TableSpace are:

*

*

*

*

*

SCHEMA_HEADER
CONFIG_DATA

NEXT_ID
SYS_PROPERTIES
AGENTS

QUEUES
EB_SYNC_TABLE
MQ_SYNC_TABLE
WMQI_SYNC_TABLE
ICS_SYNC_TABLE
CLEANUP_SYNC_TABLE
NOTIFY_SYNC_TABLE

The indexes of the tables above will be assigned to the second
TableSpace.

« Static Model Data tables and indexes can be allocated to Static Model data
Tables and Static Model Data Indexes TableSpaces respectively. The
Monitor database tables that will be associated with the first TableSpace

are:

*

*

© Copyright IBM Corp.

ORG_UNIT
ORGANIZATION
ROLE_DATA
USER_DATA
PROCESS
PROCESS_MODEL
ACTIVITY
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The indexes of the tables above will be assigned to the second
TableSpace

* Runtime Data tables and indexes can be allocated to Runtime Data Tables
and Runtime Data Indexes TableSpaces respectively. The Monitor
database tables that will be associated with the first TableSpace are:

* PROCESS_INST
* ACTIVITY_INST
* WORK_ITEM

* VARIABLES

* NOTIFY

The indexes of the tables above will be assigned to the second
TableSpace.

» Events Data tables and indexes can be allocated to Events Data Tables
and Events Data Indexes TableSpaces respectively. The Monitor database
tables that will be associated with the first TableSpace are:

* EVENTS

* DELAYED_EVENTS

* MBEVENTS

* CXFLOWEVENTRECORDS

The indexes of the tables above will be assigned to the second
TableSpace.

 Process Data tables and indexes can be allocated to Process Data Tables
and Process Data Indexes TableSpaces respectively. The Monitor
database table that will be associated with the first TableSpace is:

* PROCESS_DATA
The index of the table above will be assigned to the second TableSpace.

 Security tables and indexes can be allocated to Security Tables and
Security Indexes TableSpaces respectively. The Monitor database tables
that will be associated with the first TableSpace are:

* SECGROUP

* SECGRPMEMBER
* SECACTION

* SECSECOBJTYPE
* SECACL

* SECACE

* SECPERMISSION
* SECSECSESSION
* SECUSER
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* SECSECMANAG

* SECPRINCIPAL

* SECSECTYPE

* SECANDORCONSTR
* SECAND

* SECOR

The indexes of the tables above will be assigned to the second
TableSpace.

« Different Large Objects (LOBSs) tables can be assigned to several LOB
TableSpaces as in the following:

* Static Model Lob table can be allocated to Static Model Lob
TableSpace. The Monitor database table that will be associated with
this TableSpace is:

- PROCESS_MODEL

* Process Data Lob table can be allocated to Process Data Lob
TableSpace. The Monitor database table that will be associated with
this TableSpace is:

- PROCESS_DATA

* Configuration Data Lob table can be allocated to Configuration Data
Lob TableSpace. The Monitor database table that will be associated
with this TableSpace is:

- CONFIG_DATA

* Notify Extra Data Lob table can be allocated to Notify Extra Data Lob
TableSpace. The Monitor database table that will be associated with
this TableSpace is:

- NOTIFY

* Event Data Lob table can be allocated to Event Data Lob TableSpace.
The Monitor database table that will be associated with this
TableSpace is:

- EVENTS

* Delayed Event Data Lob table can be allocated to Delayed Event Data
Lob TableSpace. The Monitor database table that will be associated
with this TableSpace is:

- DELAYED_EVENTS

* WBI Message Broker Lob table can be allocated to WBI Message
Broker Lob TableSpace. The Monitor database table that will be
associated with this TableSpace is:

- MBEVENTS
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3.3.2 In the MQ Workflow Database (FMCDB):

30

* MQ Workflow Connector Queue (EventQueue) tables and indexes can be
allocated to EventQueue Tables and EventQueue Indexes TableSpaces
respectively. The database tables that will be associated with the first
TableSpace are:

* HS_AUDIT_TRAIL

* HS_CONT_DETAIL
* HS_PROC_DATA
* HS_SCHEMA

The indexes of the tables above will be assigned to the second
TableSpace.

* MQ Workflow Data Lobs can be allocated to MQWF Data Lobs
TableSpace. The database table that will be associated with this
TableSpace is:

* HS_CONT_DETAIL
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3.4 Using the National Language
Support (NLS)

To serve as many users as possible, WBI Monitor v4.2.4 provides Globalization
features in order to support using multiple languages other than English.

The supported code pages are:

1252 - English 1255 - Hebrew

1252 - French 1256 - Arabic

1252 - German 932 - Japanese

1252 - Italian 936 - Chinese (Traditional)
1252 - Portuguese 950 - Simplified Chinese
1252 - Spanish 949 - Korean

(24 | Note: Switching GUI and text direction to Right-to-Left is not supported in
2" | this release.

The support for multiple languages rather than the English language requires
that the WBI Monitor database must be created with UTF-8 code page.

If you have created the monitor database with a different code page (for
example IBM-1252), whether as a new database for the recent version of WBI
Monitor or for any previous version of WBI Monitor, and you need to allow using
multiple languages then you must export all tables of the WBI Monitor schema
(defaults to WFM unless changed) and import these tables into a newly created
database with UTF-8 code page before the database migration. Please consult
your Database Administrator for information about converting the code page of
an existing database.
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Chapter 4: WBI Monitor Installation

This chapter provides a step-by-step procedure that guides you through
Installing IBM WebSphere Business Integration (WBI) Monitor with all its
components and deploying the Monitor Server on Windows, AlX and Solaris
platforms. The chapter also contains the procedures of un-deploying the
Monitor Server and how to completely uninstall WBI Monitor. At this stage, it is
assumed that all the prerequisite software has been installed, and the Monitor
and Event Queue databases have been created and configured successfully.

The following conventions are used for all the instructions throughout this
document:

- <WebSphere> : The WebSphere home directory. e.g. C:\WebSphere

- <MQ> : The MQ Workflow home directory. (For example:
C:\WebSphere\AppServer on Windows platform, /usr/WebSphere/
AppServer on AlX platform, or /opt/WebSphere/AppServer in Solaris
platform).

- <DB2> : The DB2 home directory. (For example: C:\SQLLIB)

- <Oracle>: The Oracle home directory on the Oracle Server machine
(if Oracle is not running on the same machine on which the IBM
WebSphere Application Server is installed). For example:
C:\oracle\ora81 (Local) or \oracle_machine\oracle\ora81 (Network)

- <Monitor> : The Monitor installation directory. (For example:
C:\WBIMonitor)

- <WebServerName> : The name of the machine that hosts the Web
server for which the WebSphere is configured. (For example: The
machine name on which the IBM HTTP Server or Microsoft IS 4.0 or
[IS 5.0 is installed)

- <ServerName> : The name of the server on which the Monitor will be
installed.

- <WebPath>: The monitor web application web path (For example: /
monitor).

Important Notes:

- On AlX and Solaris platforms, use forward slash / instead of back-slash
\ when writing paths.

- The names and paths of folders and files are case sensitive.

- The names and paths of folders and files that you will specify during
the installation should not contain any spaces. (For example, the
Monitor installation directory, the WebSphere home directory, and/or
the DB2 home directory)
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Make sure that the user account you are using have all needed
permissions. For example, using a user account who has no
permissions on WebSphere or the Database will fail to install and
deploy the monitor.

On AIX 5.1 platform, the environment variable named LIBPATH must
be appended with the following paths: <MQ>/lib and <MQ>/lib/
mgserver. To do this, type the following command in the console
window from which you will start the WebSphere and then press Enter:

export LIBPATH=$LIBPATH:<MQ>/lib:<MQ>/lib/mgserver

The Monitor will not work if the server properties
client.encoding.override or default.client.encoding are set to any
encoding other than UTF-8.

If you are using WebSphere Application Server 4.0.5, the property
client.encoding.override=UTF-8 should be added explicitly in the
server JVM's settings. This must be done manually after you finish the
deployment if you performed the deployment automatically using the
WBI Monitor Installation Wizard as in the following steps:

* Open Administrator's console

* Select the Monitor Server from the Application servers
* Select the JVM Settings tab

* In the System Properties list, click Add

* Type client.encoding.override as the property name.
* Type UTF-8 as the value.

* Click apply and restart the server

Make sure to increase the parameter named Statement Cache Size of
the connection pool for all Data Sources that are created after
successful deployment. The default value for WebSphere Application
Server 4.x is 100 which is suitable for single threaded event processor.
You should increase it to enhance the system performance if you plan
to configure multiple event processors. The default value for
WebSphere Application Server 5.x is 10 which must be increased to
100 if you plan to use single threaded event processor or to more than
100 if you plan to configure multiple event processors.
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4.1 IBM WBI Monitor Installation
Wizard

The WBI Monitor is installed using the WBI Monitor Installation Wizard. This
wizard allows you to do the following:

* Perform only the manual installation of the WBI Monitor components by
extracting the necessary folders and files that are required for the
installation and deployment.

« Install the WBI Monitor components and perform the automatic
deployment for these components as follows:

* Perform the automatic deployment of the Monitor Server on IBM
WebSphere Application Server 4.0.2 or IBM WebSphere Application
Server 5.0 or IBM WebSphere Deployment Manager 5.0 on Windows,
AIX and Solaris platforms.

* Install the WBI Monitor Portlets on a specific WebSphere Portal
Server.

* Install the LDAP Bridge

The following sections in this chapter describe how to use the WBI Monitor
installation wizard to install these components automatically.

For a description of the manual deployment of Monitor Server on WebSphere
4.0.2, please refer to Appendix A of this guide: Manual Deployment of WBI
Monitor on WebSphere 4.0.2. For a description of the manual deployment of
Monitor Server on WebSphere 5.0, please refer to Appendix B of this guide:
Manual Deployment of WBI Monitor on WebSphere 5.0.

For a description of the manual installation of WBI Monitor Portlets on a
WebSphere Portal Server, please refer to the section entitled Installing WBI
Monitor Portlets in chapter 4 WebSphere Portal Support of the WBI Monitor
User Guide

For a description of how to Control the Logging Service in IBM WBI Monitor,
please refer to Appendix D of this guide: Controlling the Logging Service in IBM
WBI Monitor v4.2.4

4.1.1 Starting the WBI Monitor Installation Wizard

The WBI Monitor Installation Wizard starts by running the jar file named
WBIMonitor424.jar from the product CD or from the location where you have
extracted the contents of the zip file that you downloaded from the Internet.

Before starting the WBI Monitor Installation Wizard, you have to make sure that
an environment variable named WAS_HOME is defined and contains the actual
path of the IBM WebSphere Application Server installation directory. If this
variable is not defined, then you must define it by doing the following:
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* On Windows platform:

1. Open a command line window.

2. Type the following:
WAS_HOME = <WebSphere>
Set WAS_HOME

3. Run the WBIMonitor424.jar from this command line window.

¢ On AlIX or Solaris platforms:

1. Open a Terminal Console using root.

2. Type the following in the command line:
WAS_HOME= <WebSphere>
export WAS_HOME

3. Run the WBIMonitor424.jar from this terminal console.

If you are using IBM DB2 as the database server on AIX and Solaris platforms
only, make sure that you run the Installation wizard with a user who is in the DB2
Administrators group. You should also run at least once the <DB2>/db2profile
file from the same terminal console from which you will start the wizard. In order
to run the db2profile command:

1. Open aterminal console.
2. Change the directory to <DB2>.

3. Type the following in the command line and then press Enter:
../db2profile

4. Run the WBIMonitor424.jar file from the same terminal console.

You have to make sure also that the IBM JDK 1.3.0 is installed on your
machine. Alternatively, you can use the IBM JDK that is shipped with IBM
WebSphere Application Server.

To start the WBI Monitor Installation Wizard, run the WBIMonitor424.jar file by
doing the following:

* On Windows platform:
1. Start a command prompt window.
2. Type the following in the command prompt and then press Enter:

java.exe -jar G:\\WBIMonitor424.jar

Where G: is your CD drive name. Replace this name with the actual name of
your CD drive or with the location where the WBIMonitor424.jar file exists.

If the java.exe is not included in the Path environment variable path then type
the full path of java.exe (e.g. C:\WebSphere\AppServer\java\bin\java.exe).

* On AIX and Solaris platforms:
1. Start a terminal console as root.

2. Type the following in the command prompt and then press Enter:
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java -jar /tmp/WBIMonitor424.jar
Where /tmp is the location where the WBIMonitor424.jar file exists.

If the java is not included in the PATH environment variable, then type the full
path of java (e.g. "/usr/WebSphere/AppServer/java/bin/java" in AlX platform or
"lopt/WebSphere/AppServer/java/bin/java” in Solaris platform)

In the following sections of this chapter, you will be guided through the detailed
steps of using the WBI Monitor Installation Wizard to install the WBI Monitor

components.
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4.2 WBI Monitor Server Installation
and Deployment

The Monitor Server component can be deployed automatically on WebSphere
Application Server using the WBI Monitor Installation Wizard by selecting the
Automatic Deployment as the deployment type.

The wizard will lead you through a set of steps to gather the required
information for the Monitor Server deployment, and then the wizard will deploy
the Monitor Server automatically.

The following are the wizard steps for installing and deploying Monitor Server:

1. The WBI Monitor Installation Wizard starts on the Welcome screen. For
all wizard steps, to go forward to the next step, click Next. To go back to
the previous step click Back. You can exit the wizard at any time by
clicking Cancel.
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2. The next screen is the License Agreement. Read the License
Agreement carefully and select the | accept the terms in the License
Agreement radio button to accept the agreement, then Click Next to
continue. If you select the | do not accept the terms in the License
Agreement then you will exit this installation wizard.
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3. Inthe next screen you should enter the Monitor installation directory
(<Monitor>) where the necessary folders and files will be extracted.
This directory also will be the WBI Monitor Working Directory. You can

accept the default path or change this path to a new folder. Then, you
can click Next to continue.
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4. The next screen is the Deployment Type where you can select one of
the following deployment types:
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- Manual Deployment: Selecting this option will only extract all
necessary folders and files that are required for deploying all WBI
Monitor components into the destination folder. In this case you will
need to perform the deployment of each component manually.

- Automatic Deployment: Selecting this option will let this installation
wizard perform all needed steps for installing the WBI Monitor

Components and perform the WBI Monitor Server deployment
automatically.

Al

@ Flesse selec] he ons of he iollowing depleymant pes

o Bhwunnl Deplosarintt. Saloring Mt opoon will (e sutrsd] 3l neceasany Iiders and Sl el are
required for deploving a8 V01 Mosshor compondnts indo tha desBnaSon folded in Fus caso you Wil
need b peslorm e de {ef enth i Fruipally

= Mitomalic (eployiment Gisicing Tt o¥on will le] g install#ton winend fo guide vour Beough &
nesded Heps ff ingEalkng P WEN Mondor Comgonents e perfem e WEH Monace Sene
didpiiyrrant womab sy

CHck Mead 0 Conirss

Fldain anied T niquined fonmaaticn

Baliec! Ma depdoymanl b
% jusormane Depdorrenl
™ Manus Deploymant

epack | Heds | cane |

Select the Automatic Deployment option and then click Next to
continue.

The next screen of the WBI Monitor Installation Wizard appears if you
select the Automatic Deployment option as the deployment type. In
this screen, you should select one or more of the WBI Monitor
components to be installed. Select the Monitor Server option to install

and deploy the WBI Monitor Server component and then click Next to
continue.
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6. In the next wizard screen you will be asked to enter the path and the
type of the Database JDBC driver file. For IBM DB2 database, this driver
file is named db2java.zip and is located in the <DB2>\Javal2 folder.
For Oracle database, this driver file is named classes12.zip and is
located in the <Oracle>\jdbc\lib folder. Enter the required path or click
Browse to select the path. Then select the driver type from DB Driver
Type combo box. If the entered path is not correct, then you will be
informed by a message, and the wizard will not continue until you enter
the correct path. Then, you can click Next to continue.
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7. Inthe next screen you will be asked to enter the following information for
the Monitor database:

- In the Name/URL field, enter the Monitor database name (or the
database URL).

* |If you are using Oracle database server, then type the following for
the Monitor database URL:

jdbc:oracle:thin:@<Oracle_Server_Name>:<Oracle_Server_Po
rt_Number>WFMDB

* Where <Oracle_Server_Name> is the name or the IP address of
the Oracle Database Server machine, and
<Oracle_Server_Port_Number> is the Oracle Server Port
Number (the default port is 1521)

- In the User Name and Password fields, enter the user name and
password of the Monitor database administrator.

- In the Schema field, enter the Monitor database schema (The default
value is WFM).

*

In Oracle Database, the Monitor database schema must be the
same as the Database Administrator's User Name

The wizard will check the connection with the database using the
entered database name (or URL), user name and password. If one or
more of the entered parameters are not correct, then you will be
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informed by a message, and the wizard will not continue until you enter
the correct parameters. Then click Next to continue.
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The wizard will also check this database to verify if it is a newly created
database or a database of an earlier version of the WBI Monitor that
requires to be upgraded to the recent version's modifications. If the
specified database belongs to the previous version of WBI Monitor, then
a message will appear to tell you that the specified database belongs to
a previous version of WBI Monitor, and it needs to be upgraded using
the Database Migration Utility before starting this Installation Wizard.
Then the wizard will be terminated.

(74 | Please refer to the section entitled WBI Monitor Database

¥ Migration in Chapter 6: Upgrading your Existing Version of WBI
Monitor to the Recent Version in this guide for detailed
information about the Database upgrade.

8. After you enter the Monitor database information and if the , you should
specify the names of the required TableSpaces for each group of tables
and indexes in the Monitor database as follows:

- In the Default TableSpace field, type the name of the TableSpace that
you want to set as the default TableSpace. This TableSpace will be
used as the TableSpace of any tables or indexes group for which you
have not specified a TableSpace.

3 | Ifyou leave this field empty, then the database default TableSpace
¥ will be considered and used as the default TableSpace.

] iy
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- Inthe Administration section, type a TableSpace name for each of the
following:

* Administration Tables.
* Administration Indexes.

- In the Static Model Data section, type a TableSpace name for each of
the following:

* Static Model Data Tables.
* Static Model Data Indexes.

- In the Runtime Data section, type a TableSpace name for each of the
following:

* Runtime Data Tables.
* Runtime Data Indexes.

- In the Events Data section, type a TableSpace name for each of the
following: (These TableSpaces are used for the Event Queue (MQ
Workflow) database):

* Events Data Tables.
* Events Data Indexes.

- In the Process Data section, type a TableSpace name for each of the
following:

* Process Data Tables.
* Process Data Indexes.

- In the Security section, type a TableSpace name for each of the
following:

* Security Tables.
* Security Indexes.

- In the Large Objects TableSpaces section, type a TableSpace name
for each of the following:

* Static Model Lob.

* Process Data Lob.

* Configuration Data Lob.

* Notify Extra Data Lob.

* Event Data Lob.

* WBI Message Broker Lob.

You can specify a different TableSpace name for each group of tables or
indexes. Alternatively, you can specify the same TableSpace for more
than one group of tables or indexes. In the later case these groups of
tables and/or indexes will use the same TableSpace for storing the data
physically on the hard drive.
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If you leave a blank field without specifying a TableSpace name, then the
default TableSpace will be used for the corresponding group of tables or
indexes.

The specified TableSpace should have been previously created in the
Database server. Otherwise, the deployment will not be performed
properly and you will not be able to create the database tables.

[z%. | In case you have an existing database that belongs to a previous

o version and contains data, then you will only be able to enter the
default TableSpace. All other fields that can hold the multiple
TableSpaces Names will be disabled.

Click Next to continue.
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9. Inthe next screen you will be asked to select the workflow engine(s) that
the WBI Monitor will monitor their run-time data. There are two workflow
engines that can be selected:

- MQSeries Workflow / WebSphere MQ Workflow
- WebSphere MQ Integrator (WMQI) / WBI Message Broker
- WebSphere InterChange Server (WICS)
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You can select one of these options or you can select a combination of them.
According to your selection, the wizard steps will vary to let you enter the
required information for the selected option as will be described in the following
sections.

If the specified WBI Monitor database belongs to a previous
version of WBI Monitor, then the MQSeries Workflow / WebSphere
MQ Workflow option will be selected by default and its check box
will be disabled so that you cannot de-select it.

4.2.1 MQ Workflow is Selected

46

If you select the MQ Workflow option, whether you select it alone or with
another option (WMQI and/or WICS), you must enter the following information:

» The MQ Workflow Configuration parameters.
* The MQ Workflow Database (the Event Queue Database) parameters.

In this case the WBI Monitor will be forced to authenticate the logged users to
WBI Monitor Client through the MQ Workflow. That means any user who will
login to WBI Monitor Client must be an MQSeries Workflow registered user, and
only MQSeries Workflow users have the privilege to log in to WBI Monitor
Client.

The following are the wizard screens that appear when you select the
MQSeries Workflow / WebSphere MQ Workflow option:
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1. Inthe next screen you will be informed that the wizard will check for the
existence of the IBM MQ Workflow and its database. Click Next to
continue.
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2. In the next screen you will be asked to enter the following IBM MQ
Workflow Configuration parameters in each corresponding field:

- BM MQSeries Workflow Library: The MQSeries Workflow library file
named fmcojagt.jar and located in the <MQ>\bin\java3320 folder if you
are using IBM MQSeries Workflow 3.3.2 or located in the
<MQ>\bin\java3400 if you are using IBM WebSphere MQ Workflow
3.4. (You can click the Browse button represented as triple dots to
select this file).

- Configuration Id: The used MQ Workflow Configuration ID (Default or
Non-Default).

- Encoding: The MQSeries Workflow server machine encoding. (This
property must be set if the MQ Workflow server machine encoding is
different from the Monitor Server machine encoding).

Enter the required values for each corresponding field and click Next to
continue.
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Important Note: In MQ Workflow, a default configuration must be
defined.

3.

In the next screen you will be asked to enter the following information for
the IBM MQ Workflow database (The Event Queue Database):

- In the Name/URL field, enter the MQ Workflow database name or the
database URL.

*

If you are using Oracle database server, then type the following
for the MQ Workflow database URL.:

jdbc:oracle:thin:@<Oracle_Server_Name>:<Oracle_Server_Po
rt_Number>:FMCDB

where <Oracle_Server_Name> is the name or the IP address of
the Oracle Database Server machine, and
<Oracle_Server_Port_Number> is the Oracle Server Port
Number (the default port is 1521)

- In the Administrator and Password fields, enter the user name and
password of the MQSeries Workflow database administrator.

- In the Schema field, enter the MQSeries Workflow database schema
(The default value is FMC).

* |n Oracle Database, the Event Queue database schema must be
the same as the Database Administrator's User Name.

- In the MQ Workflow Connector Queue section, type the TableSpaces
names for each of the following:

*  Tables
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* Indexes
*  Large Objects (LOBS)

You can specify a different TableSpace name for each of these three
fields. Alternatively, you can specify the same TableSpace for more
than one field. In the later case these groups of tables and/or indexes
will use the same TableSpace for storing the data physically on the
hard drive.

If you leave a blank field without specifying a TableSpace name, then
the default TableSpace will be used for the corresponding group of
tables or indexes.

The specified TableSpace should have been previously created in the
Database server. Otherwise, the deployment will not be performed
properly and you will not be able to create the database tables.

The wizard will check the connection with the database using the entered
database name (or URL), user name and password. If one or more of the
entered parameters are not correct, then you will be informed by a message,
and the wizard will not continue until you enter the correct parameters.

[z4 | In case you have an existing database that belongs to a previous

o version and contains data, then you will not be able to define
multiple TableSpaces, and the TableSpaces Names fields will be
disabled.

Click Next to continue.
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4.2.2 MQ Workflow is not Selected

If you select WebSphere MQ Integrator (WMQI) / WBI Message Broker and/or
WebSphere InterChange Server (ICS) as the workflow engine, without selecting
the MQSeries Workflow / WebSphere MQ Workflow, then you will be asked to
enter the information about the authentication and security type that you will use
to authenticate the logged users to the WBI Monitor Client, as long as you will
not use the MQ Workflow authentication.

50

The following are the wizard screens that appear when you select WebSphere
MQ Integrator (WMQI) / WBI Message Broker and/or WebSphere InterChange
Server (ICS) as the workflow engine:

1. Inthe next screen, select the security mode you want to apply. You have
the option to select one of the following security modes:

Local Security: The Local security mode allows you to register any
user who is allowed to use the WBI Monitor locally in the WBI Monitor
database, so that each registered user's record contains the user
name and the password by which the logged user will be identified
each time he/she logs in to WBI Monitor Client.

LDAP Security: The LDAP (Lightweight Directory Access Protocol)
security mode depends on acquiring the user authentication
information from an external LDAP server. The LDAP Server is a
stand-alone, external server that holds a database of all employees
who have an identification record in the LDAP Server database. For
the LDAP Authentication method, any registered user in the LDAP
Server database can login to WBI Monitor client. When the user enters
his/her identification information (LDAP user name and password), the
LDAP server will check the information. If he / she passes the
authentication, then he will login to the WBI Monitor. The WBI Monitor
database does not hold the registered users' passwords that are used
for authenticating users. The WBI Monitor database holds only the
user name for setting the user's permissions.
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Select the appropriate security mode and then click Next to continue.
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2. The next screen appears only if you select the LDAP Security mode to
let you enter the required LDAP configuration parameters as follows:

- In the LDAP URL field: Type the LDAP Server URL and port number
(for example Idap://Idapsrvr:389/)

.| On AlX and Solaris platforms, type the LDAP server IP address
¥ instead of the server name

M

The remaining parameters are needed to allow logging in to WBI Monitor client
using only the User ID, instead of having to supply the full Distinguished Name
(DN). In this case, WBI Monitor queries the LDAP Server for the full DN of this
user using these parameters, and then uses the obtained full DN for login.

The required parameters are:

- In the Server Bind DN field: Type a Distinguished Name (DN) for an
LDAP Server authorized user that will be used for logging in to this
LDAP Server, and performing the search in the LDAP users' tree.

- In the Server Bind Password field: Type the password of the defined
User DN.

=Ly | The Server Bind DN and Server Bind Password fields are optional.

o If you leave these fields empty without specifying a user then the
user anonymous will be used. In this case this user should have at
least read/search access rights on the LDAP directory.
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- In the Naming Attribute Holding Login ID field: Type the name of the
prefix that precedes the user ID in the LDAP Server database (i.e. CN,
UID,...etc). The value of this parameter varies between the different
types of LDAP Servers.

- In the Base of Search field: Type the starting point in the LDAP tree
from which the query will start searching for the full DN of the given
user ID.

- In the DN Attribute ID field: Type the name of the Distinguished Name
attribute 1D (for example distinguishedName, entrydn ...etc. This value
is case sensitive).
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- Click Next to continue.

4.2.3 Continuing the Wizard Steps

Now after entering the required information according to the selected engine,
the wizard steps will continue to complete installing the Monitor Server
component.

1. Inthe next screen, you will be asked to enter the Installed version of IBM
WebSphere Application Server and its installation path.

- Select the version of IBM WebSphere Application Server you are using
from the WebSphere Version drop down list (WebSphere 4 or
WebSphereb).

- Enter the location where the IBM WebSphere is installed:

* For IBM WebSphere Application Server, Version 4.0.2 & IBM
WebSphere Application Server, Version 5.0, enter the location of
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the AppServer folder that is located in the WebSphere installation
folder.

* For IBM WebSphere Deployment Manager (Network Deployment),
Version 5.0, enter the location of the DeploymentManager folder
that is located in the WebSphere installation folder.

Enter the required path or click Browse to select the path. If the entered path is
not correct, then you will be informed by a message, and the wizard will not
continue until you enter the correct path. Then, you can click Next to continue.
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2. In the next screen, you will be informed with the Monitor Server
installation summary. The wizard now is ready to start extracting the
necessary folders and files needed for installing the WBI Monitor Server
Component and then update the Monitor Enterprise Archive file
(monitor.ear) with the new parameters that you have specified in the
wizard steps. Click Next to continue.
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3. After extracting the necessary folders and files needed for WBI Monitor
Server deployment, the wizard now is ready to do the following:

- Generate the deployment script that is used for deployment.
- Deploy WBI Monitor using the generated deployment script.
You have the option to do either of the following:

« To generate the deployment script and deploy WBI Monitor, select the
Deploy check box.

« To generate the script only, clear the Deploy check box.

The created deployment script will be placed in <Monitor>\install directory. To
deploy the Monitor by using this script, run the batch file named
monitorinstall.bat in Windows platform (or the file named monitorinstall.sh in the
AIX or Solaris platforms) in the previous path. Now click Next to continue.
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Important:

In order to deploy the WBI Monitor automatically by selecting the Deploy
check box, the automatic deployment wizard must connect to WebSphere
Application Server using the SOAP port. The SOAP port should have the
default value, which is 8880.

If you are using IBM WebSphere Network Deployment or if two or more
installations of WebSphere Application Server exist on the same machine
on which you will install the WBI Monitor, then the SOAP port number may
have different value other than this default value.

In this case you will get a message that says “WASX7023E: Error creating
"SOAP" connection to host "localhost"; exception information:
com.ibm.websphere.management.exception.ConnectorNotAvailableExce
ption WASX7213I: This scripting client is not connected to a server
process; please refer to the log file <WebSphere>\logs\wsadmin.traceout
for additional information.” when the wizard starts the deployment if you
select the Deploy check box. However, the deployment will not start. You
should then un-check the Deploy check box in the wizard, and then do the
following:

 Obtain the actual value of the SOAP Port. To do this:
* Open the IBM WebSphere Administrative Console.

* From the left hand tree, select System Administration >
Deployment Manager.

* From the Deployment Manager configuration page, click the End
Points hyperlink in the Additional Properties table.
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* Click the SOAP CONNECTOR ADDRESS hyperlink from the End
Point Name column.
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« Update the file named executetool.bat (or executetool.sh) that is located
under the <Monitor>\server\install directory as follows:

* On Windows platform:

- Open the executetool.bat for edit.

- Locate the following two lines:

if "%WAS_Version%"=="was_5.0"call
%WAS_HOME%\bin\wsadmin.bat -conntype SOAP -port
<Port_Value> -f was5\InstallMonitor.tcl

if "%WAS_Version%"=="was_5.0" call
%WAS_HOME%\bin\wsadmin.bat -conntype SOAP -port

<Port_Value> -f was5\UninstallMonitor.tcl

- Replace the value that exists instead of this variable <Port_Value>
with the SOAP Address port number that you have obtained.

* On AlX and Solaris platforms:

- Open the executetool.sh for edit.

- Locate the following two lines:
${WAS_HOME}/bin/wsadmin.sh -conntype SOAP -port

<Port_Value> -f was5/InstallMonitor.tcl;
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${WAS_HOME}/bin/wsadmin.sh -conntype SOAP -port
<Port_Value> -f was5/UninstallMonitor.tcl;

- Replace the value that exists instead of this variable <Port_Value>
with the SOAP Address port number that you have obtained.

* Run the batch file named monitorinstall.bat on Windows platform (or the
file named monitorinstall.sh on the AIX or Solaris platforms) from the
command line to perform the deployment.

4. Now the WBI Monitor Server installation has finished. You will need to

start the deployed Application Server from the WebSphere
Administrator's Console, in order to run WBI Monitor. Click Finish to exit

this installation wizard.
00
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4.2.4 Start the New Application Server

4.2.4.1 For IBM WebSphere Application Server 4.0.2

1. Start the WebSphere Administrator's Console.

2. In the WebSphere Administrative Domain tree, right-click Nodes >
<ServerName> > Application Servers > MonitorServer and select Start

from the shortcut menu that appears.
3. Wait until the confirmation message appears, and then click OK.

4.2.4.2 For IBM WebSphere Application Server 5.0

You must restart the Default Server (serverl) after you deployed the WBI
Monitor new Application Server. To do this:
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1. On Windows platform, run a command prompt window. On AlX or
Solaris platforms start a terminal console window.

Change the directory to <WebSphere>\bin

3. Type the following command line:
stopServer serverl

[z%_| For AlXand Solaris platforms, type stopServer.sh serverl. This
¥ command is case sensitive.

4. Wait until the Application Server is stopped and the confirmation
message appears, and then type the following command line:

startServer serverl

[4_| For AlX'and Solaris platforms, type startServer.sh serverl. This
4 command is case sensitive.

5. Wait until the Application Server is started and the confirmation
message appears.

4.2.4.3 For IBM WebSphere Deployment Manager
(Network Deployment) 5.0

Start the installed WBI Monitor Enterprise Application.
From the WebSphere Administrative Console, do the following:

1. From the left hand tree, select Applications > Enterprise
Applications. The Enterprise Applications page appears.

2. Select the IBM_WBI_Monitor application by selecting the check box
next to its name.

3. Click Start

4.2.5 Finalize the Monitor Server Deployment

4.25.1 Initialize the Monitor Database

1. Run a Web browser (such as MS Internet Explorer)

2. Type the following URL:
http://<WebServerName><WebPath>/admin
(eg. http://monitorsrvr/monitor/admin)

The Login Page appears

3. Enter the User ID and Password of a valid user. (Please refer to the WBI
Monitor Administration Guide for detailed information about the WBI
Monitor authentication and security options). The Administration Utility
Web page opens.

58 IBM WBI Monitor - Deployment Guide



4. Create the Monitor Database tables. Please refer to the WBI Monitor
Administration Guide for the detailed instructions of creating Monitor
database tables.

5. Close the browser.

4.2.5.2 Importing Organization XML Files

You have to import the required organization XML files to the WBI Monitor
database in order to complete the deployment instructions.

25 Please refer to the WBI Monitor Administration Guide for the
: etailed instructions of importing organization iles.
=" | detailed i i fi i ization XML fil

4.2.6 WBI Monitor Server Un-Deployment

This section is used to completely un-deploy the Monitor Server from
WebSphere. To do this:

4.2.6.1 For IBM WebSphere Application Server 4.0.2

1. Stop the running MonitorServer application server.

2.  Run the batch file named monitoruninstall.bat in Windows platform or
the file named monitorUninstall.sh in AIX or Solaris platforms. These
files are located in <Monitor>\install. This will uninstall WBI Monitor

automatically.

3. Delete the file monitor_deployed.ear from
<WebSphere>\AppServeninstallableApps\

4. Delete the directory named MonitorServer which is located in
<WebSphere>/temp/<WAS_NODE_NAME>/

4.2.6.2 For IBM WebSphere Application Server 5.0 and
IBM WebSphere Deployment Manager 5.0

1. Run the batch file named monitoruninstall.bat in Windows platform or
the file named monitorUninstall.sh in AIX or Solaris platforms. These
files are located in <Monitor>\install. This will uninstall WBI Monitor
automatically.

24 | For IBM WebSphere Application Server 5.0, the log files are shared
¥ between the different applications so that it will not be deleted.

2. Delete the directory named MonitorServer which is located in
<WebSphere>/temp/<WAS_NODE_NAME>/
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This directory does not exist if you have deployed the WBI Monitor
Application Server on the default (base) Application Server named
serverl

3. Restart the WebSphere Application Server
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4.3 Installing the WBI Monitor Portlets
Component

The WBI Monitor Portlets component can be installed automatically using the
WBI Monitor Installation Wizard. This will install the four WBI Monitor Portlets
(Workflow Dashboard Portlet, Business Dashboard Portlet, Process Diagram
Portlet, and Notification Portlet) automatically into a specific WebSphere Portal
Server.

You will be guided through a set of steps to gather the required information for
installing this component, and then the wizard will install the Monitor portlets
automatically. Please refer to Chapter 4: IBM WebSphere Portal Support of the
WBI Monitor User Guide for detailed information about the support for
WebSphere Portal in WBI Monitor and how to install the WBI Monitor Portlets
manually.

(2% | Important Note: The Monitor Server installation and deployment
¥ must be performed before installing the WBI Monitor Portlets
component.

The following are the WBI Monitor Installation Wizard steps for installing the
Portal component:

1. The WBI Monitor Installation Wizard starts on the Welcome screen.
Click Next to continue.

2. Inthe License Agreement step, accept the License Agreement and click
Next to continue.

3. Enter the Monitor installation directory where the necessary folders and
files will be extracted. Then, click Next to continue.

4. Inthe Deployment Type step, select Automatic Deployment and click
Next to continue.

5. Inthe Installed Component step select the WBI Monitor Portlets
option and click Next to continue.
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In the next wizard screen that appears after the Installed Component

screen, you will be asked to enter the required configuration parameters
of the WebSphere Application Server and WebSphere Portal Server as
the following:

- In WAS Directory field, enter the location where the IBM WebSphere
Application Server is installed (For example:
C:\WebSphere\AppServer). You can click Browse to select the
directory location.

- In the Portal Directory, enter the location where the IBM WebSphere
Portal Server is installed (For example: C:\WebSphere\WebSphere
Portal). You can click Browse to select the directory location.

- In the Domain field, enter the DNS Domain name on which the
WebSphere Portal server is installed. (for example: egy.ibm.com)

- In the Portal Administrator User Name and Password fields, enter
the user name and password of one of the WebSphere Portal Server
administrators that will be used to login to the Portal Server and
perform the installation.

- In the Configuration Page URL field, enter the URL that is used to
access the portal configuration servlet. This URL consists of the portal
host name, the base URL for the portal, as specified during installation
(for example /wps), and the servlet extension (/config).
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Click Next to continue
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7. In the next screen, you will be informed with the Portal installation
summary. The wizard now is ready to start installing the WBI Monitor
portlets on the specified WebSphere Portal Server.

Click Next to continue.

“Bark | Hede cancel
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8. Now the WBI Monitor Portlets installation has finished. Click Finish to
exit this installation wizard.

PR -
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4.4 Installing the Monitor LDAP Bridge
Component

The Monitor LDAP Bridge component is necessary to be installed if you are
using IBM WebSphere MQ Workflow 3.4 that depends on an LDAP server for
acquiring the users’ information. In this case any changes in the users'
information/definition that occurs in the LDAP server and are reflected in the
MQ Workflow should be also reflected in WBI Monitor in order to update the
processes and organization information in WBI Monitor with the changed
information in MQ Workflow.

Installing the Monitor LDAP Bridge component will extract only a folder named
Idapbridge in the specified destination directory. This folder contains a single .jar
file named Idapbridge.jar. By running this jar file the users information in WBI
Monitor will be updated with all changes that occurred in the LDAP Server from
which the MQ Workflow obtains the users information.

[z | Important Note: The Monitor Server installation and deployment
¥ must be performed before installing the Monitor LDAP Bridge
component.

The following are the WBI Monitor Installation Wizard steps for installing the
Portal component:

1. The WBI Monitor Installation Wizard starts on the Welcome screen.
Click Next to continue.

2. Inthe License Agreement step, accept the License Agreement and click
Next to continue.

3. Enter the Monitor installation directory where the necessary folders and
files will be extracted. Then, click Next to continue.

4. Inthe Deployment Type step, select Automatic Deployment and click
Next to continue.

5. Inthe Installed Component step select the Monitor LDAP Bridge
option and click Next to continue.
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6. Once you select to install the LDAP Bridge component from the Installed
Components step and clicked Next, you will be informed with the
Monitor LDAP Bridge installation summary. The wizard now is ready to
start installing the Monitor LDAP Bridge folder on the specified
destination directory.
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Click Next to start the installation.
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7. Now the Monitor LDAP Bridge installation has finished. Click Finish to
exit this installation wizard.

=10 |

Thi InstaliShiald Wizard has successiuly instalied WaikonRar, Chooase Finish o e Sw wizar

4.4.1 Running the Monitor LDAP Bridge

After you have installed the Monitor LDAP Bridge component, you will need to

run the installed jar file periodically in order to update the WBI Monitor database
with the changes that occurred in the LDAP Server on which the MQ Workflow
acquires the users' information.

To run the Monitor LDAP Bridge:
* On Windows platform:
1. Start a command prompt window.
2. Type the following in the command prompt and then press Enter:

java.exe -jar <Monitor> \ldapbridge\ldapbridge.jar -f <FDLFile> -u
<MonitorAdminUserName> -p <MonitorAdminPassword> -s
http://<WebServerName><WebPath>

B If the java.exe is not your environment variable path then type the
¥ full path of java.exe (e.g. C:\WebSphere\AppServer\java\bin\
java.exe)

* On AlX and Solaris platforms:

1. Start a terminal console using root.
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2. Type the following in the command prompt and then press Enter:

java -jar <Monitor> \Idapbridge\ldapbridge.jar -f <FDLFile> -u
<MonitorAdminUserName> -p <MonitorAdminPassword> -s
http://<WebServerName><WebPath>

If the java.exe is not your environment variable path then type the
full path of java.exe (e.g. "/usr/WebSphere/AppServer/javal/bin/
java" in AlX platform or "/opt/WebSphere/AppServer/java/bin/java"
in Solaris platform

Where:

* <FDLFile>: The full path and name of the FDL file that has been produced
by running the MQ Workflow LDAP Bridge. This file contains the updated
information for the organization units and their users that have been
changed in the LDAP Server and have been updated in the MQ Workflow.

* <MonitorAdminUserName>: A valid user name for a WBI Monitor
administrator.

* <MonitorAdminPassword>: the password of the specified administrator's
user name.

* http://<WebServerName><WebPath>: The web address that is used to
access the WBI Monitor Client. (for example: http://MonitorServer/
monitor).
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4.5 WBI Monitor Clustering Support
for WebSphere Deployment
Manager

As one of the major features of the IBM WebSphere Application Server v5.0.x,
WBI Monitor supports clustering deployment using the WebSphere 5.0.x
Application Server and Deployment Manager.

A Cluster is a set of application servers that are managed together for the
purpose of failover handling and participate in workload management. The
servers that are members of a cluster can be on different host machines, as
opposed to the servers that are part of the same node and must be located on
the same host machine.

Servers that belong to a cluster are members of that cluster set and must all
have identical application components deployed on them. Please refer to the
WebSphere Application Server and Deployment Manager v5.0.x documentation
for details about creating and configuring clusters.

In order to install and deploy the WBI Monitor in a cluster, there are two possible
cases:

« If you already have an existing cluster that is configured and its members
have running web applications, then you must install and deploy the WBI
Monitor on each member in that cluster using the manual deployment
steps (not the WBI Monitor Installation Wizard). Notice that each node
must point to the same database(s).

* If you are building a new cluster or adding a new node to a cluster on
which the WBI Monitor is installed and deployed, then you should install
and deploy the WBI Monitor on each cluster member, either automatically
using the WBI Monitor Installation Wizard or manually by performing the
manual deployment steps. Notice that each node must point to the same
database(s). This must be done before adding each machine to the
cluster.

74y | Please refer to Appendix B of this guide: Manual Deployment of
¥ WBI Monitor on WebSphere 5.0 for a description of the manual
deployment of Monitor Server on WebSphere 5.0

© Copyright IBM Corp. 2002, 2004 69



4.6 WBI Monitor Un-Installation

This section describes how to completely uninstall the WBI Monitor from your
machine using the WBI Monitor Uninstallation Wizard in order to remove all
folders and files that was installed by the WBI Monitor installation wizard. The
WBI Monitor Uninstallation Wizard starts by running the jar file named
uninstall.jar that is located in the <Monitor>\_uninst folder.

Before starting the WBI Monitor Uninstallation Wizard, make sure that the IBM
JDK 1.3.0 is installed on your machine. Alternatively, you can use the IBM JDK
shipped with IBM WebSphere Application Server.

To start the WBI Monitor Uninstallation Wizard:
1. Run the uninstall.jar file by doing the following:
- In Windows platform:
* Start a command prompt window.
* Type the following in the command prompt and then press Enter:

java.exe -jar <Monitor>\_uninst\uninstall.jar

25 If the java.exe is not your environment variable path then type the
& full path of java.exe (e.g.
C:\WebSphere\AppServer\java\bin\java.exe)

- In AIX and Solaris platforms:
* Start a terminal console using root.
* Type the following in the command prompt and then press Enter:

java -jar <Monitor>/_uninst/uninstall.jar

[z%_| If the java.exe is not your environment variable path then type the

& full path of java.exe (e.g. "/usr/WebSphere/AppServer/java/bin/
java" in AlX platform or "/opt/WebSphere/AppServer/java/bin/java"
in Solaris platform

70 IBM WBI Monitor - Deployment Guide



2. Once you start the Uninstallation wizard, a Welcome dialog box
appears. Click Next to continue through the wizard or click Cancel to
exit the wizard.

& Uninstaller =10 x|

Welcome to the nstallShield Wizard for WEINMonitor

Net» || cancel |

3. The next screen contains the Home Directory on which the WBI Monitor
was installed and the installed components. Click Next to start removing
these installed components and remove the files and folders from your
hard drive, Back to return to the previous step, or Cancel to exit the
wizard.

A Uninstaller =lo0] x|
‘Wilkonitor will be uninstalted from the following location:

CaBIMonitord 24
‘with the fallowing features:

Sanmar

Portal
LDAP bridge

< Back |=""rTéuE'-:|| Cancel I
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screen will tell you that the Uninstallation Wizard has finished
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uninstalling the WBI Monitor from your system. Click Finish to exit the
wizard.

& Uninstaller =10 x|

The InstalZhield Wizard has successiully uninstalled YWEIMonfor. Choose
E Finlsh to et the wizard.

Finish_||
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Appendix A: Manual Deployment of
WBI Monitor on
WebSphere 4.0.2

This appendix describes the manual steps of deploying WBI Monitor on IBM
WebSphere 4.0.2. Before starting these steps, it is assumed that the Monitor
Database (and Event Queue Database if you are using MQ Workflow as your
engine) with the required Table Spaces are created and configured in your
Database Server.

The following conventions are used for all the instructions throughout this
document:

- <WebSphere> = The WebSphere home directory. e.g. C:\\Websphere

- <MQ> = The MQ Workflow home directory. (e.g. c:\\fmcwinnt on
Windows platform, /user/fmc on AlX platform, or /opt/fmc on Solaris
platform)

- <DB2> = The DB2 home directory. e.g. c:\sqllib

- <Oracle> = The Oracle home directory on the Oracle Server machine
(if Oracle is not running on the same machine on which the IBM
WebSphere Application Server is installed). e.g. C:\oracle\ora81
(Local) or \\oracle_machine\oracle\ora81 (Network)

- <Monitor> = The Monitor installation directory where the WBI Monitor
has been installed. e.g. C:\WBIMonitor

- <WebServerName> = The name of the machine that hosts the Web
server for which the WebSphere is configured. (Ex. The machine name
on which the IBM HTTP Server or Microsoft IIS 4.0 or IS 5.0 is
installed)

- <ServerName> = The name of the server on which the Monitor will be
installed.

On AlX and Solaris platforms, use forward slash / instead of back-slash \ when
writing paths.

Important notes:

- The names and paths of folders and files are case sensitive.

- Make sure that the user you are using have all needed permissions.
For example, using a user who has no permissions on WebSphere or
the Database will fail to deploy the monitor.

- On AIX 5.1 platform, the environment variable named LIBPATH must
be appended with the following pathes: <MQ>/lib and <MQ>/lib/
mgserver. To do this, type The following command in the console
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window from which you will start the WebSphere and then press Enter:
export LIBPATH=$LIBPATH:<MQ>/lib:<MQ>/lib/mqserver

- The Monitor will not work if the server properties
client.encoding.override or default.client.encoding are set to any
encoding other than UTF-8.

If you are using WebSphere Application Server 4.0.5, the property
client.encoding.override=UTF-8 should be added explicitly in the
server JVM's settings.
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1  Monitor Server Deployment

1.1 Configure IBM WebSphere

B In Windows NT or Windows 2000, make sure that the IBM WS
=" | AdminServer service is started and running.

The purpose of these steps is to create and configure a new Application Server
in WebSphere. The Application Server resides inside the Monitor Server.

In order to perform this operation, start the WebSphere Administrator’s
Console and perform the following steps:

1.1.1 Create JDBC Provider and Data Sources

(2% | If a previous driver is already created and installed, then you can
¥ skip the following steps for creating and installing the database
drivers for the data source.

You need to create the required Database Drivers and their Data Sources. The
creation of the Database Drivers and their Data Sources should be performed
as the following sequence:

1. If you are not using IBM MQ Workflow as your engine or If the Monitor
database and the Event Queue database are located in the same
physical database:

- Create and install only one Pool Database Driver.

- Create only one Pool Data Sources under the created Pool Database
Driver points to the Monitor database.
2. If the Monitor database and the EventQueue database are located in
two physical databases:
- Create and install one Pool Database Driver.

- Create two Pool Data Sources under the created Pool Database Driver
(one Data Source points to the Monitor database and the other Data
Source points to Event Queue database).

- Create and install one XA Database Driver.

- Create two XA Data Sources under the created XA Database Driver
(one Data Source points to the Monitor database and the other Data
Source points to Event Queue database).

The following table provides the required values for the each Database Driver
and Data Source as you should enter through the creation steps:

For Monitor Pool JDBC Provider:
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Driver File path

Property/Field DB2 Oracle

Name

Name MonitorDB2PoolDriver MonitorOraclePoolDriver
Database JDBC db2java.zip classes12.zip

Driver File Name

Database JDBC <DB2>\java\ <Oracle>\jdbc\lib

Implementation
Class

PoolDataSource

COM.ibm.db2.jdbc.DB2Connection

PoolDataSource

For Monitor Pool Data Source:

Property/Field Name

Value

Name

Monitor_Pool_DataSource

JNDI Name

MonitorPoolDataSource

For Event Queue Pool Data Source:

Property/Field Name

Value

Name

Event_Queue_Pool_DataSource

JNDI Name

EventQueuePoolDataSource

For Monitor XA JDBC Provider:

Property/Field DB2 Oracle
Name
Name MonitorDB2XADriver MonitorOracleXADriver
Database JDBC db2java.zip classes12.zip
Driver File Name
Database JDBC <DB2>\javal2\ <Oracle>\jdbc\lib
Driver File path
Implementation COM.ibm.db2.jdbc.DB2XADataSource | oracle.jdbc.xa.client.OracleXADataSource
Class
For Monitor XA Data Source:
Property/Field Value
Name
Name Monitor_ XA DataSource
JNDI Name MonitorXADataSource
For Event Queue XA Data Source:
Property/Field Name Value
Name Event_Queue_XA_DataSource
JNDI Name EventQueueXADataSource
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The following sections describe the required steps that you should follow to
create and install a JDBC Provider and to create a Data Source under this
driver:

Create and Install the JDBC Provider

Creating a JDBC Provider:
To create a JDBC Provider:

1. Expand the WebSphere Administrative Domain tree, and select
Resources > JDBC Providers

2. Right-click the JDBC Providers and select New from the shortcut menu

that appears.

= wWebSphere Administrative Dormain

-~ Wirual Hosts

-2 Server Groups

H-E2 Modes

--F‘_'I Enterprise Applications

=-E3 Resources
SR=R IDEC Providers
. F-@ Sample DB Mewy...
=3 Javahlail Sessic Find...

M E= i e

The JDBC Provider Properties dialog box appears
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"% JIDBC Provider Properties =] =]

ManitarDB2Driver

COM.ibm.db2 jdbe. DBEZEADataSource L

- Type database driver name in the Name box.

IBM WBI Monitor - Deployment Guide



- Click the Browse button (represented by triple dots) next to the
Implementation Class field. The Select an Implementation Class
dialog box appears.

4 Select an Implementation Class -0 x|

COM.ibm.db2 jdbe.DBZ2 ConnectionPoolDataSource -
comibm.as400.access ASA00J0DBCConnectionPoolDatasSource
com.ibm.db2 jdbc.app.DBEZStdConnectionPoolDataSource

aracle jdbc. pool.OracleCaonnectionPoolDataSource

com.svbasejdbejdbe. SybhConnectionPoolDataSource
com.merant.zequelink jdhex.datasource SequelinkDataSource
com.merant.datadirect jdbex sglserver. SQLSernverDataSource
com.ibm.ejs.cm.potabilit IDBConnectionPoolDataSource

GO ibm.db2 jdbe DBZADataSource
corm.ibm.as400.access AS400J0BCHADataSource

comLibm.db2 jdhc.app DBZStdADataSource
oraclejdboxa.client OraclexXADataSource

com.sybase jobc? jdbc SybEADataSource LI
Ok Cancel Help |

- From the Implementation Classes list, select the appropriate
implementation class for the database driver according to the above
table.

- Click OK. The dialog box will close and you will return to the JDBC

Provider Properties dialog box where the selected class appears in

the Implementation Class field.

Installing the Created Database Driver
To install the created JDBC Driver:
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1. While you are in the JDBC Provider Properties dialog box, select the
Nodes tab.

¥ JDBC Provider Properties : =0l x|

General Modes

This JOBC Pravider is installed on the Modes helow.

MHode Classpath Install Mew...
rmanitorser CAUBMSALLIENava1 4. .
Irinstall
Maode:
Classpath:
(]34 Cancel

2. Click Install New, the Install Driver dialog box appears.

¥4 Install Driver 10l x|

Select a node on which you want to install the driver.

rmanitarsner

Ciriver file (CUBMSCQLLIEYava1 M b2java Zip, i Specify Driver...

Install Cancel
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3. Select <ServerName> from the Nodes list, and click Specify Driver in
order to select a driver to be installed for the node. The Specify the
Driver Files dialog box appears.

¥ Specify the Driver Files - | I:Ilil
Specify the path to the implementation files for this provider

CABMSQALLIENava1 Adh2java Zip Add Driver... I

Femuaove |

Set | Cancel |

4. Click Add Driver. The Open dialog box appears.

Laak in: |_| ja...;l

3 cOmman.jar
& databean jar
1] db2javazip
& ioraph jar
runtirme zip
&P solasstjar
& swingall jar =

File narme: |db2ja'-xa.zip Qpen

Files oftype:  [JARSIZIPS (zip,jany »|  Cancel

5. Select the appropriate JDBC driver file name and path according to your
database server type, and click Open.

6. Select the added driver in the Specify the Driver Files dialog box and
click Set.

Click Install in the Install Driver dialog box.

8. Click OK in the JDBC Provider Properties dialog box. The Database
Driver will be installed.

Creating a Data Source

To create a Data Source to point to a Database and a Communication Driver:
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1. Expand the WebSphere Administrative Domain tree, and select
Resources > JDBC Providers> <DatabaseDriverName> Data

Sources

2. Right-click Data Sources and select New from the shortcut menu that
appears.

=4 WebSphere Administrative Domain
-~ Wirtual Hosts
-~ Server Groups
FE3 Modes
--F_'I Enterprise Applications
=3 Resources .
=03 JDBC Providers
- [#-@ Sample DB Driver
=& MonitorDB2Driver

B =0 ata Sourcey
-~ JavaMail Sessions
+-82 URL Providers Find...

- The Data Source Properties dialog box appears.

"4 Data Source Properties ) ]

| Connection F'u:u:ulingl

Please read the help for information an configuring data sources.
Marme: *|
JHDI name: |

Description:

JOBC provider: *wMonitarDB2Driver
—Custom Propedies

Marre Walue Add |
* |databaseMame al

user Femoyve |
password
connectionAttribute
description
language
[oghriter j

Test Connection |

0] 14 I Cancel Help

- Type the Data Source name in the Name box.
- Type the Data Source JNDI name in the JNDI name box.
- In the Custom Properties table:
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- Type the name of the database to which the created Data Source
points in the Database Name field. (For example WFMDB for Monitor
database or FMCDB for MQ Workflow database. If you created the
Monitor Database or the Event Queue Database with a different name,
then you should type this name in the Database Name field.).

* For Oracle database, the field name is URL and it should be filled
with the database URL instead of the database name. (For
example
jdbc:oracle:thin:@<Oracle_Server_Name>:<Oracle_Server_Po
rt_Number>:>:<DatabaseName>

Where <Oracle_Server_Name> is the name or the IP address of
the Oracle Database Server machine,
<Oracle_Server_Port_Number> is the Oracle Server Port
Number (the default port is 1521) and <DatabaseName> is the
database name (for example WFMDB for Monitor database or
FMCDB for MQ Workflow database. If you created the Monitor
Database or the Event Queue Database with a different name,
then you should type this name in the Database Name field).

'."I Data Source Properties !E[ |

eral_§| Connection Poaling |

Please read the help for information on configuring data sources.

Mame: *|ru1 anitor_x<A_DataSaource
JMDI name: [MonitorxADataSource
Description: i DataSource for Manitor Application

JOBC provider: *MonitarOraclexAlriver
Custom Properties

MHame Yalle Add |
= |passward s N

= [URL idbc:nracle:thin:@nraJ |

" o|user F i
looriter
senertame
descriptian
TMESENtryMame i

Test Connection |

I Cancel Help

- Type the Database connection user's name and password in the User
and Password fields.
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You can test the connection with the Database with the entered
user name or password by clicking Test Connection. If the
Database name, user name or password is not correct, then you
will be notified by a message. Otherwise, another message will
confirm that the connection is successful.

Click OK. The Data Source will be created.

1.1.2  Create a new Application Server

Now your next step is to create a new Application Server for WBI Monitor.

1. Inthe WebSphere Administrative Domain tree, right-click Nodes >
<ServerName> > Application Servers and select New from the
shortcut menu that appears.

=58 wwebhSphere Administrative Domain [+
----- 3 Virual Hosts
----- £3 Server Groups

=HE2 Modes
=@ monitorsrer
E}E- Application Server

- [H@)) Default Server
~-f3 Generic Servers

™~ /& . i SNHE e e
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The Create Application Server dialog box appears.

"% Create Application Server - |I:I|5|

General I Advancedl FiIeI Transactiunl J4 Beﬁingal Sewicesl Cuatnml

Application Server name: *|ru1|:|nit|:|rEenfer

Mode: fmonitorsrer =l
Emviranment: | Environment.. |
Working directony: |C:1mnnitu:ur421

Mode startup state: |Last state =l
Maximum startup attermpts: |2 atternpts
Madule visibility: [Application =

] I Cancel Help

- In the General tab:
* In the Application Server Name box, type MonitorServer.
* In the Working Directory box, type <Monitor>
* In the Module Visibility combo box, select Application.

* Leave the other fields as default
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- In the File tab:

®i Create Application Server - | I:Ilil

General | Advanced File | Transaction | JyM Settings | Sewices | Custom |

Standard input: |

Standard output:  flogsistdout log

Standard errar; |||:.gsfptderr,|ng

—File permissians

Specify what permissions WebhSphere Application Server should use
when creating the files ahove.

Owner. [ Read [ Write [ Execute
Group: [V Read [ Write [V Execute
Other [V Read [ Write [ Execute

Ol I Cancel Help

*

Leave the Standard Input box blank
* In the Standard Output box, type logs/stdout.log
* In the Standard Error box, type logs/stderr.log

* Leave the check boxes in the File Permissions frame with their
default settings.

- In the JVM Settings tab:
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¥4 Create Application Server =100 x|

General | Advanced | File| Transaction J¥M Settings | Services | Custom |

FS

Initial java heap size: 128 hB
Maximurm java heap size;  |512 []=]
—Classpaths
Mame | Add
Eemoye
—Systermn Properties
MHame Yalue Add
Eemoye
Advanced SV Settinos.. |
Generated Command Line Arguments:
FHms128m -KrmxE1 2m |

Ok I Cancel Help |

* In the Initial Java Heap Size box, type 128

* In the Maximum Java Heap Size box, type 512

* If you are using MQ Workflow as your engine then do the following
in the Classpaths section:

- Click Add. A new empty line appears in the Classpaths table
under the Name column.

- Type in the added line the full path and hame of the MQ
Workflow library file named fmcojagt.jar and located in the
<MQ>\bin\java3320 folder if you are using IBM MQSeries
Workflow 3.3.2 or located in the <MQ>\bin\java3400 if you are
using IBM WebSphere MQ Workflow 3.4.

* If you are using WebSphere Application Server 4.0.5, then the
property client.encoding.override=UTF-8 should be added as in
the following steps:

- In the System Properties list, click Add
- Type client.encoding.override in the Name field.
- Type UTF-8 in the Value field.

- Click OK. The new application server will be created.
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1.1.3  Configure the WBI Monitor Initial Parameters

Now you should configure the WBI Monitor initial parameters. This is done
through the WebSphere Application Assembly Tool.

To configure the WBI Monitor initial parameters:

1. From the WebSphere Administrator's Console, Select Tools
>Application Assembly Tools from the menu.

The Application Assembly Tool window opens.

Click Cancel to close the welcome screen.

Select File> Open from the menu. The Open dialog box appears.
Select the monitor.ear file located under the <Monitor>\server\server.

Expand the tree on the left.

o gk~ wDN

Add the required environment entries (parameters) in the Environment
Entries node under the session bean of the following modules:

- For the Monitor EJB Module:
* ClientAgent bean.
* CleanupAgent bean.
* NotificationAgent bean.
* EventProcessor bean.
* DBBridge bean.
- For the WMQI_Connector_ID module
* WMQIConnector bean.
- For the ICS_Connector_ID module
* |CSConnector bean.
- For the Connector_ID module.
* MQWFConnector bean.
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v Application Assermbly Tool

File Edt W
g & o

Window Help

= 21 |5 _WEI_Monitor
= ¢ EJB Modules
= g% Manitor
=1 Session Beans

= (@) CligntAgen
s ]

0 EJB References
3 Resource References
M Sécisity Role Réferénces
3 Memod Exéngions
CleanupAgent
Malific aticnAgent
EventProcessor
DEBridge

1 Entity Beans

0 Secunty Roles

O Memmod Pemmissions

8 Container Transactons

O Fiez
.'1 Cannactar_ID
&4 wWmal_Connecor_iD
Web Modules
Application Cliants
Security Roles

TP Fites

g

C)
*
+
s

LIUIEI_ s &

4 |

hE XF o288

*

Matna | vawe | Type | Descrigtion |
+» monfordbagSchema FMC Baing
s mondor db schema WF M Swing
T MOnAor it enablad false Swing
3 MORA0F pwt enabled =0T Swing
€ MOonAoE e loc alne LoG Sting
' mondor securily mode L] S¥ing
*s MonAor wmal énabled g S¥ing

Oeneral |

Emironment erdries define variables used to cusiomize the business logic for an
application

Hame “menitor db egSchema
Yalue FuC

Tipe: "sxing

Description

| |

The following table lists the required parameters that should be entered for each

session bean.

Property Name / EJB Name:

ICSConnector

monitor.db.schema

<« | ClientAgent

<« | CleanupAgent

< | NotificationAgent
< | EventProcessor

< | MQWFConnector
< | WMQIConnector

<« | DBBridge

N

monitor.db.eqSchema

<

monitor.db.tablespaces.adminData

monitor.db.tablespaces.adminindexes

monitor.db.tablespaces.modelTables

monitor.db.tablespaces.modelindexes

monitor.db.tablespaces.processinstTables

monitor.db.tablespaces.processinstindexes

monitor.db.tablespaces.eventTables

monitor.db.tablespaces.eventindexes

monitor.db.tablespaces.processDataTables

N R YRR R
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monitor.db.tablespaces.processDatalndexes

monitor.db.tablespaces.securityTables

monitor.db.tablespaces.securitylndexes

monitor.db.tablespaces.processModelLob

monitor.db.tablespaces.processDatalob

monitor.db.tablespaces.configValuesLob

monitor.db.tablespaces.notifyExtraDatalLob

monitor.db.tablespaces.eventDatalLob

monitor.db.tablespaces.delayedEventDatalLob

monitor.db.tablespaces.mbDetailLob

SN R N AN BN AN AN BN BN RN

monitor.db.tablespaces.eqTables

monitor.db.tablespaces.eqindexes

monitor.db.tablespaces.conDetailDatalLob

monitor.db.tablespaces.defaultTablespace

IR ERN RN

monitor.wics.enabled

monitor.wmgi.enabled

monitor.mqwf.enabled

monitor.security.mode

monitor.security.ldap.url

monitor.security.ldap.dn

monitor.security.ldap.password

monitor.security.ldap.naming.attr

monitor.security.ldap.root

monitor.security.ldap.dn.attr.id

monitor.mgwf.configurationID

IR AR AN AR NI BN B NE B NS NS BN

monitor.mqwf.encoding

v

The following table provides the description of each parameter.

Parameter Name Type | Value Description

monitor.db.schema String | The Monitor Database Schema. The default value is WFM

monitor.db.eqSchema String | The MQSeries Workflow Database (Event Queue Database)
Schema. The default value is FMC

monitor.mqwf.enabled String | Type True if you are using MQ Workflow as your engine or False
otherwise.

monitor.wmgi.enabled String | Type True if you are using WMQI as your engine or False
otherwise.
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monitor.wics.enabled String | Type True if you are using WICS as your engine or False
otherwise.

monitor.security.mode String | The applied security mode:

* Type MQ for MQ Workflow security mode if you are using MQ
Workflow as your engine.

* Type LDAP for LDAP security mode or Local for local security
mode if you are only using WMQI as your engine.

monitor.security.ldap.url String | The LDAP Server URL and port number (for example Idap://
Idapsrvr:389/).

This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.security.ldap.dn String | A Distinguished Name (DN) for an LDAP Server authorized user
that will be used for logging in to this LDAP Server, and perform-
ing the search in the LDAP users' tree.

This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.security.ldap.password String | The password of the defined User DN.

This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.security.ldap.naming.attr | String | The name of the prefix that precedes the user ID in the LDAP
Server database (i.e. CN, UID,...etc). The value of this parameter
varies between the different types of LDAP Servers.

This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.security.ldap.root String | The starting point in the LDAP tree from which the query will start
searching for the full DN of the given user ID.

This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.security.ldap.dn.attr.id String | The name of the Distinguished Name attribute ID (for example
distinguishedName, entrydn ...etc. This value is case sensitive).

This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.mgwf.configurationID String | The used MQ Workflow Configuration (Default or Non-Default)

monitor.mgwf.encoding String | The MQSeries Workflow Database encoding. (This property must
be set if the MQ Workflow Database encoding is different from the
Monitor Server machine encoding)

In addition to the above parameters, there are additional parameters that
should be defined to hold the values of the Database TableSpaces
names that you want to use for physically storing the Monitor and
EventQueue database tables and indexes. You have the ability to use a
number of TableSpaces that are up to 22 different TableSpaces; 19 of
them are created in the Monitor Database and three of them are created
in the EventQueue Database. The database tables and indexes are
grouped and categorized so that each category can be assigned to a
separate TableSpace. You can define different TableSpace name as the
value for each system property. Alternatively, you can define the same
TableSpace for more than one system properties. In the later case, this
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TableSpace will be used for the tables and indexes that are
corresponding to these properties. You can also ignore defining any of
these properties, and in this case the tables, which are supposed to be
assigned to these TableSpaces, will be assigned to the default
TableSpace that can be defined by the
monitor.db.tablespaces.defaultTablespace property. If you did not define
this property then the database user default TableSpace will be used as
the default TableSpace.

Parameter Name Type | Value Description
monitor.db.tablespaces.adminData String | TableSpace name of the Monitor Database
Administration tables.
monitor.db.tablespaces.adminindexes String | TableSpace name of the Monitor Database
Administration indexes.
monitor.db.tablespaces.modelTables String | TableSpace name of the Monitor Database Static
model tables.
monitor.db.tablespaces.modellndexes String | TableSpace name of the Monitor Database Static
model indexes.
monitor.db.tablespaces.processinstTables String | First TableSpace name of the Monitor Database
Dynamic tables.
monitor.db.tablespaces.processinstindexes String | First TableSpace name of the Monitor Database
Dynamic indexes.
monitor.db.tablespaces.eventTables String | Second TableSpace name of the Monitor Database
Dynamic tables.
monitor.db.tablespaces.eventindexes String | Second TableSpace name of the Monitor Database
Dynamic indexes.
monitor.db.tablespaces.processDataTables String | Third TableSpace name of the Monitor Database
Dynamic tables.
monitor.db.tablespaces.processDatalndexes String | Third TableSpace name of the Monitor Database
Dynamic indexes.
monitor.db.tablespaces.securityTables String | TableSpace name of the Monitor Database
Security tables.
monitor.db.tablespaces.securityindexes String | TableSpace name of the Monitor Database
Security indexes.
monitor.db.tablespaces.processModelLob String | TableSpace name of the Monitor Database
Process Model LOB.
monitor.db.tablespaces.processDatal ob String | TableSpace name of the Monitor Database
Process Data LOB.
monitor.db.tablespaces.configValuesLob String | TableSpace name of the Monitor Database
Configuration Values LOB.
monitor.db.tablespaces.notifyExtraDatalLob String | TableSpace name of the Monitor Database Notify
Extra Data LOB.
monitor.db.tablespaces.eventDatal ob String | TableSpace name of the Monitor Database Event

Data LOB.
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monitor.db.tablespaces.delayedEventDatalLob String | TableSpace name of the Monitor Database
Delayed Event Data LOB.
monitor.db.tablespaces.mbDetailLob String | TableSpace name of the Monitor Database WBI
Message Broker LOB.
monitor.db.tablespaces.eqTables String | TableSpace name of the MQSeries Workflow
Database Event Queue tables .
monitor.db.tablespaces.eqlndexes String | TableSpace name of the MQSeries Workflow
Database Event Queue indexes.
monitor.db.tablespaces.conDetailDatal.ob String | TableSpace name of the MQSeries Workflow
Database Configuration Detail Data LOB
monitor.db.tablespaces.defaultTablespace String | The name of the default TableSpace that is used

for any tables or indexes category that has not
been assigned to a specific TableSpace.

In case you have an existing database that belongs to a previous

schema and the Monitor Database Schema must be the same as

Important Note: In MQ Workflow, a default configuration must be

L

i version and contains data, then you will need only to add the
monitor.db.tablespaces.defaultTablespace parameter. All other
parameters that hold the TableSpaces names should not be
added.

&_ Important Note: In Oracle Database, the Event Queue database
the Database Administrator's User Name.

=5,

=" | defined .

To add each one of these parameters, do the following:
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- Right click inside the right-hand table, and select New from the shortcut
menu that appears. The New Environment Entry dialog box appears.
T x|
[General |
Emvironment entries define vanables used to customize the business logic for an
application.

Mama: |

Walue: |

Type: *| String
Description: |

| L

—

ok | aoy | cancat | Hew

- Type the parameter name in the Name field.
- Type the parameter value in the Value field.
- Select the parameter type from the Type drop down list.
- Click OK. The new parameter will be added to the table.
Select File > Save from the menu to save the monitor.ear.

8. Exit the Application Assembly Tool.

1.1.4 Install the WBI Monitor Enterprise Application

Now you will create and install an Enterprise Application for WBI Monitor.

1. From the Console > Wizards menu, select Install Enterprise
Application. The Install Enterprise Application Wizard will start
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2. Inthe Specifying the Application or Module screen:

" Install Enterprise Application Wizard

Specifying the Application or Module
Specify the applicaiion{EAR file) or module(JAR or WAR file) thal you want o install.
liyouw install a stand-alone module, you must specify a new application name L]

]

Browse for filé on noda: Tizarvara =]

i+ Install Application (.ear)
Fati: “JC aBIManibo s arvalmonor. & ar Browse...
Application nanme: BN _wWBIL Monilor

" Install stand-alone module (*.war, = jary
1 |
|

Help | I_gm:lr I I Cancel |

- Select the <ServerName> node from the Browse for file on node:
combo box if it is not displayed by default.

- Select the Install Application (*.ear) radio button.
- In the Application name box, type IBM_WBI_Monitor

- Click the Browse button to locate the monitor.ear file. The Open dialog
box appears.

* Select the monitor.ear file from the <Monitor>\server\server.

* Click Open. The file will be selected and you will return to the
Specifying the Application or Module screen

- Click Next.
In the Mapping Users to Roles screen, click Next.
In the Mapping EJB RunAs Roles to Users screen, click Next.

In the Binding Enterprise Beans to JNDI Names screen, click Next.

o 0k~ w

In the Mapping EJB References to Enterprise Beans screen, click
Next.

7. Inthe Mapping Resource References to Resources screen do the
following:

- If the Monitor database and the Event Queue database are located in
the same physical database (one database), then all resource
references should be mapped to the same physical data source
named Monitor_Pool_DataSource.
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- If the Monitor database and the Event Queue database are located in
two physical databases, then map each resource reference to the
appropriate resource according to the following table:

Resource Ref. Module Data Source Name Data Source JNDI Name
jdbc/MonitorDataSource MQWZFConnector Monitor_XA_DataSource MonitorXADataSource
jdbc/EventQueueDataSource MQWZFConnector Event_Queue_XA_DataSource EventQueueXADataSource
jdbc/ MQWZFConnector Event_Queue_Pool_DataSource EventQueuePoolDataSource
PoolEventQueueDataSource

jdbc/MonitorDataSource CleanupAgent Monitor_Pool_DataSource MonitorPoolDataSource
jdbc/MonitorDataSource ClientAgent Monitor_Pool_DataSource MonitorPoolDataSource
jdbc/MonitorDataSource EventProcessor Monitor_Pool_DataSource MonitorPoolDataSource
jdbc/MonitorDataSource NotificationAgent Monitor_Pool_DataSource MonitorPoolDataSource
jdbc/MonitorDataSource WMQIConnector Monitor_Pool_DataSource MonitorPoolDataSource
jdbc/MonitorDataSource ICSConnector Monitor_Pool_DataSource MonitorPoolDataSource

To perform the mapping:

- Select the resource reference you want to map to a specific data
source from the Resource Reference column.

- Click Select Resource. The Select Resource dialog box appears.
"i select Resource

3

Select Resource

Event_Queue_Ponl_DataSource [

Ok Cancel |

- Select the appropriate Data Source name from the Select Resource
drop down list and click OK. The resource reference will be mapped to
the selected resource and the JNDI Name of the selected data source
will appear in the mapping table in the JINDI Name column.

- Click Next to continue.

8. Inthe Specifying the Default DataSource for EJB Module screen,
click Next.

9. Inthe Specifying DataSources for Individual CMP Beans screen,
click Next.

10. Inthe Selecting Virtual Hosts for Web Modules screen, click Next.

96 IBM WBI Monitor - Deployment Guide



11.

" Install Enterprise Application Wizard

Help < Hack I._gm‘lrm I f I Cancel I

In the Selecting Application Server screen:

Selecting Application Servers
Specify the application senverwhang you want to install modules contained in your
application. Modules can be installed on the same server ar dispersed among
several semvers

:l'il-] Salect a module in the list below and click the Selact Server bution o selact the application
i, 4| semveronwhich fo install the module.

Module | Application Server |
Monifor MonitorSerar{maonitorsn )

MonidorSapanmaniforsne

- Select Monitor from the Module column.

- Click Select Server. The Select a Server or Server Group dialog box
appears.

Select a Server or Server Group El

Application Server:

Default Serverimonitorsme 0]

MonitorServerimonitorsret

Cancel

Server Group:

- Select MonitorServer(<ServerName>) from the Application Server
list and click OK.

- Select Web Monitor from the Module column in the Selecting
Application Server screen

- Click Select Server. The Select a Server or Server Group dialog box
appears.
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- Select MonitorServer(<ServerName>) from the Application Server
list and click OK.

- Click Next in the Selecting Application Server screen.

12. Inthe Completing Application Installation Wizard screen, click
Finish.

*& Install Enterprise Application Wizard

Completing the Application Installation Wizard
Confirm the infarrmation for installing the application or module.

al The application or module will be installed with the setings you provided. To make
- T—E changes to these seffings, click Back. To install the application, click Finish.

This application will be installed on the folowing nodes with thie install direclory salling for
each node as:
moniforsnr ChibmiwebSpheraappServeninstalledApps\BPM_Monitor.ear

of which monitors T 1S the local node. This wizard will autornatically create the install
diractary for this local node after finishing the install task

Help < Back | |ulnlsn| Cancel I

The Deploy dialog box appears.
TR %

Deployad module location: |C libmidebSpherel\appSemerinstallablesppsimonitor_de

Working Directory: |C ipmityebSphereippSeneninstallabledpps
Dependent classpath: |

[ Code generation onhy
[~ Werity archive
RMIC oplions: |

Datahase type: [CazUDEWIN_v7 2 =]
Database nanme: |

Schema name: |

Ok | Cancel |

13. Accept the default values in the Deploy dialog box and click OK. The
new Enterprise Application will be installed.

14. Wait until the confirmation message appears, and then click OK.
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1.1.5 Regenerating Web Server Plug-in

Now you must regenerate the Web Server Plug-in to be adequate with the
installed Enterprise Application. To regenerate the Web Server Plug-in:

1. Inthe WebSphere Administrative Domain tree, right-click Nodes >
<ServerName> and select Regen Webserver Plugin from the shortcut
menu that appeatrs.

=38 wehSphere Administrative Domain -

----- £ virtual Hosts |
----- £ Server Groups (3 Ger
=3 Modes
-
=3 Applica Find...
E} DEf STDFI a
=gyl Mar . -
o orce atop
~B i
L Restart
----- 3 Generii
(=80 Enterprise App Stop for restart
=21 manitorsre Ping
----- £3 EJB Mo T
me £ Web M race...
Rl Feden Yiebserver Plugin

=2 Resources

Il T T

2. Wait until the confirmation message appears, and then click OK.

1.1.6 Restart the Web Server

Now you should restart the Web Server you have.

Example: If you installed IBM HTTP Server as the Web Server then do the
following:

1. From the Windows Taskbar, select Start > Programs > IBM HTTP
Server > Stop IBM HTTP Server.

2. Wait until the confirmation message that tells you that the IBM HTTP
Server has been stopped.

3. From the Windows Taskbar, select Start > Programs > IBM HTTP
Server > Start IBM HTTP Server.

4. Wait until the confirmation message that tells you that the IBM HTTP

1.1.7  Starting the Monitor Application Server

Now you must start the Monitor Application Server. To do this:

1. Inthe WebSphere Administrative Domain tree, right-click Nodes >
<ServerName> > Application Servers > > MonitorServer and select
Start from the shortcut menu that appeatrs.
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=+-H webSphere Administrative Domain =)

----- £3 wirtual Hosts B
----- {3 Serer Groups B3 Installed
=3 Modes

=@ monitorsmr
=82 Application Servers
g Default Server General |;
@ .

-2 Ingtalleg _ FiRd.. |
@ sl
=3 Generic Servers

=2 Enterprise Applications

: Force Sto
E}ﬂ, monitarsrr_sample 5
- 3 BJB Modules
. - .D Web MDdUIES REH"II:I"."E
-1 BPM Monitar
=2 Resources Create Server Group. .
=2 JDBC Providers :
7 Fropeties

- Samnle DA Nrive

2. Wait until the confirmation message appears, and then click OK.
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2  WBI Monitor Server Un-
deployment

This section is used in a situation where you would like to completely un-deploy
the Monitor Server. To completely un-deploy the Monitor perform the following
steps:

1. Open the WebSphere Administrator's Console.

2. Inthe WebSphere Administrative Domain tree, right click Nodes >
<ServerName>> > Application Servers > MonitorServer and select
Stop from the shortcut menu that appears to stop the Monitor
Application Server.

- WebSphere Administrative Domain =

----- £ wirtual Hosts B
----- 3 Server Groups B2 Installed '
=3 Modes

=6 monitorsrr
=B Application Servers
¢ [Hm] Default Server

EI General | i
. ..... .D Installed Find...
w7 Installed
D e e
E}F_'I Enterpn;e Applications Farce Stop
=21 monitorsrer_sarmple i
B2 EJB Modules Ping
- 3 Web Modules
-1 BPM Manitar Transactions...
=3 Resources
=82 JDBC Providers :
. #T8 Samnle DB Drivi_ T 1OReMes

3. Inthe WebSphere Administrative Domain tree, right click the
Enterprise Applications > IBM_WBI_Monitor and select Remove
from the shortcut menu.

4. Right click the Nodes > <ServerName>> > Application Servers >
MonitorServer and select Remove from the shortcut menu.

5. Remove all created Data Sources for the Monitor.
6. Remove the created Database Driver(s).

7. Delete the file monitor_deployed.ear from
<WebSphere>\AppServeninstallableApps\

8. Delete any reference for WBI Monitor from
<WebSphere>\AppServeninstalledApps\

9. Delete the directory named MonitorServer which is located in
<WebSphere>/temp/<WAS_NODE_NAME>/

10. Delete all files in the <Monitor> folder.
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Appendix B: Manual Deployment of
WBI Monitor on
WebSphere 5.0

This appendix describes the manual steps of deploying WBI Monitor on IBM
WebSphere 5.0 Before starting these steps, it is assumed that the Monitor
Database (and Event Queue Database if you are using MQ Workflow as your
engine) with the required Table Spaces are created and configured in your
Database Server. The following conventions are used for all the instructions
throughout this document:

* <WebSphere> = The WebSphere home directory. e.g. C:\Websphere

* <MQ> = The MQ Workflow home directory. (e.g. c:\fmcwinnt on Windows
platform, /user/fmc on AIX platform, or /opt/fmc on Solaris platform)

* <DB2> = The DB2 home directory. e.g. c:\sqllib

» <Oracle> = The Oracle home directory on the Oracle Server machine (if
Oracle is not running on the same machine on which the IBM WebSphere
Application Server is installed). e.g. C:\oracle\ora81 (Local) or
\\oracle_machine\oracle\ora81 (Network)

* <Monitor> = The Monitor installation directory where the WBI Monitor has
been installed. e.g. C:\WBIMonitor

» <WebServerName> = The name of the machine that hosts the Web
server for which the WebSphere is configured. (Ex. The machine name on
which the IBM HTTP Server or Microsoft 1IS 4.0 or IIS 5.0 is installed)

* <ServerName> = The name of the server on which the Monitor will be
installed.

Important Notes:

* On AIX and Solaris platforms, use forward slash / instead of back-slash \
when writing paths.

* The names and paths of folders and files are case sensitive.

* Make sure that the user you are using have all needed permissions. For
example, using a user who has no permissions on WebSphere or the
Database will fail to deploy the monitor.

* On AIX 5.1 platform, the environment variable named LIBPATH must be
appended with the following pathes: <MQ>/lib and <MQ>/lib/mgserver. To
do this, type The following command in the console window from which
you will start the WebSphere and then press Enter:

export LIBPATH=3$LIBPATH:<MQ>/lib:<MQ>/lib/mqgserver
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« The Monitor will not work if the server properties client.encoding.override
or default.client.encoding are set to any encoding other than UTF-8.
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1  WBI Monitor Deployment

1.1 Configure IBM WebSphere

The manual deployment of WBI Monitor on WebSphere 5.0 is done through the
IBM WebSphere Administrative Console for either WebSphere Application
Server v5.0 or WebSphere Deployment Manager (Network Deployment) v5.0.
The differences between the deployment steps on each of these WebSphere
editions are:

If you intend to deploy the WBI Monitor on WebSphere Deployment
Manager (Network Deployment) v5.0 then you have to create a new
Application Server (for example, named MonitorServer) on which the WBI
Monitor Enterprise Application will be deployed. Also you have to select
the node on which you will create the Application Sever and deploy the
WBI Monitor Enterprise Application. This is done at the beginning of each
section steps that requires the node selection.

If you intend to deploy the WBI Monitor on WebSphere Application Server
v5.0 then the WBI Monitor enterprise application should be deployed on
the Default Server (serverl). And in this case you don't need to create a
new Application Server.

The following sections provide the detailed steps of the manual deployment of

WBI

Monitor on WebSphere.

1.1.1 Create JDBC Providers and Data Sources

B3 If pr

evious drivers are already created and installed, then you can

i skip the following steps for creating and installing the database

drivers for the data source.

You need to create the required Database Drivers and their Data Sources. The
creation of the Database Drivers and their Data Sources should be performed

as th

1.

© Copyright IBM Corp. 2002, 2004

e following sequence:

If you are not using IBM MQ Workflow as your engine or if the Monitor
database and the Event Queue database are located in the same
physical database:

- Create and install only one Pool Database Driver.

- Create only one Pool Data Sources under the created Pool Database
Driver points to the Monitor database.

If the Monitor database and the Event Queue database are located in
two physical databases:

- Create and install one Pool Database Driver.
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- Create two Pool Data Sources under the created Pool Database Driver

(one Data Source points to the Monitor database and the other Data
Source points to Event Queue database).

- Create and install one XA Database Driver.

- Create two XA Data Sources under the created XA Database Driver
(one Data Source points to the Monitor database and the other Data
Source points to Event Queue database).

The following tables provide the required values for the each Database Driver
and Data Source as you should enter through the creation steps:

For Monitor Pool JDBC Provider

Property/Field Name

DB2

Oracle

Type DB2 JDBC Provider Oracle JDBC Thin Driver
Name MonitorDB2PoolDrive MonitorOraclePoolDrive
Database JDBC Driver File Name | db2java.zip classes12.zip

Database JDBC Driver File path <DB2>\javal2\ <Oracle>\jdbc\lib

For Monitor Pool Data Source

Property/Field Name

Value

Name

Monitor_Pool_DataSource

JNDI Name

MonitorPoolDataSource

For Event Queue Pool Data Source

Property/Field Name

Value

Name

Event_Queue_Pool_DataSource

JNDI Name

EventQueuePoolDataSource

For Monitor XA JDBC Provider

Property/Field Name

DB2

Oracle

Type DB2 JDBC Provider (XA) Oracle JDBC Thin Driver (XA)
Name MonitorDB2XADrive MonitorOracleXADrive
Database JDBC Driver File Name db2java.zip classes12.zip

Database JDBC Driver File path <DB2>\javal2\ <Oracle>\jdbc\lib

For Monitor XA Data Source
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Property/Field Name

Value

Name

Monitor_XA_ DataSource

JNDI Name

MonitorXADataSource
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For Event Queue XA Data Source

Property/Field Value

Name

Name Event_Queue_XA_DataSource
JNDI Name EventQueueXADataSource

The following sections describe the required steps that you should follow to
create and install a Database Driver and to create a Data Source under this
driver:

Creating and Installing a JDBC Provider

To create and install a JDBC Provider:

1. From the left hand tree, select Resources > JDBC Providers. The
JDBC Provider page appears in the right side of the window.

h —_——
i JDBC Providers
LER .
. IS providen e e by P ritie appkoafony 10 scoest dets tom dedabaes ]
B Senan
E Appicafors
B Fesosces Teta 0
B Scope CeleAnamy, ModeAaurmy
e NS Prpiery e Avwery  Lins soope eSng 1o el e ety of 1E00UrceE B & paricule oell, e, oF T
ViebSohere MG Provider Wiha rarer Benag wen created n e vawy, Faey il ba oresled wiren T oument sope
Wil by AT Wyyrevie F aan Ay
el Proswiens -
e —_—
Bxepurce b onment Pryvgery 3
L Py Apply
Bbinris Loyl §
(== o Filter
8 Erveoreet B Fretevencen
[E Srotom damrotraton
Ny Dslate
& Fronsersretis )
| M D il
o
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2. Click New. The JDBC Provider > New page appears.

=1
Heme | Bave | Frefecenies | Logest | Help | L
- BEC Provhiery - =
Asarrny DE2 JOBC Provider [XA)
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3. Select the JDBC Driver type from the JDBC Providers drop down list:
4. Click Apply, the configuration page of the selected JDBC Provider type
appears.
—1
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5. Type JDBC Provider name in the Name box.
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10.

Type a description for the new JDBC Provider in the Description box
(Optional)

In the Classpath box, change the contents of this field to contain the
path and name of the JDBC Driver file according to your Database
Server type.

Click OK.

Click Save in the top menu bar to save your changes. The Save page
appears.

Click Save.

Creating the Data Source

To create a Data Source to point to a Database and a Communication Driver
under the created JDBC Provider:

1. From the left hand tree, select Resources > JDBC Providers. The
JDBC Providers page appears on the right.
2. From the Existing JDBC Provider list, click the Hyperlink of the JDBC
Provider you have created. The configuration page of the JDBC
Provider appears.
3. From the Additional Properties section, click the Data Sources
(Version 4) hyperlink. The Data Sources (Version 4) page appears.
il —
Weme | Swve | Frefscences | Logen | Meip | (3]
R FE Py gkbery - Mol ke -
Ay Data Sources (Verslen 4)
8 Sarvarn Trug = e WeebSphere d o gy DoUrCE Thal uned ihe WeoSphere ol Connecionidersger sechierhare. Al e E0H o module) Pt ube T dats
B Apgicafions; sarce. il
B Fsioscet
Toead 1
i Fils
Bl Preterercrs
Mg Delets
e ™ Jime * P [Destription [cutegen £
r:;.:.:-.- ‘ .-“,_. r .!ﬂ_{‘_[ﬂ;m .“:I'A'A[lll'ﬁmc‘" --'Ii'.*tﬂi'['\l’l'.t-fl:i' |
E Seowrty
B Errororererd
@ Sysion darrisrdon
[ORAEY T
© Copyright IBM Corp. 2002, 2004 109



110

4. Click New. The Configuration page of the new Data Source appears.
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Type Data Source name in the Name box.
Type Data Source JNDI name in the JNDI name box.
7. Inthe Database Name field:

- For DB2 database: Type the name of the database to which the data
source points (For example WFMDB for Monitor database or FMCDB
for MQ Workflow database. If you created the Monitor Database or the
Event Queue Database with a different name, then you should type
this name in the Database Name field.).

- For Oracle database: Leave this field empty

8. Type the Database Administrator's user name and password in the

Default User ID and Default Password fields.

9. Click Apply.
10. For Oracle database only:

- In the Additional Properties section that appears in the bottom of the
page:

* Click the Custom Properties hyperlink. The Custom Properties
Page appears.
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* In the Custom Properties page click the URL property hyperlink.
The URL Properties page appears.
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* In the Value field type:

jdbc:oracle:thin:@<Oracle_Server_Name>:<Oracle_Server_Po
rt_Number>:>:<DatabaseName>

Where <Oracle_Server_Name> is the name or the IP address of the
Oracle Database Server machine, <Oracle_Server_Port_Number>is
the Oracle Server Port Number (the default port is 1521) and
<DatabaseName> is the database name (for example WFMDB for
Monitor database or FMCDB for MQ Workflow database. If you
created the Monitor Database or the Event Queue Database with a
different name, then you should type this name in the Database Name
field.).

* Click Apply.

- Click OK

- Click Save in the top menu bar to save your changes. The Save page
appears.

- Click Save.

Create a new Shared Library

In the left hand tree expand the Environment node

2. Select the Shared Library hyperlink. The Shared Libraries page

appears.
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3. Click New. The configuration page of the new Shared Library appears.
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4. Type MQLib in the Name box.
5. Type a description for the new shared library in the Description box
(Optional).
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- In the Classpath box, enter the path of the file fmcojagt.jar file (the
default location is under the <MQ>\bin\java3320 folder

6. Click OK

7. Click Save in the top menu bar to save your changes. The Save page
appears.

8. Click Save.

1.1.3 Create a new Application Server

The following steps describe how to create a new Application Server named
MonitorServer, on which you will deploy the WBI Monitor Enterprise Application
in case of deploying on WebSphere Deployment Manager (Network
Deployment) v5.0. Do not create this new Application Server if you are going to
deploy the WBI Monitor Enterprise Application on the Default Server (serverl)
in case you are deploying on WebSphere Application Server 5.0.

To create a new Application Server for WBI Monitor:
1. From the Left hand tree, expand the Servers node.

2. Click the Application Servers hyperlink. The Application Servers
page appears.
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3. Click New. The Create New Application Server wizard appears.
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4. Select the node on which the new Application Server will be created
from the Select Node drop down list.

Type MonitorServer in the Server name field.
Leave the other fields with their default values.

Click Next. The Confirmation Page appears.

© N o 0

Click Finish. The new Application Server will be created and its name
will be added to the Application Servers list in the Application
Servers page.

9. Click Save in the top menu bar to save your changes. The Save page
appears.

10. Click Save.

1.1.4  Configure the New Application Server

After creating the MonitorServer Application Server, you need to configure its
parameters. If you intend to deploy the WBI Monitor Enterprise Application on
the default Application Server (Default Server) named serverl, then adjust this
Application Server with the different settings.

To configure the Default Server (serverl):
1. From the Left hand tree, expand the Servers node.

2. Click the Application Servers hyperlink. The Application Servers
page appears.
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3. Click the serverl hyperlink in the Application Servers list. The serverl
Configuration Page appears.

4. Click the Process Definition hyperlink. The Process Definition
configuration page appears.

- Click the Java Virtual Machine hyperlink. The Java Virtual Machine
configuration page appears.

* In the Initial java heap size box, type 64

* In the Maximum java heap size box, type 128

* Click OK.
5. Click Save in the top menu bar to save your changes. The Save page
appears.
6. Click Save.

To configure the MonitorServer:
1. From the Left hand tree, expand the Servers node.

2. Click the Application Servers hyperlink. The Application Servers
page appears.

3. Click the MonitorServer hyperlink in the Application Servers list. The
MonitorServer Application Server Configuration Page appears.

4. Click the Process Definition hyperlink. The Process Definition
configuration page appeatrs.

- In the Working Directory box, type <Monitor>
- Leave the other fields with their default values.
- Click Apply.

- Click the Java Virtual Machine hyperlink. The Java Virtual Machine
configuration page appeatrs.

* In the Initial java heap size box, type 64
* In the Maximum java heap size box, type 128
* Click OK.

- Click the MonitorServer hyperlink in the top of the page to return to
the MonitorServer Configuration Page.

- Click the Logging and Tracing hyperlink. The Logging and Tracing
configuration page appeatrs.

- Click the JVM Logs hyperlink. The JVM Logs Configuration Page
appears.

* In the System.out section change the value in the File Name field
to contain the following: <Monitor>/logs/stdout.log

* |n the System.err section change the value in the File Name field
to contain the following: <Monitor>/logs/ stderr.log

* Click OK.
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5.

6.

1.1.5

Click Save in the top menu bar to save your changes. The Save page
appears.

Click Save.

Configure the Virtual Host

Now you should configure the default_host virtual host in order to add the
server HTTP port to its Host Aliases list.

These steps are done only if you have created a new Application Server in case
of Network Deployment. If you will deploy the WBI Monitor Enterprise
Application on the Default Server (serverl) then do not perform these steps.

To configure the Virtual Host:

1.
2.

© ©® N O

11.

12.
13.
14.

15.
16.

17.

In the left hand tree, expand the Servers node.

Click the Application Servers hyperlink. The Application Servers
page appears.

Click the MonitorServer hyperlink. The MonitorServer configuration
page appears.

Click the Web Container hyperlink from the Additional Properties
table. The Web Container page appears.

Click the HTTP Transports hyperlink from the Additional Properties
table. The HTTP Transports page appears.

Click the * hyperlink in the First row of the HTTP Transports table.
Copy the value in the Port field.
In the left hand tree, expand the Environment node.

Click the Virtual Hosts hyperlink. The Virtual Hosts configuration page
appears.

Click the default_host hyperlink in the hosts list. The default_host
configuration page appeatrs.

Click the Host Aliases hyperlink in the Additional Properties table.
The Host Aliases page appears.

Click New. The Configuration page of the new Host Alias appears.
Type * in the Host Name field

Type the MonitorServer HTTP Port Number that you've copied in the
Port field.

Click OK.

Click Save in the top menu bar to save your changes. The Save page
appears.

Click Save.
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1.1.6  Configure the WBI Monitor Initial Parameters

Now you should configure the WBI Monitor initial parameters. This is done
through the WebSphere Application Assembly Tool.

To configure the WBI Monitor initial parameters:
1. Start the WebSphere Application Assembly Tool.
Click Cancel to close the welcome screen.
Select File> Open from the menu. The Open dialog box appeatrs.
Select the monitor.ear file located under <Monitor>\server\server.

Expand the tree on the left.

o gk~ 0N

Add the required environment entries (parameters) in the Environment
Entries node under the session bean of the following modules:

- For the Monitor EJB Module:
* ClientAgent bean.
* CleanupAgent bean.
* NotificationAgent bean.
* EventProcessor bean.
* DBBridge bean.
- For the WMQI_Connector_ID module
* WMQIConnector bean.
- For the ICS_Connector_ID module
* |CSConnector bean.
- For the Connector_ID module.
* MQWFConnector bean.
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The following table lists the required parameters that should be entered for each

session bean.

Property Name / EJB Name:

ICSConnector

monitor.db.schema

< | NotificationAgent
< | EventProcessor

< | ClientAgent
< | CleanupAgent

< | WMQIConnector

<

< | DBBridge

monitor.db.eqSchema

< | & | MQWFConnector

monitor.db.tablespaces.adminData

monitor.db.tablespaces.adminindexes

monitor.db.tablespaces.modelTables

monitor.db.tablespaces.modellndexes

monitor.db.tablespaces.processinstTables

monitor.db.tablespaces.processinstindexes

monitor.db.tablespaces.eventTables

monitor.db.tablespaces.eventindexes

monitor.db.tablespaces.processDataTables

NEYEYEYEY YRR
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monitor.db.tablespaces.processDatalndexes

monitor.db.tablespaces.securityTables

monitor.db.tablespaces.securitylndexes

monitor.db.tablespaces.processModelLob

monitor.db.tablespaces.processDatalob

monitor.db.tablespaces.configValuesLob

monitor.db.tablespaces.notifyExtraDatalLob

monitor.db.tablespaces.eventDatalLob

monitor.db.tablespaces.delayedEventDatalLob

SN R N AN BN AN AN BN BN RN

monitor.db.tablespaces.mbDetailLob

monitor.db.tablespaces.eqTables

monitor.db.tablespaces.eqindexes

monitor.db.tablespaces.conDetailDatalLob

IR ERN RN

monitor.db.tablespaces.defaultTablespace v

<
N

monitor.wmgi.enabled

N
N

monitor.wics.enabled

monitor.mqwf.enabled

monitor.security.mode

monitor.security.ldap.url

monitor.security.ldap.dn

monitor.security.ldap.password

monitor.security.ldap.naming.attr

monitor.security.ldap.root

monitor.security.ldap.dn.attr.id

N N N N N N RN RN

monitor.mgwf.configurationID

monitor.mqwf.encoding v

The following table provides the description of each parameter.

Parameter Name Type | Value Description

monitor.db.schema String | The Monitor Database Schema. The default value is WFM

monitor.db.eqSchema String | The MQSeries Workflow Database (Event Queue Database)
Schema. The default value is FMC

monitor.mqwf.enabled String | Type True if you are using MQ Workflow as your engine or False
otherwise.

monitor.wmgi.enabled String | Type True if you are using WMQI as your engine or False
otherwise.
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monitor.wics.enabled String | Type True if you are using WICS as your engine or False
otherwise.

monitor.security.mode String | The applied security mode:

* Type MQ for MQ Workflow security mode if you are using MQ
Workflow as your engine.

* Type LDAP for LDAP security mode or Local for local security
mode if you are only using WMQI as your engine.

monitor.security.ldap.url String | The LDAP Server URL and port number (for example Idap://
Idapsrvr:389/).

This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.security.ldap.dn String | A Distinguished Name (DN) for an LDAP Server authorized user
that will be used for logging in to this LDAP Server, and perform-
ing the search in the LDAP users' tree.

This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.security.ldap.password String | The password of the defined User DN.

This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.security.ldap.naming.attr | String | The name of the prefix that precedes the user ID in the LDAP
Server database (i.e. CN, UID,...etc). The value of this parameter
varies between the different types of LDAP Servers.

This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.security.ldap.root String | The starting point in the LDAP tree from which the query will start
searching for the full DN of the given user ID.

This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.security.ldap.dn.attr.id String | The name of the Distinguished Name attribute ID (for example
distinguishedName, entrydn ...etc. This value is case sensitive).

This parameter is added only if you are only using WMQI as your
engine with LDAP security mode.

monitor.mgwf.configurationID String | The used MQ Workflow Configuration (Default or Non-Default)

monitor.mgwf.encoding String | The MQSeries Workflow Database encoding. (This property must
be set if the MQ Workflow Database encoding is different from the
Monitor Server machine encoding)

In addition to the above parameters, there are additional parameters that
should be defined to hold the values of the Database TableSpaces
names that you want to use for physically storing the Monitor and
EventQueue database tables and indexes. You have the ability to use a
number of TableSpaces that are up to 22 different TableSpaces; 19 of
them are created in the Monitor Database and three of them are created
in the EventQueue Database. The database tables and indexes are
grouped and categorized so that each category can be assigned to a
separate TableSpace. You can define different TableSpace name as the
value for each system property. Alternatively, you can define the same
TableSpace for more than one system properties. In the later case, this
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TableSpace will be used for the tables and indexes that are
corresponding to these properties. You can also ignore defining any of
these properties, and in this case the tables, which are supposed to be
assigned to these TableSpaces, will be assigned to the default
TableSpace that can be defined by the
monitor.db.tablespaces.defaultTablespace property. If you did not define
this property then the database user default TableSpace will be used as
the default TableSpace..

Parameter Name Type | Value Description

monitor.db.tablespaces.adminData String | TableSpace name of the Monitor Database
Administration tables.

monitor.db.tablespaces.adminindexes String | TableSpace name of the Monitor Database
Administration indexes.

monitor.db.tablespaces.modelTables String | TableSpace name of the Monitor Database Static
model tables.
monitor.db.tablespaces.modellndexes String | TableSpace name of the Monitor Database Static

model indexes.

monitor.db.tablespaces.processinstTables String | First TableSpace name of the Monitor Database
Dynamic tables.

monitor.db.tablespaces.processinstindexes String | First TableSpace name of the Monitor Database
Dynamic indexes.

monitor.db.tablespaces.eventTables String | Second TableSpace name of the Monitor Database
Dynamic tables.

monitor.db.tablespaces.eventindexes String | Second TableSpace name of the Monitor Database
Dynamic indexes.

monitor.db.tablespaces.processDataTables String | Third TableSpace name of the Monitor Database
Dynamic tables.

monitor.db.tablespaces.processDatalndexes String | Third TableSpace name of the Monitor Database
Dynamic indexes.

monitor.db.tablespaces.securityTables String | TableSpace name of the Monitor Database
Security tables.

monitor.db.tablespaces.securityindexes String | TableSpace name of the Monitor Database
Security indexes.

monitor.db.tablespaces.processModelLob String | TableSpace name of the Monitor Database
Process Model LOB.

monitor.db.tablespaces.processDatal ob String | TableSpace name of the Monitor Database
Process Data LOB.

monitor.db.tablespaces.configValuesLob String | TableSpace name of the Monitor Database
Configuration Values LOB.

monitor.db.tablespaces.notifyExtraDatalLob String | TableSpace name of the Monitor Database Notify
Extra Data LOB.

monitor.db.tablespaces.eventDatal ob String | TableSpace name of the Monitor Database Event
Data LOB.
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monitor.db.tablespaces.delayedEventDatalLob String | TableSpace name of the Monitor Database
Delayed Event Data LOB.

monitor.db.tablespaces.mbDetailLob String | TableSpace name of the Monitor Database WBI
Message Broker LOB.

monitor.db.tablespaces.eqTables String | TableSpace name of the MQSeries Workflow
Database Event Queue tables .

monitor.db.tablespaces.eqlndexes String | TableSpace name of the MQSeries Workflow
Database Event Queue indexes.

monitor.db.tablespaces.conDetailDatal.ob String | TableSpace name of the MQSeries Workflow
Database Configuration Detail Data LOB

monitor.db.tablespaces.defaultTablespace String | The name of the default TableSpace that is used
for any tables or indexes category that has not
been assigned to a specific TableSpace.

=&y _| In case you have an existing database that belongs to a previous

& version and contains data, then you will need only to add the
monitor.db.tablespaces.defaultTablespace parameter. All other
parameters that hold the TableSpaces names should not be
added.

=& _| Important Note: In Oracle Database, the Event Queue database
¥ schema and the Monitor Database Schema must be the same as
the Database Administrator's User Name.

=Ly_| Important Note: In MQ Workflow, a default configuration must be
=" | defined.

To add each one of these parameters, do the following:
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- Right click inside the right-hand table, and select New from the shortcut
menu that appears. The New Environment Entry dialog box appears.

New EnviconmentEntry x|
[Ganeral]
Ermironmeant entries define wanables used to customize the business logic for an
application.
Mama: |

alug: |

Type: *| String =l
Dascription

ok | aoy | cancat | Hew

- Type the parameter name in the Name field.

- Type the parameter value in the Value field.

- Select the parameter type from the Type drop down list.

- Click OK. The new parameter will be added to the table.

Select File > Save from the menu to save the monitor.ear.

Exit the Application Assembly Tool.

1.1.7 Install the WBI Monitor Enterprise Application

Now you will create and install an Enterprise Application for WBI Monitor.
1. From the left hand tree, expand the Applications node.

2. Click the New Enterprise Application hyperlink. The Preparing for the
application installation wizard first page appears.

3. Click the Browse button to locate the monitor.ear file. The Open dialog
box appears.

- Select the monitor.ear file located in server folder.
- Click Open. The file will be selected.

4. Inthe second step of the Preparing for the application installation
wizard, select the Generate Default Binding check box

5. Click Next. The Install New Application wizard will start on its first
step’s page:

© Copyright IBM Corp. 2002, 2004 123



- In the Directory to Install Application field, enter the directory you
want to be used for installing the WBI Monitor Enterprise Application. If
you leave this field empty, then the default directory that the IBM
WebSphere Application Server used for installing the applications will
be used (i.e. C:\WebSphere\ApplicationServeninstalledApps).

- Select the Deploy EJBs check box.
- Leave the other settings with the default values.
- Click Next.

For the Steps 2 to 4 in the wizard, click Next without changing any
parameters.

In step 5 page (Mapping Resource References to Resources) do the
following:

- If the Monitor database and the Event Queue database are located in
the same physical database (one database), then all resource
references are mapped to the same physical data source named
Monitor_Pool_DataSource.

- If the Monitor database and the Event Queue database are located in
two physical databases, then map each resource reference to the
appropriate resource according to the following table:

EJB Resource Ref. Data Source Name Data Source JNDI Name
ClientAgent jdbc/MonitorDataSource Monitor_Pool_DataSource MonitorPoolDataSource
CleanupAgent jdbc/MonitorDataSource Monitor_Pool_DataSource MonitorPoolDataSource
EventProcessor jdbc/MonitorDataSource Monitor_Pool_DataSource MonitorPoolDataSource
NotificationAgent jdbc/MonitorDataSource Monitor_Pool_DataSource MonitorPoolDataSource
MQWZFConnector jdbc/MonitorDataSource Monitor_XA_DataSource MonitorXADataSource
MQWFConnector jdbc/EventQueueDataSource Event_Queue_XA DataSource EventQueueXADataSource
MQWFConnector jdbc/ Event_Queue_Pool_DataSource | EventQueuePoolDataSource

PoolEventQueueDataSource

WMQIConnector

jdbc/MonitorDataSource

Monitor_Pool_DataSource

MonitorPoolDataSource

ICSConnector

jdbc/MonitorDataSource

Monitor_Pool_DataSource

MonitorPoolDataSource

124

To perform the mapping:

- Select the Reference(s) you want to map to a specific resource (data
source) by selecting the check box in its row in the table.

- Select the appropriate resource (Data Source) from the Specify
existing Resource JNDI name drop down list.

- Click Apply. The selected resource will be mapped to all selected
references, and its name will appear in the JNDI Name column's cells
for these references.

For Step 6 in the wizard, click Next without changing any parameters.
In the Step 7 page (Map modules to application servers) do the
following:
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- Select the Application Server on which you want to deploy the WBI
Monitor Enterprise Application from the Clusters and Servers list.

- Select the check box next to the Module column header to select all
existing modules (Monitor, MonitorService, and MonitorClient).

- Click Apply.
- Click Next.
10. Inthe Steps 8, click next without changing any parameters.

11. In Step 9 (Summary) the settings you have chosen will be listed.
Review these settings. To return to any previous step, click the step
number hyperlink and or click Finish if all settings are correct.

12. Wait until the installation is finished and the confirmation page appears

13. Click Save to Master Configuration hyperlink to save your
configuration. Then click Save in the confirmation message.

1.1.8 Assign the Created Shared Library to the Installed
Enterprise Application

Now you should assign the MQLib shared library that you have created before
to the WBI Monitor Enterprise Application that you have just installed. To do
this:

1. Inthe left hand tree, expand the Applications node.

2. Click the Enterprise Applications hyperlink. The Enterprise
Applications page appears.

—

—
—

Memse | Baws | Prefecences | Logea | Help | (]
Uses I mmn
- Enterprize Applications
Anary A koA il hcabong A - d F |
B Senveen rorinled spgkoatong & prgie spplkcaton can be Sevired onba mulipie jeresy (1]
B Applcaticors

Totwt

Ll Vit e @ Fas

B Resources ] Freterprees
1 Sty stact| stop] mnstadt || uninstad | updse | Espeet | | Evpenoou |
E Ervrorvrart - - =
B Syuten Adrririon r _m' _“-" -G
B Froumde srasotineg r (EisfApic o +

B oy ‘=

[ PalsEationens +

r | iapbesCalery +
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3. Click the IBM_WBI_Monitor hyperlink (or the name of the installed
Enterprise Application of the WBI Monitor if you have changed the
default name). The IBM_WBI_Monitor Configuration Page appears.

™

Mome | Save | Pieferenies | Logen | Mew |
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4. Click the Libraries hyperlink from the Additional Properties table. The

Library Ref page appears.

5. Click Add. The Configuration page of the new Shared Library

Reference appears.
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6. Select the MQLib shared library from the Library Name drop down list.

Click OK.

8. Click Save in the top menu bar to save your changes. The Save page
appears.

9. Click Save.

1.1.9 Regenerate Web Server Plug-in

Now you must regenerate the Web Server Plug-in to be adequate with the
installed Enterprise Application. To regenerate the Web Server Plug-in:

1. Inthe left hand tree, expand the Environment node.

2. Click the Update the Web Server Plugin hyperlink. The Update web
server plugin configuration page appears.

T ., —
b=
Heme | Save | Frelerenies | Logest | Help | hﬂ
Usaa Wi mowear
Update wab server plugin cenfiguration
Anat
H .-"'. Tha vl parwer pilapm oonfgur slon fis controh what corient o Sena s bom e sl gerees o e sibosfion e ves Thig die sl e
B Senven rpgerane ahed wwn peeepe clnbee, FTTF benapor, or wwbus Pocd sl confqurasbions e changesd T peree sled plugreclg smil fie o piscesd n e
B Appikcwors confe direciany ol Be Weblhphere noislalon By web terve o o eled o reerole s b, you sl merusly soree o Sie 50 Sl s fes
5] Fwiorce:
Lk e O DB B0 wadsle et plugen Cordgur abon e
B Leturty
B Erveronerert m '\CIF:H_I
rlanl Mot Wi of dowmioad T vk il 1
(it SYSlLCRer g bR
Shaeglgewey
B g
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8 Froumee sresotfeg

3. Click OK.

1.1.10 Restart the Web Server

Now you should restart the Web Server you have.

Example: If you installed IBM HTTP Server as the Web Server then do the
following:

1. From the Windows Taskbar, select Start > Programs > IBM HTTP
Server 1.3.26 > Stop IBM HTTP Server.

2. Wait until the confirmation message that tells you that the IBM HTTP
Server has been stopped.
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3. From the Windows Taskbar, select Start > Programs > IBM HTTP
Server > Start IBM HTTP Server.

4. Wait until the confirmation message that tells you that the IBM HTTP
Server has been started.

1.1.11 Start the Application Server and the Enterprise
Application

For IBM WebSphere Application Server v5.0

You must restart the Default Server (serverl) after you deployed the WBI
Monitor new Application Server. To do this:

1. On Windows platform, run a command prompt window. On AIX or
Solaris platforms start a terminal console window.

Change the directory to <WebSphere>\bin
Type the following command line:

stopserver serverl

(2% [ This command is case sensitive.

4. Wait until the Application Server is stopped and the confirmation
message appears, and then type the following command line:

startserver serverl
5. Wait until the Application Server is started and the confirmation
message appears.
For IBM WebSphere Deployment Manager (Network
Deployment) v5.0

From the Administrative Console, do the following:
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1. From the left hand tree, select Servers > Application Servers. The
Application Servers page appears.

e —
} - } — =4
o
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2. Select the MonitorServer Application Server by selecting the check box
next to the Application Server's name.

=&y _| If you have created the application server with a different name or
you have deployed the Monitor Enterprise Application on a
different Application Server then select it from the list.

3. Click Start.
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WBI Monitor Server Un-
deployment

This section is used to completely remove the WBI Monitor Application Server.
To completely remove the WBI Monitor, perform the following steps:

1.
2.

Open the WebSphere Administrative Console.

Uninstall the WBI Monitor Enterprise Application (the default name is
IBM_WBI_Monitor).

- From the left hand tree, select Applications > Enterprise Applications.

- Select the check box next to the IBM_WBI_Monitor Enterprise
Application name.

- Click Stop.

- Select the IBM_WBI_Monitor Enterprise Application again.

- Click Uninstall.

Delete the HTTP Port that you have added to the Host Aliases list.

Delete the MonitorServer Application Server.

If you have deployed the WBI Monitor Enterprise Application on
the Default Server named serverl, then do not perform the above

two steps (3 and 4).

5.
6.
7.
8.

10.

Delete the added MQLib shared library.
Delete the added JDBC Providers.
Save your changes.

Delete the file monitor_deployed.ear from
<WebSphere>\AppServeninstallableApps\

Delete any reference for WBI Monitor from
<WebSphere>\AppServeninstalledApps\

Delete the directory named MonitorServer which is located in
<WebSphere>/temp/<WAS_NODE_NAME>/

This directory does not exist if you have deployed the WBI Monitor
Application Server on the default (base) Application Server named

serverl

11.

Restart the WebSphere Application Server.
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Appendix C: IBM DB2 7.2 Database
Server Configuration

This chapter provides detailed steps about configuring your database server by
creating the Monitor database and configuring both the Monitor database and
the Event Queue database (the IBM MQSeries Workflow or the IBM
WebSphere MQ Workflow database) using IBM DB2 UDB 7.2 with fixpack 5 on
Windows platform.

1  Creating the Monitor Database

To create the Monitor database
1. Open DB2 Control Center.

2. Create a new Database (No specific name is required, but IBM WBI
Monitor recommends WFMDB as the Monitor database name).

- Expand the tree in the left tree browser until you reach the Databases
node.

- Right-click the Databases node and select Create > Database Using
Wizard from the shortcut menu to create the database. The Create
Database dialog box opens.

- Type WFMDB in the Database Name text box, and WFMDB in the
Alias text box

- Click Finish

3. Configure the Database Instance on which the database has been
created by running the following commands from the command line, and
then restart the DB2:

- db2set DB2_RR_TO_RS=YES
- db2set DB2_HASH_JOIN=Y
- db2set DB2_EXTENDED_OPTIMIZATION=ON

4. Configure the created database by adjusting the following configuration
settings:

- Right-click the WFMDB and select Configure from the shortcut menu.
- In the Configure Database dialog box, select the Performance tab.

- Scroll the Parameters grid and change the values of the following
parameters to these values:

* Maximum Storage for Lock list: 50000
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* Application Heap Size: 4096
* Application Control Heap Size: 4096

- Select the Application tab and change the value of the following
parameters:

* Maximum Lock per application: 50
* Lock timeout: 60

- Select the Logs tab and change the value of the following parameter:
* Minimum commit group: 3

- Click OK.

[z%_| In order for the above parameters to take effect, you must bounce
¥ the DB2 instance for the instance parameters and restart
WebSphere Application Server for the database parameters.

5. If one of the business processes in the organization file (.org) contains
more than 55 business measures, you should calculate the page size by
performing the following steps:

- From the .org file, calculate the maximum number of business
measures in any process of the model

- Divide the calculated number by 55

- Round the result number up to the nearest integral value. (e.g. if the
result is 1.3 then the you should round it up to 2)

- Multiply the last value by 4K.

- Round the result up to the nearest value of 8K, 16K, 32K, etc. This will
be the required page size. (E.g. if the result is 12K, then the required
page size is 16K)

2  Creating the Buffer Pool

Create a Buffer Pool named HFXBP with the calculated page size:
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1. Open IBM DB2 Control Center

& Control Center Ol x|
Control Center  Selected  Edit View Tools Help B G
2 :l@j@lgﬁlj{ﬁl 2 @3
{[Svstems
Eg’]MONITORSRVR Mame |N0dename |Operatingsystem |T\,rpe |
B D Instances g_'?l MOMITORS... MONITORE Windows NT DB2 WY
El-<2 DB2
EIDDatabases
B D Gateway Connections
[+ .-E.DBQCTLSV
Kl | i
I I L

Expand Databases > WFMDB

3. Right click Bufferpools and select Create from the shortcut menu

In the Create Buffer Pool dialog box, do the following:

- For the Buffer Pool field, type the name of the Buffer Pool (No specific
name is required, but IBM WBI Monitor recommends HFXBP as the

Buffer Pool name).

- In the Page Size combo box select a number that equal to the
calculated page size you calculated in the previous steps, then click

OK.

& Create Buffer Pool

MOMITORSEYR - DB2 - WEMDB

Buffer poal name :

Fane size |4 vl
Size in 4 KB pages 280
[ Use extended storage
[ Use default bufferpool size

ok || enowscr

Cancel

Help

5. Bounce the DB2 Instance.

© Copyright IBM Corp. 2002, 2004

133



3

134

Creating the TableSpaces for
EventQueue and Monitor
Databases

1.

[# Create Table Space i X]

ASANY - DBZ - \WFMDB
Table space name |HF>:

Type of fable space Space management
+ Ragular  System
" Lon

il + Database

" System femporary

" Usertempora

In WFMDB database, create the required table spaces with the
calculated page size.

The following steps describe how to create a sample table space named
HFX:

- Open the IBM DB2 Control Center again
- Expand Databases > WFMDB

- Right click Table Spaces and select Create from the shortcut menu,
then select Table Space from the sub menu. (Don'’t select Table
Space Using Wizard)

- In the Create Table Space dialog box do the following
* In the Table Space Name text box type HFX

ry

Container narme

cAaaMsaLLIENContainers\iMonitorContainer

Total allocated: 100.00 MB

Type |[Size (MB}

Change...

i

Remoyve

Cnmmsntl

0K Cancel | Show SGL Adgfmr:ad... | Help |

* In the Space Management section select the proper management
method that you want to use (System or Database).

Click Add.
In the Add Container dialog box, do the following:

*

*

*

If you selected System as the TableSpace management method:
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- In the Add Container dialog box:

& Add Container

Container

IFMCDEICDntainer

Current directory

|c:1m1 oniton DB 2\Eventaueue

Directories

Drives

C: | 4276 MB available
0].8 | Cancel | Apply

Help

- In the Container Name text box, type the container name

- In the Current Directory text box, type the container current

directory or select the directory path, then click OK.

* If you selected Database as the TableSpace management

method:

© Copyright IBM Corp. 2002, 2004

135



136

- In the Add Container dialog box

x
File size
| 100 {mB |
 File
" Raw device
Contalner Current directory
HF¥XContainert CABMSGLLIBYC ontainersiMonitorContainerst
Files Directories

Drives

|c = | 5187 W8 avaliable

Qk I Cancel | I Apply I Help

- In the File size text box, enter the container file size.
- In the Container Name text box, type the container name

- In the Current Directory text box, type the container current
directory or select the directory path, then click OK.

* Click Advanced
* In the Advanced dialog box:

™ Advanced |
MONITORSRYR - DBZ - WFMDHB
Fage size |4 :l kB
Extent size I 32 4B pages
Prefetch size |1 fi ;I 4B pages
Owerhead I 241 ms
Transfer I 0.9 ms
Buffer pool

(0] | Cancel | Help |

- In the Page Size combo box select a number that equal to the
calculated page size you calculated before.

- In the BufferPool field, select HFXBP
- Click OK
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* Click OK to create the Table Space and to close the Create Table
Space dialog box

2. In the MQ Workflow database (e.g. FMCDB), create the required table
spaces. Repeat the above steps in order to create each table space.

(74 | The value of the page size of the table space of the MQ Workflow
¥ database is not affected by the number of business measures in
the organization file processes.

2% | Make surethat IBM DB2 Server is configured for JDK 1.2 or higher.
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Appendix D: Controlling the Logging
Service in IBM WBI
Monitor v4.2.4

IBM WebSphere Business Integration (WBI) Monitor provides you with the
capability of logging all the messages that are transacted at run time in its
various components. You can control the Logging service to log only specific
types of messages, or to log all types of messages that are associated with one
or more function areas (components) of the application.

The ability to control the logging service manifests significant importance as it
limits the amount, and type, of the data that is saved to the WBI Monitor log file.
This remarkably enables the user, and thus customer support team members,
to trace source of a particular problem more easily by limiting the logging of
messages to only those pertaining to the parts of the application in which
problems take place. Hence, this eliminates the need for analyzing and scrolling
down unneeded messages (e.g. Error, Warning...etc) that may exist in a
conventional stretched log file.

The produced WBI Monitor log files are mainly stderr.txt and stdout.txt. In
case of WAS 4.0, they could be found in the folder named Logs that resides in
the directory on which you have deployed the WBI Monitor. In case of WAS 5.0,
they could be found in the folder named Logs that resides in the root
WebSphere directory.

The control of logging service is implemented through the definition of one or
more categories and/or detail Level in the Java Virtual Machine tab in WAS
4.0.2, or WAS 5.0.
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Message Logging/Tracing

The logging service is controlled through two system properties. These two
properties are: (Detail) Levels, and Categories.

The first system property (Levels) enables the logging of messages based on
defined (detail) Levels. Each level is an integer value that represents one or
more types of messages to be logged. The second system property
(Categories) enables logging all debug messages related to one or more
function areas (categories) that you specify in a comma-separated parameter
on WAS 4.0, or WAS 5.0.

Levels

You can setup the logging service to log messages or errors depending on the
level you specify. The level of details to be saved to the log file is defined by
specifying the appropriate integer value from the following table:

Level Description

1 This level enables logging Fatal Error messages.

2 This level enables logging Error messages.

3 This level enables logging Warning messages.

4 This level enables logging Debug messages.
Categories

When you specify a category in the logging service, you enable the logging of
all the debugging messages that are related to this category. In case of
specifying multiple categories, at least one comma must separate between
every two successive category hames.

For example ADMIN,IMPORT,,, SECURITY,,," is valid a value, and implies that
you enables the logging of the debug messages for these three categories.

Any values that you type other than those listed in the following
table will be ignored.

For categories to be active, you have to use detail Level 4.

The following table depicts the function areas (categories) whose debug
messages can be logged in the WBI Monitor log file.

IBM WBI Monitor - Deployment Guide



Category

Description

ALL It means that all categories will be logged.
NONE It means that no category will be logged.
IMPORT It means logging messages concerning the import of model, and the export of

actual values.

EVENT_PROCESSING

It means logging messages concerning the module handling MQ Workflow
events and calling appropriate monitor engine functions.

EVENT_COLLECTOR

It means logging messages concerning module handling the retrieval of audit
trails events and process data from MQ Workflow.

MONITOR_ENGINE

It means logging messages concerning module handling the event processor
commands to store appropriate data in monitor database.

BUSSINESS_ENGINE

It means logging messages concerning the calculation of business measures at
the appropriate locations, and firing notifications when necessary.

DATABASE It means logging messages concerning database transactions such as
inserting, updating, deleting, or querying data.
SECURITY It means logging messages concerning adding, removing, and updating users,

groups, and users’ & groups’ permissions/constraints, in addition to login and
logout.

ADMIN_MANAGER

It means logging messages concerning suspending, resuming or terminating
process instances. This also includes logging messages related to transferring
work items, creating or dropping database, starting or stopping monitor
services, and starting or stopping event queue.

CONFIGURATION It means logging messages concerning adding, updating and deleting
configurations and system configurations.

REPORT It means logging messages concerning the handling of the different reports
displayed in the Business Dashboard.

WFD It means logging messages concerning the Workflow Dashboard.

REPOSITORY It means logging messages concerning the retrieval of the model elements (org

units, employees, processes...etc).
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2  Controlling the Logging Service

You can control the logging service in WAS 4.0 or WAS 5.0 by following the
steps below.

21 WAS

1.

2.2 WAS

142

4.0

Access the Java Virtual Machine page.

- Click WebSphere Administrative Domain > Nodes > NodeName >
Application Servers > server name (whose JVM settings you want to
configure [MonitorServer] in the console navigation tree).

- Select the JVM Settings tab.

On the Java Virtual Machine tab, specify values for the JVM settings as
needed. Specify command-line arguments to pass to the Java virtual
machine code that starts the application server process in a name-value
pairs:

- Click Add to enter an entry in the System Property table.

- Specify name/value pair property: for example type
monitor.debug.level (or monitor.debug.cateogory) in the Name
field, and type the value in the Value field.

- Click Apply to view a page with your new settings.

Restart the application server.

5.0

Access the Java Virtual Machine page.
- Click Servers > Application Servers in the console navigation tree.

- On the Application Server page, click on the name of the server
whose JVM settings you want to configure [serverl].

- On the settings page for the selected application server [serverl], click
Process Definition.

- On the Process Definition page, click Java Virtual Machine in the
Additional Properties.

On the Java Virtual Machine page, specify values for the JVM settings
as needed.Click Custom Properties in Additional Properties:

- Click New to display the settings page for your internal system
configurations property.

- Specify name/value pair property: type monitor.debug.level (or
monitor.debug.category) in the Name field, and type the value in the
Value field.

- Click Apply to view a page with your new settings.
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- Click OK to return to the Custom Properties page, where your new
property appears in the list.

- Click OK to return to the Java Virtual Machine page.
Click Save on the console taskbar.

Restart the application server.
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Deployment on OS/390 and
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Chapter 5: WBI Monitor Deployment
on OS/390 and z/OS

Platforms

This chapter contains detailed steps for deploying IBM WBI Monitor on IBM
WebSphere Application Server 4.0.1 for OS/390 and z/OS Platforms. The
following figure illustrates the deployment sequence and the required

environment to perform the deployment.

Workstation

Wi n dons

TCRIP
Connection

[BM YWebSphere

S$1390 Machine

055290 ar =05

IBM WebSphere
Application Server

Assemhbly Tool for
Q55390 and Z05 Administrators Console
]
£ ) &
& % 5
i A z
z = =
£ ;
§'i§ %{; § Creployrment
o S P Steps
ol - o N
gg %;; =
Ec & &
=g & 'Dq
Qriginal Modified
monior.ear file monilor.ear file

4.01

Deployed honitor
Application Senver

The following conventions are used for all the instructions throughout this

document:
« <Monitor> = The Monitor installation directory. e.g. C:\WBIMonitor

« <\WebServerName> = The name of the machine that hosts the Web

server for which the WebSphere is configured.

* <ServerName> = The name of the server on which the Monitor will be

installed.

* <MonitorWebPath> = The monitor web application web path eg. /monitor.
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* <MonitorServiceWebPath> = The monitor web application web path eg. /
monitorservice.

[z%_| Important note: The names and paths of folders and files are case
¥ sensitive.

[z%_| Important note: Make sure that the user you are using have all
i needed permissions. For example, using a user who has no
permissions on WebSphere will fail to deploy the monitor.

[z%_| The Monitor will not work if the server properties
¥ client.encoding.override or default.client.encoding are set to any
encoding other than UTF-8.
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5.1 IBM WBI Monitor Deployment

5.1.1 Configure the Database Server

The first thing you have to do is to configure the Database Server. To do this:
1. Create the Monitor database (i.e. WFMDB)

2. Create the required TableSpaces in both the Monitor Database
(WFMDB) and the EventQueue Database (FMCDB). WBI Monitor
allows you to control the distribution of the Monitor and the EventQueue
Database tables and indexes into a number of TableSpaces that are up
to 22 TableSpaces; 19 of them are created in the Monitor Database and
three of them are created in the EventQueue Database. The database
tables and indices are grouped and categorized so that each category
can be assigned to a separate TableSpace.

This number is the maximum number of TableSpaces to which you can
assign the database tables and indexes. This means you do not have to
create all these TableSpaces, but you can create part of them. In this
case, during the deployment steps, you can assign more than one group
of tables or indices to the same TableSpace.

Please refer to the section named Database Tables and Indexes
Allocation with Multiple TableSpaces in Chapter 3: Database Server
Configuration of this guide for details about the distribution of the Monitor
and EventQueue database tables and indexes on multiple TableSpaces.

3. Adjust the Database authorizations for the User ID that will be used by
the WBI Monitor to access the database. The following are the required
actions on the database that should be used in order to set the needed
permissions for the given User ID:

- DDL actions

* ALTER TABLE

* CREATE TABLE & DROP TABLE

* CREATE TRIGGER & DROP TRIGGER
- DML actions

* SELECT

* INSERT

* UPDATE

* DELETE

* SELECT FROM SYSIBM.SYSTRIGGERS

* SELECT FROM SYSIBM.SYSDUMMY1

4. Create the Monitor and EventQueue Database Tables by running the
DDL files named monitorCreate.sgl and eqCreate.sql respectively.
These files are located in the <Monitor>/server/docs/ddl folder.
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Before running, these files have to be edited in order to update them with
the actual Schema and TableSpace name that you have created in the
database. To do this:

- Open each of these two files in any text editor.

- Replace the variables named $TABLESPACE$ and $SCHEMAS$ with
the actual name of the TableSpace and Schema in each creation
statement of the tables and indexes.

For example:
The original statement is:

CREATE TABLE "$SCHEMAS$"."SCHEMA_HEADER"("VERSION"
INTEGER NOT NULL) IN $TABLESPACE$$

The modified statement should be

CREATE TABLE "WFM"."SCHEMA_HEADER"("VERSION"
INTEGER NOT NULL) IN AdminTablespace$

- Save and close the file.

Important Notes:

» The delimiter used in these files is the Dollar Sign ($). You
must set this delimiter in the command that you will use to
run these files specifically, otherwise the default DB2
delimiter (;) will be used and the script will fail to execute.

e For distributed installation and deployment (where the
Database server is located on a z/OS or an OS/390 machine
while the WebSphere Application Server is installed and
used from a different Windows, AlX or Solaris machine),
You must make sure that the Database Client is installed on
the client machine where the WebSphere Application Server
is installed, and is properly configured and connected to the
Database Server that exists on the Mainframe. Consult your
database Administrator for information about configuring
the DB2 database client to connect to the remote database.
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5.1.2 Modifying the Monitor Enterprise Archive File

Before starting the deployment of IBM WBI Monitor application server on
WebSphere Application Server, you should first modify the original monitor.ear
file that has been installed on your machine in <Monitor>/server/server using
the manual deployment option in the WBI Monitor installation wizard. This is

important in order to make this file compatible with OS/390 and z/OS operating
systems.

The following sections and their steps describe how to use the Assembly Tool
for z/OS and OS/390 to modify the monitor.ear file:
5.1.2.1 Importing the Monitor Enterprise Archive File

1. Open the Assembly Tool for z/OS and OS/390.

2. From the Assembly Tool menu bar, select Selected > Import.

(ol x|
-
| Eaqont
| Gow
BBOG40481 Intialization complets for Application Assembly Tool for 2108 and 051390, version AT 4.00.029, using “]
Viindows 2000, [
-
| |
The Import Application dialog box appears.
5
Enter the EAR file path name prefix:
| DWEIMonitord24\serveriserverimonitar |ear | Choose..
A
_ Cancer | | tew |
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3. Click Choose. The Select EAR File to Import dialog box appears.

[ Sclect EAR file to import x|
Lok | C)server ~| =l (@] o] E“
E monitor ear I McMul'lecmm
o “IMETA-INFIMANIFEST MF =
META-INFrapplic ation xrmi
META-INFbm-application-bnd aomd
META-INFlibm-application-ext xmi
[ jar
mnnlmranl lar =
File psme: | monitor.ear | | oK |
Fes of type: | EAR fles (ear) v | | cancel |

4. Locate and select the monitor.ear file from the temporary folder in which
you have placed a copy of it, click OK, and then click OK in the Import

Application dialog box.
The IBM_WBI_Monitor node will be created and displayed under the
Applications tree.

E: Application Assernbly Tool for 2/05 and 05/390 M
File Selected Build View Edi Filer Options Help
SAED OX d=080 Q 29
|Iulr.=ﬁru -
% 1 Applications 4

€= |BM_WEI_Monitor i
Il =]
[ |
| |
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5.1.2.2 Deleting the XMI Files

1. Right-click the IBM_WBI_Monitor node and select Modify from the

shortcut menu that appears.
& [0 Applications

@ 1B i
¢ %%
Delete

Save
Cancel

¢  Export..
Yalidate
Deploy
Expand
Collapse
Properties »
¢  Refresh

Help

2. Select the Files tab on the right.

Dh:lulll sian Adsemnbly Toal lae 2705 snd 057350 .-.IEI.EI
@9 BX +#=09 Q L9
[ e v wtaniton v)
T Toon e p——
? , .
% 2 EpJars Fiirs
= Connecior_ID
&= Mensor Relaty palt Modified | Sirw |I ]
S WMOI_Connector_i0 METAINFI BIZEA3 1044 PM L
® [ WwebApps META - INFMAMNIF EST MF BIZR03 10044 P 107
B Monaord lignd ﬂE'I'.A.-Mh!ﬂ-tinur[.l.m : ) BA1A03 11:35 AM 1,378
& MonsorGerdce META-INFAbm-appilcation-bnd xmi | B3 11:35 AM [0
3 Application Chents METAINFAD M- applic ation- gt xmi B 103 1135 A LE
i &t B0 11:36 AW 108,418
melsmodel jar BFZRA0G 1042 PM 13,517
mGniopd jar BUZEAO3 10042 P 168,161
monifoet liend war 2803 1044 P BATEET4
imoniigee lien]_WebApp jar PO ERRRET U 2,854
Wl TR BUTEA03 10043 P 48B4 5TH
monion: enice war BIZRADG 10043 P 21,252
monforsenice_WebApp jar QM35 A 2854
migwdc cnniector jar BUIE03 10043 PM 24618
SELLN|ar BIIRA03 1043 P 482 545 =
Wmpor_ | | Delete | Vew. | Baact. | (oo
BEOI404E Infalzabon complete for Applic aticn Assermbly Tool for 0S8 and OSr300, version AAT 4 00032, using Windows 2000 -
BEOR05I11 Agplication IBM_WBI_Monfior was deléled
BEOS40011 Application IBM_VWBI_Mondos was impoded from Sle DVWOSIENR aleghSourcests- 180 Frmonitar aan

i

| 6 _WEI_Manitor: Not modified

© Copyright IBM Corp. 2002, 2004

3. From the Files list, select each file that has .xmi extension (2 files), and
then click Delete for each selected file.

153



4. Right-click the IBM_WBI_Monitor node and select Save from the
shortcut menu.

L Applications
§ |BM_WEI_Monkior

? Elb Jz
¢ Conna
,__-'
Ly Cancel
@ Monio
&
Properties ¥
@ Wh|
=

5. Repeat the above steps for the Connector_ID, Monitor, and
WMQI_Connector_ID nodes under the IBM_WBI Monitor>EJB Jars
node, and for the MonitorClient and MonitorService nodes under the
IBM_WBI Monitor>Web Apps node to delete all files that have the
extension .xmi from their files list.

5.1.2.3 Modifying the Session Beans

Expand the Applications tree

2. Do the following for each session bean of the following EJB modules
under IBM_WBI_Monitor \ Ejb Jars:

- For the WMQI_Connector_ID module
* WMQIConnector bean.
- For the ICS_Connector_ID module
* |CSConnector bean.
- For the Monitor EJB Module:
* ClientAgent bean.
* CleanupAgent bean.
* NotificationAgent bean.
* EventProcessor bean.
* DBBridge bean.
- For the Connector_ID module.
* MQWFConnector bean
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3. Right-click the <SessionBeanName> node in the tree and select

Modify from the shortcut menu that appears.

@ - Applications
& 18M_WHI_Moniior
@ 3 EjbJars
9 Connector_|D
{7} Entity Beans
9 [ Session Beans
AV GO
Q Monitar |
{1 Entity Beans |
® 1 Session Beat

Cleanupigent:
Clientgent

EventProcesst
MotificationAge

o Will_Connector_ID |
{1 Entity Beans |

4. Select the +RunAs tab on the right.
5. Click Modify All.

S
Cancel
Expand

DBBridge | Collapse
Properties
Refresh
Help

Type | Role | interface | Method [P
Callar Horne create
Callar Home gelEJEMeta. .
Callar Horne getHomeH. .
Callar Home rRmove janva lang 0.
Callar Horme FRFOYE javanajbH...
Callar Remole craataMonit . com holoeso.
Coallar Remols inillatizeko. . comholoso.
Callar Remole créalaEvent.. comholoso..,
Callar Remola inflalizedEy... com holoso.
Callar Rermole IsManitarD. L
Callar Bapmate  |sbinnitna b
[ ronny. | [ Somyer] | [ view |

The Modify all runas permissions dialog box appears.

EH-:--:I-ir all runas permisshons _5]
Type

=]

[ ok | | cancel |

| Help |

6. Select Server from the Type combo box.
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7. Click OK. The Type column will display Server for all Runas
Permissions.

9. Inthe Environment tab add the EJB environment parameters as the
following table:
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Property Name / EJB Name:

ICSConnector

<« | ClientAgent

< | CleanupAgent

< | NotificationAgent
< | EventProcessor
< | WMQIConnector

< | DBBridge

AN

monitor.db.schema

< | < | MQWFConnector

monitor.db.eqSchema

monitor.db.tablespaces.adminData

monitor.db.tablespaces.adminindexes

monitor.db.tablespaces.modelTables

monitor.db.tablespaces.modelindexes

monitor.db.tablespaces.processinstTables

monitor.db.tablespaces.processinstindexes

monitor.db.tablespaces.eventTables

monitor.db.tablespaces.eventindexes

monitor.db.tablespaces.processDataTables

monitor.db.tablespaces.processDatalndexes

monitor.db.tablespaces.securityTables

monitor.db.tablespaces.securitylndexes

monitor.db.tablespaces.processModelLob

monitor.db.tablespaces.processDatalLob

monitor.db.tablespaces.configValuesLob

monitor.db.tablespaces.notifyExtraDataLob

monitor.db.tablespaces.eventDatalLob

monitor.db.tablespaces.delayedEventDatalLob

NN N N N N N N N N N N N N N N N NN

monitor.db.tablespaces.mbDetailLob

monitor.db.tablespaces.eqTables

monitor.db.tablespaces.eqindexes

monitor.db.tablespaces.conDetailDatalLob

< s

monitor.db.tablespaces.defaultTablespace v

monitor.wmgi.enabled v v

monitor.wics.enabled v v

monitor.mqgwf.enabled v v

monitor.security.mode v
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monitor.security.ldap.url

monitor.security.ldap.dn

monitor.security.ldap.password

monitor.security.ldap.naming.attr

monitor.security.ldap.root

monitor.security.ldap.dn.attr.id

IR AN AR N BN BN RN

monitor.mgwf.configurationID

monitor.mgwf.encoding v

The following table provides the description of each parameter.

Parameter Name Type Value Description

monitor.db.schema java.lang.String | The Monitor Database Schema. The default value is
WFM. This property must not has null value.

monitor.db.eqSchema java.lang.String | The MQSeries Workflow Database (Event Queue
Database) Schema. The default value is FMC. This
property must not has null value.

monitor.mqgwf.enabled java.lang.String | Type True if you are using MQ Workflow as your engine
or False otherwise.

monitor.wmgi.enabled java.lang.String | Type True if you are using WMQI as your engine or False
otherwise.

monitor.wics.enabled java.lang.String | Type True if you are using WICS as your engine or False
otherwise.

monitor.security.mode java.lang.String | The applied security mode:

» Type MQ for MQ Workflow security mode if you are
using MQ Workflow as your engine.

» Type LDAP for LDAP security mode or Local for local
security mode if you are only using WMQI as your
engine.

monitor.security.ldap.url java.lang.String | The LDAP Server URL and port number (for example
Idap://Idapsrvr:389/).

This parameter is added only if you are only using WMQI
as your engine with LDAP security mode.

monitor.security.ldap.dn java.lang.String | A Distinguished Name (DN) for an LDAP Server autho-
rized user that will be used for logging in to this LDAP
Server, and performing the search in the LDAP users'
tree.

This parameter is added only if you are only using WMQI
as your engine with LDAP security mode.

monitor.security.ldap.password java.lang.String | The password of the defined User DN. This parameter is
added only if you are only using WMQI as your engine
with LDAP security mode.
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monitor.security.ldap.naming.attr | java.lang.String | The name of the prefix that precedes the user ID in the

LDAP Server database (i.e. CN, UID,...etc). The value of
this parameter varies between the different types of
LDAP Servers. This parameter is added only if you are
only using WMQI as your engine with LDAP security
mode.

monitor.security.ldap.root java.lang.String | The starting point in the LDAP tree from which the query

will start searching for the full DN of the given user ID.
This parameter is added only if you are only using WMQI
as your engine with LDAP security mode.

monitor.security.ldap.dn.attr.id java.lang.String | The name of the Distinguished Name attribute ID (for

example distinguishedName, entrydn ...etc. This value is
case sensitive). This parameter is added only if you are
only using WMQI as your engine with LDAP security
mode.

monitor.mqwf.configurationID java.lang.String | The used MQ Workflow Configuration (Default or Non-

Default)

monitor.mgwf.encoding

java.lang.String | The MQSeries Workflow Database encoding. (This
property must be set if the MQ Workflow Database
encoding is different from the Monitor Server machine
encoding)

In addition to the above parameters, there are additional parameters that
should be defined to hold the values of the Database TableSpaces
names that you want to use for physically storing the Monitor and
EventQueue database tables and indexes. You have the ability to use a
number of TableSpaces that are up to 22 different TableSpaces; 19 of
them are created in the Monitor Database and three of them are created
in the EventQueue Database. The database tables and indexes are
grouped and categorized so that each category can be assigned to a
separate TableSpace. You can define different TableSpace name as the
value for each system property. Alternatively, you can define the same
TableSpace for more than one system properties. In the later case, this
TableSpace will be used for the tables and indexes that are
corresponding to these properties. You can also ignore defining any of
these properties, and in this case the tables, which are supposed to be
assigned to these TableSpaces, will be assigned to the default
TableSpace that can be defined by the
monitor.db.tablespaces.defaultTablespace property. If you did not define
this property then the database user default TableSpace will be used as
the default TableSpace.

Parameter Name

Type | Value Description

monitor.db.tablespaces.adminData String | TableSpace name of the Monitor Database

Administration tables.

monitor.db.tablespaces.adminindexes String | TableSpace name of the Monitor Database

Administration indexes.

monitor.db.tablespaces.modelTables String | TableSpace name of the Monitor Database Static

model tables.
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monitor.db.tablespaces.modellndexes String | TableSpace name of the Monitor Database Static
model indexes.
monitor.db.tablespaces.processinstTables String | First TableSpace name of the Monitor Database
Dynamic tables.
monitor.db.tablespaces.processinstindexes String | First TableSpace name of the Monitor Database
Dynamic indexes.
monitor.db.tablespaces.eventTables String | Second TableSpace name of the Monitor Database
Dynamic tables.
monitor.db.tablespaces.eventindexes String | Second TableSpace name of the Monitor Database
Dynamic indexes.
monitor.db.tablespaces.processDataTables String | Third TableSpace name of the Monitor Database
Dynamic tables.
monitor.db.tablespaces.processDatalndexes String | Third TableSpace name of the Monitor Database
Dynamic indexes.
monitor.db.tablespaces.securityTables String | TableSpace name of the Monitor Database
Security tables.
monitor.db.tablespaces.securitylndexes String | TableSpace name of the Monitor Database
Security indexes.
monitor.db.tablespaces.processModelLob String | TableSpace name of the Monitor Database
Process Model LOB.
monitor.db.tablespaces.processDatal ob String | TableSpace name of the Monitor Database
Process Data LOB.
monitor.db.tablespaces.configValuesLob String | TableSpace name of the Monitor Database
Configuration Values LOB.
monitor.db.tablespaces.notifyExtraDatalLob String | TableSpace name of the Monitor Database Notify
Extra Data LOB.
monitor.db.tablespaces.eventDatal ob String | TableSpace name of the Monitor Database Event
Data LOB.
monitor.db.tablespaces.delayedEventDatalLob String | TableSpace name of the Monitor Database
Delayed Event Data LOB.
monitor.db.tablespaces.mbDetailLob String | TableSpace name of the Monitor Database WBI
Message Broker LOB.
monitor.db.tablespaces.eqTables String | TableSpace name of the MQSeries Workflow
Database Event Queue tables .
monitor.db.tablespaces.eqindexes String | TableSpace name of the MQSeries Workflow
Database Event Queue indexes.
monitor.db.tablespaces.conDetailDatal. ob String | TableSpace name of the MQSeries Workflow
Database Configuration Detail Data LOB
monitor.db.tablespaces.defaultTablespace String | The name of the default TableSpace that is used

for any tables or indexes category that has not
been assigned to a specific TableSpace.
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In case you have an existing database that belongs to a previous
version and contains data, then you will need only to add the
monitor.db.tablespaces.defaultTablespace parameter. All other
parameters that hold the TableSpaces names should not be
added.

[z&_| Important Note: In MQ Workflow, a default configuration must be
L= | defined.

To add each of these parameters do the following:

- Click Add. The Add environment entry dialog box appears.
x

Entry narms

l.

Type

| lavatang.String |
Value

I |

Descriplion

[ox | Concel | | Hew |

- Type the parameter name in the Entry Name box.

- Select the parameter type from the Type drop down list.
- Type the parameter value in the Value box.
- Click OK.

10. Right-click the <SessionBeanName> node and select Save from the
shortcut menu.

© {1 EjbJars
@ Connectar_ID
[ Enlity Beans
§ (1 Sesslon Beans

MGIVVF Conpastn: : ‘
@ Manilor Modary
L1 Enfity Baangs 3
® [0 SessionB cpnem
Cleanupag
Clientagen]  Expand
CBBridga Collapse
EvaniProce operties
Hotification) o ,
? '-'-MDI_L?'I}I‘IHE(.IDI Hirfiesh
] Entity Beat  Help
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5.1.2.4 Adjusting the BootstrapServiet Parameter

Add the monitor.indirectEjbCall parameter to the BootstrapServlet parameters
list:

1. Expand the Applications tree and select IBM_WBI_Monitor \ Web
Apps \ MonitorService \ Web Components \ BootstrapServlet

2. Right-click the BootstrapServlet node and select Modify from the
shortcut menu that appears.

@ [ Applications i
& |BM_WEI_Monitor v Gemeral | et
©-[1 EjbJars Initialization
[0 webspps
&= MonitorClient Kk

® MonitorSenice
@ 0 Web Components
BootsirapSendeat

{ JSer:url'r,'I:uI Bodify '

[ Application Clients) g

Expand

Collapse

Properties ¥
Refresh

Help

3. Select the Parameters tab on the right.

4. Click Add. The Add initialization parameter dialog box appears.

Endd initialization parameter X|

Hame

| ronitarindirectEjbCall |

Yalue

| hitpeitdiehSerertdamelimuonitorsenvice/BootstrapServlet |

Description

| »

1]

OK Cancel Help

Type monitor.indirectEjbCall in the Name field.

Type http://<WebServerName><MonitorServiceWebPath>/
BootstrapServlet in the Value field.

7. Click OK.
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8. Right-click the BoorstapServlet node and select Save from the shortcut

menu.

5.1.2.5 Deploying and Exporting the Modified Monitor
Enterprise Archive (.ear) File

& [ Applications
@ IBM_WBI_Manitor
® [ EjbJars
@ 1 WebApps

& MonitorClient
@ MonitorSemice
[ Web Components

§

BooteiranSands
3 Sel Modify
=i Ml:l|ll:3tll:l1 Save
Cancel
Expanil
Collapss
Properties
Refrosh
Halp

1. Right-click the IBM_WBI_Monitor node in the Applications tree and

select Deploy from the shortcut menu that appears.

P L0 Applications
@ |BMW_WBIL Monitor

o Modiy

2. Wait for the confirmation message that notifies you that the Application

IBM_WBI_Monitor was deployed appears in the Status Bar.

3. Select Selected > Export from the menu.
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E - Application Assembly Tool for z/05 and 05/390

File §EIE[:tEd| Build View Edit Filter Option
* * Modify 4 D ® Q
BPM -
—1 M Delete Cirl-Delete
4 &
9 =g
e
Export... 5
2ans
Goto

fnnitnrAnant

The Export Application dialog box appears.
Crowtapication x|

Enter the EAR file path name prefic

| DwWBIMOnitord 20 \servenservenmonitord| ear | Choose...

[ WabSphere for 205 Version 4.0 compatibie
| Cy———caT i——
[Lox | | concel | | Hei |

4. Make sure that the WebSphere for z/OS Version 4.0 compatible
check box is selected.

5. Enter the path and the name of the modified Monitor Enterprise Archive
(.ear) file, and then click OK.

(2% | Itis preferred to export the file with a new name (example:

4 monitord.ear) so that to distinguish it from the original file.
However, if you want to replace the original file, you can click
Choose and select the path and the name of the original file to
replace it.

The modified Monitor Enterprise Archive (.ear) file will be saved with the
specified name in the selected path.

5.1.3 Deploying IBM WBI Monitor

After modifying the Monitor Enterprise Archive (.ear) file, you are now ready to
start the IBM WBI Monitor deployment. The deployment steps are performed
using the Administration Tool of IBM WebSphere Application Server for z/OS
and OS/390, which is installed on a client machine that has Windows, AlX, or
Solaris as its operating system and connected to the S390 Mainframe where
the IBM WebSphere Application Server for z/OS and OS/390 is installed over a
LAN/WAN TCP/IP connection.

164 IBM WBI Monitor - Deployment Guide



The following sections describe in detail the deployment steps of the IBM WBI
Monitor on IBM WebSphere Application Server for z/OS and 0S/390.

5.1.3.1 Adding a New Conversation for the Monitor
Application Server

1. Start the Administration Tool of IBM WebSphere Application Server for z/
OS and 0S/390.

The Login dialog box appears

Erogn x|

Bootstrap server [P name
[os3g022

Port
[ann

Userid
[CEADMIN

Password

sy

2. Enter the name (or the IP address), port number, user Id, and password
of the WebSphere Server for z/OS and OS/390 on which you will deploy
the Monitor in the corresponding fields and then click OK.
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The Administration Tool's main window opens.

e
P ekt [l e Ot
T X d=o® BT

aldim

Sl

3. Right click the Conversations node in the left hand tree and select Add
from the shortcut menu that appears. The right area will display the
properties of the new conversation to let you enter the values of the
required properties.

i VebSphere Application Server Tor 205 and 05330 Admintstrathon

Fle Selected Build View Options Help

'D® BX =989 H.:iv%
¢ [ Conversations

- Cormer sations
13 tradel0
25 Tradedd . .
© ) BBOASRZ Server Definition F-CIMErEALON Nane:

Comsersation descripiion:

4. Enter <MonitorConversation> in the Conversation name field.

5. If you want to add a description for this new conversation, then enter the
description text in the Conversation description text box.

6. Click the Save button in the toolbar to save the new conversation.
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5.1.3.2 Creating the Monitor J2EE Resource

=Ly | If aprevious J2EE Resource has been created before and already

o points to the same DB2 location where the Monitor and
EventQueue databases exist, then you can use it instead of
creating a new J2EE Resource. In this case you don’t need to
perform the steps in this section.

2% | Important Note: Make sure that the J2EE Resource (either the new

o J2EE Resource that you will create or the one that has been
created before and you will use) must have JDBC Connection
Pooling enabled.

To create a new J2EE Resource:

1. Expand the Conversations tree and select Conversation >
<MonitorConversation> > Sysplexes > <SysplexName> >
J2EEResources.

2. Right click J2EE Resources and select Add from the shortcut menu
that appears. The properties of the new J2EE Resource appear on the
right.

| s Rk s L P Yt LT ——_______________ alois
Fie il (R Veew Oy
- W o= O® LT
(¥ oo pverssoens -
| sty
L4 Erepiami
¥ POCT

ol Peiittogliy]
=L Baryann Vi P w1y
= Eyviesy =
L ST Redeuroes
= BROAED a8 WE RERSURCE

& Legcal Brsburca Mappngi =
Ty Haigsati )i
"é Tradedi
":- W
o5 BROATES Sereer Cahinden

e e ey I 0 ey P [ e o ey
o, e e DR e See

e e 1 R
i ol Datalamm 8

[EECR Ly B e * e

3. Type Monitor in the J2EE Resource name field.
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Select DB2Datasource from the J2EE Resource type combo box.
Click the Save button in the toolbar.

Expand the Conversations tree and select Conversation >
<MonitorConversation> > Sysplexes > <SysplexName> >
J2EEResources > Monitor > J2EE Resource Instances.

Right click the J2EE Resource Instances and select Add from the
shortcut menu that appears. The properties of the new J2EE Resource
Instance appear on the right.

=

B il (Rl ew (g ey

o]
T -

il SIS nrvery

-

-
*

-

B.LY

S Reieuried
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Type Monitor in the Datasource instance name field.

Type the DB2 Location name (the DB2 Subsystem name) on which the
Event Queue and the Monitor databases exist in the Location Name
field.

10. Click the Save button in the toolbar.

5.1.3.3 Installing the New Monitor J2EE Application

1. Expand the Conversations tree and select Conversation >

<MonitorConversation> > Sysplexes > <SysplexName> >
J2EEServers > <MonitorJ2EEServerName>.

Right click the <MonitorJ2EEServerName> and select Install J2EE
application from the shortcut menu that appears.
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The Install J2EE application on Server: <J2EEServerName> dialog
box appears.

T vetall J2EE application on Server: BEOASR2 . x|
EAR Filaniarme | CMempimonitord ear | | Browse EARFile.. |
Destination FIP Server | 0533052 | [Z Passive FTP

Cancel | tew |

3. Enter the path and the name of the Monitor Enterprise Archive (.ear) file
that you have modified with the required parameters in the EAR
Filename field.

- You can click Browse EAR File to select the ear file name and path.

4. Keep the Destination FTP Server field and the Passive FTP check box
with there default settings.

5. Click OK. A message appears to tell you that the application contains
references to non existent resources.

6. Click OK. The Reference and Resource Resolution dialog box
appears.

T peference and Resource Resolution
[ 1BM_WWEBI_Moniior
® [ Monitar
& ciientagent
& Cleanupagent
& notilcationagent
& cwenProcessor
& CEEridge
& [ Conneclor_ID
& mowr Connector
& [ Whal_Connacior_ID —
& vaciconnector e
®= [ maonitorclient_¥WebApp jar
& [ monitors ervice_WebApp jar

comhobosofxmonitor.server.ejbs. CientAgen Bean

Mame | Type | J2EE Resource
ydbc Monitor DataSource javax.sglDatasSeurce

| Heip ot || sae | [ cancel |

7. Expand the IBM_WBI_Monitor tree and select Monitor > ClientAgent.
And do the following:

- Select the J2EE Resource tab and do the following:
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* Click the row cell of the J2EE Resource column that contain jdbc/
MonitorDataSource in the Name cell, and select Monitor J2EE
Resource from the drop down list.

JZEE Reszource

b
BEOASRZ_EJB_I
[BMHttpSessian
Maonitor

- Select the EJB tab and do the following:

[ 1BM_WBI_Monitor
& [ Monitar
.9 Chentagent
& Cleanupagent
& totifcationAgent
& EventProcessor
& CEBrdge
@ [ conneclor_iD
& WowWF Connector
@ C]WMal_Connactor_ID
& vavaiConnecior
& [ monitorclient_Wabspp.jar

Help

= peference and Resource Resolution

& 2 monitorsendce_Webdpp jar |

com.holosal:umaniton senerojbs.Cliont AgentBean

com.holosofmanttor.apl.clientapl. ClientagentHome

Remote Inferface Name:
com.hologsofe monftorapl clientapl ClientAgent

Type:

Session
JJNDI Path: :
It |
[mm holosofs mondor apl clientapl ClientAgentHorme |

| Set Defauit JNDI Path & Nome [originai] |

| Sl HFS SAFE Defaull JHNDI Path & Name [new] |

* Click Set Default INDI Path & Name to restore the default JINDI
path and name.

8. Repeat the previous step for the CleanupAgent, NotificationAgent,
EventProcessor, and DBBridge nodes under the Monitor node. Also
repeat the steps for the WMQIConnector node under the
WMQI_Connector_ID node, for the ICSConnector node under the
ICS_Connector_ID node and for the MQWFConnector node under the
Connector_ID node.

- For the MQWFConnector node select the Monitor J2EE Resource
from the drop down list for all existing rows in the table (three rows).

9. Select IBM_WBI_Monitor > monitorclient_WebApp.jar >
monitorclient_ WebApp from the tree and do the following:

- Select the EJB tab and do the following:
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[ IBM_WEI_Monitor

& & Monitor
& cieningen jratorence
# CleanupAgent
a Nmm,:a“umger“ m“m m
& EventProcessar com.ibm ws 380 we container RemolsWebAppHome
 oBendge Remote Interface Name:
¢ & connector_ID corm ibm ws 380w confainer RemoleWebApp
,ﬂ MCWF Connachor
& B Wmol_Connector_ID Type:
ﬂ WHQIConnactor Session
® [ monilarclianl_yWebApp jar JNDI Path: )
& monitorclient_WebApp [ S 034BB0ASRIEM_WBI_Manitordmonitorclisnt_WebAppmaonitor|
& ] monitarserice_WebApp.ja
S menisuetyies. S Wionie JHDI Hame:

[ |

| Set Default JNDI Path & Name [original] |

| SeUHES SAFE Defaut JNDIPath & ame [newr)|

[ o | [(smw | [oomen ]

* Click Set Default INDI Path & Name to restore the default INDI
path and name.

10. Repeat the previous step for the IBM_WBI_Monitor >
monitorservice_WebApp.jar > monitorservice_WebApp

11. Click OK and wait until the new J2EE application is installed and
deployed.

5.1.3.4 Adding the MQ Workflow Classpath and Library
Path

The last step you need to do before committing and activating the Monitor
conversation is to add the MQ Workflow Classpath and Library path in order to
be able to communicate with MQ Workflow. To do this:

1. Expand the Conversations tree and select Conversation >
<MonitorConversation> > Sysplexes > <SysplexName> >
J2EEServers > <MonitorJ2EEServerName>.

2. Right click the <MonitorJ2EEServerName> and select Modify from the
shortcut menu that appears.

The properties of the new J2EE Server appear on the right.
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4= Environment Editing Dialog x|

Lovel  Server 5 . X

3. Scroll the Properties page until you find the Environment Variable

List.
Emdronment variable list:
Level | Marne | Walue

__1/5RY BEOC_HTTP_PORT anay =
__35RY BEOC_SKIP_DESTROY... [YES g
__35RY S LOGFILE trphwebijvimn . log |
__45RY DBEZSQLIFROPERTIEE  [fetcidhZsgljjdbo propertie...
__A[5RY JaA ERTRA_OPTIONS |-Dmaonitor.security.mode...
__BISRY LIBFPATH fusrlppidb 2/db 271 0k,
__FSRY CLASSPATH fusrlppidh 2idb27 1 06clas..
ISP BEOLAMG EMLIS =

4. Double click the CLASSPATH environment variable. The Environment
Editing Dialog appears.

Name | CLASSPATH

Wariable Walue

usrlppido2fdb2T1 Diclassesidb2jclasses zip:
Mo alffrmc MOV 33 22bin sva 3 3200 meojaot jar

| he | | ok |

5. Inthe Variable Value text box do the following:

- Type a semicolon at the end of the last line if it is not ended with a one
and then press Enter to add a new line.

- In the new line, type the path and name of the MQ Workflow Library file
named fmcojagt.jar which is located in <MQ>/bin/java3320 if you have
IBM MQSeries Workflow v3.3.2 or in <MQ>/bin/java3400 if you have
IBM WebSphere MQ Workflow v3.4.

The added line should not end with semicolon ifitis thelastlinein

the box. Otherwise, you should type a semicolon at the end of this
added line.

- Click OK.
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6. Inthe Environment Variable List, double click the LIBPATH environment
variable. The Environment Editing Dialog appears.

2 Environment Editing Dialog EI
) - od S X
Level S
evel  Selvel | Add o0y Delete
Hame 'I_IBP.i.TH 'l

Variable Value

fusrippldb2idb2 71 Qdiby:
fusrlipplavaldi bin:
fusripphavaid i 3hinfclassic
fusripphvebSpheralib;
NocalfmeMWF3322

7. Inthe Variable Value text box do the following:

- Type a semicolon at the end of the last line if it is not ended with a one
and then press Enter to add a new line.

- In the new line, type the MQ Workflow installation path.

7% | The added line should not end with semicolon if it is the last line in
¥ the box. Otherwise, you should type a semicolon at the end of this
added line.

- Click OK. Then click the Save button in the toolbar.

5.1.3.5 Committing and Activating the New Conversation

Now you can start committing and activating the Monitor conversation you have
created. In order to do this:

1. Right click <MonitorConversation> in the Conversations tree and
select Commit from the shortcut menu.

Click OK on the confirmation message.

Wait until the Commit task is finished.

»

Right click <MonitorConversation> in the Conversations tree and
select Complete from the shortcut menu. A sub menu appears

Select All tasks from the sub menu.
Click OK on the confirmation message.

Wait until the Complete task is finished.

© N o O

Right click <MonitorConversation> in the Conversations tree and
select Activate from the shortcut menu. A sub menu appears

9. Click OK on the confirmation message.
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10. Wait until the Activate task is finished. The Status bar will display a

confirmation message that the conversation was activated.

5.1.3.6 Starting the WebServer and the Monitor

Application

Now the IBM WBI Monitor Application Server deployment procedure has
finished. You should now do these two steps in order to finalize and complete
the deployment:

1.

Start the Web Server that IBM WebSphere use (e.g. IBM HTTP Server).

If the Web Server was started then stop and restart it again.

2.

Start the newly deployed Monitor Application Server.

5.1.4 Finalize the Monitor Server Deployment

174

5.1.4.1 Initialize the Monitor Database

1.
2.

5.

Run a Web browser (such as MS Internet Explorer)
Type the following URL:
http://<WebServerName><WebPath>/admin

(eg. http://monitorsrvr/monitor/admin)

The Login Page appears

Enter the User ID and Password of a valid user. (Please refer to the WBI
Monitor Administration Guide for detailed information about the WBI
Monitor authentication and security options). The Administration Utility
Web page opens.

Initialize the Monitor Database tables by clicking the Create Database
button that exists in the Monitor Database Setup page. The initialized
tables must have been created previously using the DDL files named
monitorCreate.sql and eqCreate.sql that are located in the <Monitor>/
server/docs/ddl folder. Please refer to the section entitled Configure the
Database Server above in this chapter for details about configuring the
database server and creating the database tables.

Close the browser.

5.1.4.2 Importing Organization XML Files

You have to import the required organization XML files to the WBI Monitor
database in order to complete the deployment instructions.

Please refer to the WBI Monitor Administration Guide for the detailed
instructions of importing organization XML files.
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52 WBI Monitor Server Removal

This section is used to completely un-deploy the Monitor Server. To completely
un-deploy the Monitor perform the following steps:

1.

10.

11.
12.
13.

14.
15.
16.
17.

Start the Administration Tool of IBM WebSphere Application Server for z/
OS and 0S/390.

The Login dialog box appears

Enter the name (or the IP address), port number, user Id, and password
of the WebSphere Server for z/OS and OS/390 on which you will deploy
the Monitor in the corresponding fields and then click OK.

The Administration Tool's main window opens.

Right click the Conversations node in the left hand tree and select Add
from the shortcut menu that appears.

The right area will display the properties of the new conversation to let
you enter the values of the required properties.

Enter <MonitorConversation> in the Conversation name field.

If you want to add a description for this new conversation, then enter the
description text in the Conversation description text box.

Click the Save button in the toolbar to save the new conversation.

Expand the Conversations tree and select Conversation >
<MonitorConversation> > Sysplexes > <SysplexName> >
J2EEServers > <MonitorJ2EEServerName> > J2EEApplications >
IBM_WBI_Monitor.

Click the Delete button in the Toolbar (identified by a red X), or select
Selected > Delete from the menu, or right click IBM_WBI_Monitor and
select Delete from the shortcut menu that appears. A confirmation
message appears.

Accept the confirmation message. a red cross will appear next to
IBM_WBI_Monitor in the tree.

Right click <MonitorConversation> in the Conversations tree and
select Commit from the shortcut menu.

Click OK on the confirmation message.
Wait until the Commit task is finished.

Right click <MonitorConversation> in the Conversations tree and
select Complete from the shortcut menu. A sub menu appears

Select All tasks from the sub menu.
Click OK on the confirmation message.
Wait until the Complete task is finished.

Right click <MonitorConversation> in the Conversations tree and
select Activate from the shortcut menu. A sub menu appears
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18. Click OK on the confirmation message.

19. Wait until the Activate task is finished. The Status bar will display a
confirmation message that the conversation was activated.
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PART

1V

Upgrading your EXxisting
Version of WBI Monitor to
the Recent Version
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Chapter 6: Upgrading your Existing
Version of WBI Monitor to

the Recent Version

This chapter contains the required information about upgrading your existing
version of WBI Monitor (WBI Monitor v4.2.4 Fix Packl, or WBI Monitor v4.2.4
Fix Packl HotFix) to the recent version (WBI Monitor v4.2.4 Fix Pack?2). This
includes replacing the deployed version of WBI Monitor application on
WebSphere Application Server with the new version, as well as upgrading the
existing Monitor database that already contains data stored in its tables to
adhere to the latest modification in the recent version of WBI Monitor database,
and migrate the stored data to the upgraded database.

The WBI Monitor upgrade must be performed in the following sequence:

1. Un-deploy the existing version of WBI Monitor Server completely from
the WebSphere Application Server. On Windows, AlIX and Solaris
platform, you can perform the un-deployment either automatically or
manually. On z/OS and OS/390 platforms you can only perform the un-
deployment manually.

[z%_ | Refer to the section entitled WBI Monitor Server Un-Deployment in

& Part 2 - Chapter 2: WBI Monitor Installation of this guide for the
detailed steps of automatic un-deployment of WBI Monitor Server.
Refer also to the section with the same title in Appendix A: and
Appendix B in Part 2 of this guide for the detailed steps of the
manual un-deployment of WBI Monitor Server. Refer to the
section entitled IBM WBI Monitor Deployment on OS/390 and z/OS
Platforms in Part 3 of this guide for the un-deployment steps.

2. Backup your existing Monitor database.

3. Perform the Database Migration and Upgrade after completely un-
deploying the existing version of the Monitor Server, in order to upgrade
the existing database and its data to this version. The existing database
must be of the previous version of the WBI Monitor (v4.2.4 Fix Pack?2). If
the existing database belongs to an earlier version before the stated
version, then the upgrade must be done incrementally step by step from
each version to its next version.

To perform the database upgrade, run the appropriate SQL file that
exists in the migration\SQL folder as the following:
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- For IBM DB2 database on Windows, AlX, and Solaris platforms run the
file named DB2.sql.

- For IBM DB2 database on OS/390 and z/OS platforms run the file
named DB20S390.sq|

- For Oracle database on Windows, AlX, and Solaris platforms run the
file named ORACLE.sql.

Before running these files, you should edit them in order to change the
variable named $SCHEMA$ with the actual name of the tables schema
in each occurrence in the files.

4. Install the new version of WBI Monitor and Deploy the WBI Monitor
Server that belongs to the new version of WBI Monitor after completing
the upgrade and migration of the database.

Refer to the section entitled WBI Monitor Server Installation and
deployment in Part 2 - Chapter 2: WBI Monitor Installation of this
guide for the detailed steps of automatic deployment of WBI
Monitor Server. Refer also to Appendix A and Appendix B in Part 2
of this guide for the detailed steps of the manual deployment of
WBI Monitor Server. Please refer to the section entitled IBM WBI
Monitor Deployment on OS/390 and z/OS Platforms in Part 3 of
this guide for the deployment steps.
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Glossary
A

Activity

One of the steps that make up a process model. This
can be a program activity, process activity, or block
activity. It is also one of the building blocks that con-
stitute a process model

Activity Instance Manager
The module that handles all functions related to the
Activity instances data

Administration Sessions

The sessions Enterprise Java Beans (EJBs) are used to
administrate the Monitor server. They handle cleanup
of the Monitor database, security, and the import of
the .org modeling data from IBM WebSphere Busi-
ness Integration (WBI) Workbench™.

Administration Utility

A Web-based client that allows users to start the Event
Queue triggers and create the Monitor and Event
Queue database tables.

API, Application Programming Interface.
An interface provided by the MQ Series Workflow
manager that enables programs to request services
from the MQ Series Workflow manager. The services
are provided synchronously.

Application Server

A server-side program that runs on a distributed net-
work computer. It provides the business logic for an
application program. The application server is usually
considered as part of a three-tier application, consist-
ing of a graphical user interface, an application (busi-
ness logic) server, and a database.

Arrival Time
The timestamp at which a Job has been created.

Auto Cleanup

A Functionality in the Cleanup Utility that allows the
application to automatically perform the process
instances and history data cleanup on a periodical
basis
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B

Buildtime

An MQ Series Workflow component with a graphical
user interface for creating and maintaining workflow
models, administering resources, and the system net-
work definitions.

Business Measures

Measures that allow users to evaluate the performance
of the business process while running. There are two
types of measures: those predefined by WBI Work-
bench such as cost and duration and User-defined
ones.

C

Client Sessions

The sessions Enterprise Java Beans (EJBs) handle the
communication with Monitor and Business Monitor
client.

Completion Time
The timestamp at which a Job has been completed.

Container Data
The input /output data of an activity or process.

D

Data Connectors

Connections drawn between tasks in the process dia-
gram. They determine the flow of data from an origi-
nating Task Object or Process Object to a target Task
Object or Process Object respectively.

Data Container
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Storage for the input and output data of an activity or
process. See input container and output container.

Data Structure

A named entity that consists of a set of data structure
members. Input and output containers are defined by
reference to a data structure and adopt the layout of
the referenced data structure type.

DB2

It is an IBM’s universal database management system
used by MQ Workflow and WBI Monitor to store pro-
cess models and process-relevant data.

Decisions

An internal or external environmental condition (e.g.,
an event, a specification, or a standard) that affects a
Business Process. A Decision is the question that is
asked to determine the exact set of activities during
the execution of a Process. For example, a question
might be “What type of order?” or “How will the
order be shipped?” A Decision is represented by a
Decision Object in an Activity Decision Flow Dia-
gram. There are two types of Decision Objects:
Binary and Multiple.

Delay Status

The status of the current process that is based on its
number of jobs, which are delayed as opposed to the
number of jobs, executed on time.

E

Elapsed Duration
The Elapsed Duration of the Process Instance or
Activity Instance.

Entreprise Java Beans (EJBs)

Enterprise Java Beans (EJB) is an architecture for set-
ting up program components written in Java that run
on the server side of a computer network that uses the
client/server model.

Event

A message that comes from MQ Workflow to indicate
a change in the Workflow entities, and their states.
Examples of event types are ‘Process Started’, ‘Activ-
ity instance ready’, “Work item created’, ‘Process
completed’.
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Event Collector Triggers

They are the triggers that get installed on the MQ
Workflow database to collect the events of the con-
tainer data and store them in the Monitor Event Queue
tables to be processed later by the Monitor Engine.

Event Queue

The event queue is implemented as three database
tables in DB2 that hold the event records to be picked
up later by the Monitor Service for event processing.

Event Queue Manager

A program that handles the Event Queue filled in by
triggers; reads the event and process data, processes
events, and deletes them from the database.

-

FDL File: MQ Series Workflow Definition
Language.

The language used to exchange MQ Series Workflow
information between MQ Series Workflow system
groups. It is used by the Import and Export function of
MQ Series Workflow and contains the workflow defi-
nitions for staff, programs, data structures, and topol-
ogy. This allows non-MQ Series Workflow
components to interact with MQ Series Workflow.
See also export and import

H

Head Unit
The Organization Unit to which another Organization
Unit reports.

History Data

The high-level information calculated based on the
Instances data, which represent business measures
associated with a process

IBM MQSeries Workflow
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A Workflow application developed by IBM that
allows users to automate, manage and control their
business processes.

Import

An MQ Series Workflow utility that accepts informa-
tion in the MQ Series Workflow definition language
(FDL) format and places it in an MQ Series Workflow
database.

J

Java Database Connectivity (JDBC)
The mechanism by which Java code interfaces with a
Database.

Job ID
The Workflow name of a Job or Process Instance.

M

Monitor Client

A Java client used on the enterprise network that
allows business analysts to monitor the business pro-
cesses at run time.

Monitor Data Model

A layer that grants access to the database data through
Java Database Connectivity (JDBC) of the Monitor
Server. All Monitor Database SQL statements are
encapsulated in this layer.

Monitor Databases Tables

Tables that store two types of information. The first
type is the information captured from the process
model, such as the Process Activity Flow Diagram,
that will be displayed during run time, the data associ-
ated with tasks such as User ID, Task or Activity
name, Estimated Duration, etc, and Business Mea-
sures associated with the process model. The second
type of information is that which is processed or
deduced from the run time data captured from the
Workflow database.

Monitor Engine
A module that handles the events coming from MQ
Workflow. It picks up the events, processes them, and
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stores the result in the Database for later retrieval by
the clients. Processed events are deleted after process-

ing.

Monitor Event Queue Tables

Tables that store the events together with the container
data triggers that are installed on the MQ Workflow
database.

Monitor Import Utility

A Java client that allows users to open the Organiza-
tion Folders containing the processes they want to
monitor as well as the Business measures they have
defined in WBI Workbench. They can select these
measures, and import them to the Monitor Server.

Monitor Server

The server that handles all the back-end operations of
the four User Clients. These clients control the
cleanup of the Monitor database, security, and the
import of the .org modeling data. The Monitor server
also handles the communication with user clients, the
events coming from MQ Workflow and the data
access encapsulation of the SQL statements.

Monitor User Clients

The four Monitor User Clients that allow users to take
all the necessary steps to monitor the business pro-
cesses they have developed models for, and their asso-
ciated Business Measures.

Monitoring API

A client layer that handles all the client/server com-
munication and hides the details of the monitor server
from the user clients.

N

Notification Duration

The maximum duration allowed for a process instance
before a notification is issued. This duration is
decided upon the data obtained from the Process
model that has been created using the WBI Work-
bench and imported to the Monitor Server along with
the Organization file. The value of the Notification
Duration is entered by the Modeler in WBI Work-
bench, in the Notification tab of the Task Object dia-
log box.
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O

Organization

An administrative unit of an enterprise. Organization
is one of the criteria that can be used to dynamically
assign activities to people. See child organization and
parent organization.

Organization Files
Files created by WBI Workbench They contain all
process and repository data the user has entered.

Organization Folders

Folders created by WBI Workbench that enclose all
process files, Organization files, and other related
files.

Organization Unit
The subdivisions in an Organization. Organization

Unit can represent departments, divisions, or sections.

Organization Unit Browser

A list that displays all imported Organization Units
into the Monitor Database to manipulate it with the
Cleanup utility

Organization Unit Manager

The name of the Manager of the selected Organization
Unit that is entered by the user in the Organization
Unit dialog box in WBI Workbench.

Overloaded

The status of the user performing the Work Items. The
user is considered overloaded when there are more
than four work items in his/her own work list. Over-
loaded status is indicated in a color code.

P

Phi

An Activity Decision Flow Diagram object outputted
from one activity and/or inputted to the next one. This
object represents the data or product that is manipu-
lated or produced during the performance of a pro-
cess. The term “Phi” is derived from the Greek letter
phi (F) because it is made up of the letter | (for input)
superimposed over an O (for output).
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Process
A set of activities in an organization that are linked
together

Process Browser

A list that displays all imported Processes into the
Monitor Database to manipulate it with the Cleanup
utility

Process Instance
An instance of a process that is currently executed.

Process Instances data
The crude data associated with each process instance
created and stored in the WBI Monitor database.

Process Version

A version of a Process model that contains some
changes from the original Process Model. The Process
may have one (the original version) or more versions,
and each version has a certain date at which this ver-
sion became valid from.

Process Diagram
A graphical representation of a process that shows the
properties of a process model.

Process Elements

The objects within an Activity Decision Flow Dia-
gram, these being Tasks, Process Objects, Decisions,
Decision Choices, Phis, External Entity/Process, Go
To Obijects, Stops, and Connectors.

Process History Manager
The module that handles all functions related to the
Process history data.

Process Instance Manager
The module that handles all functions related to the
Process instances data

Process Instance or Job
An instance of a process that is currently executed.

Process Management

The MQ Workflow Run time tasks associated with
process instances. These consist of creating, starting,
suspending, resuming, terminating, restarting, and
deleting process instances.

Process Model.

A set of processes represented in a process model. The
processes are represented in graphical form in the pro-
cess diagram. The process model contains the defini-
tions for staff, programs, and data structures
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associated with the activities of the process. After
having translated the process model into a process
template, the process template can be executed over
and over again. Workflow model and process defini-
tion are synonyms.

Process Status
The status of a process instance.

Q

Queue Controls
Controls that provide the Event Queue database with
the Control Commands: Start and Stop.

Queue Status
The Event Queue status that could be either Started or
Stopped.

R

Repository Manager

The module that handles the import of the .org and
grants access to all the build-time entities defined in
the WBI Workbench.

Role

A responsibility that is defined for staff members.
Role is one of the criteria that can be used to dynami-
cally assign activities to people.

Running Status

The status of a Process Instance based on the number
of jobs of a process currently running as opposed to
the number of jobs that are ready to run.

S

Security Manager
The module that handles authentication and authoriza-
tions of the logged-in users.

Setup Manager
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The module that handles the creation and removal of
the Monitor tables and triggers.

Starting Time
The timestamp at which a job has been started.

Sub-Process
A subordinate process impeded in another one.

T

Task

An activity in a Business Process that is manipulated
by a specified Resource. Visually, Tasks represent the
lowest level of work you can portray in a Process.

Translate
The action that converts a process model into a Run-
time process template.

Tray

A graphical container represented by a yellow con-
tainer that shows the Work Items waiting to be pro-
cessed.

U

User
The employee who belongs to one of the Organization
Units in an organization.

User ID
An alphanumeric string that uniquely identifies an
MQ Series Workflow user.

W

WBI Monitor

WBI Monitor is a Java-based application developed to
allow users monitor and manage their business pro-
cesses that run on IBM MQ Workflow.

WBI Monitor database
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A database contains the process instances data and the
historical data

WBI Workbench

WBI Workbench is a Windows-based application
developed to allow users model, analyze, and manage
their business processes.

Web Client
An HTML client that allows users to monitor the busi-
ness processes at run-time.

WebSphere

A set of IBM Java-based tools that allow customers to
create and manage sophisticated business Web sites.
The central WebSphere tool is the WebSphere Appli-
cation Server (WAS), an application server that a cus-
tomer can use to connect Web site users with Java
applications or servlet.

Work Item
Representation of work to be done in the context of an
activity in a process instance.

Work Item Manager
The module that handles all functions related to the
Work items data.

Work Item Set Of A User
All work items assigned to a user

Work list
A list of work items assigned to a user and retrieved
from a workflow management system

Workflow
The sequence of activities performed in accordance
with the business processes of an enterprise.

Workflow Model
Synonym for process model

Working Duration
The Working Duration of the Process Instance or
Activity Instance
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Notices and Trademarks

US Government Users Restricted Rights - Use, duplication or disclosure restricted by GSA
ADP Schedule Contract with IBM Corp.

Notices

IBM may not offer the products, services, or features discussed in this document in all
countries. Consult your local IBM representative for information on the products and services
currently available in your area. Any reference to an IBM product, program, or service is not
intended to state or imply that only that IBM product, program, or service may be used. Any
functionally equivalent product, program, or service that does not infringe any IBM intellectual
property right may be used instead. However, it is the user’s responsibility to evaluate and
verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in
this document. The furnishing of this document does not give you any license to these
patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

The following paragraph does not apply to the United Kingdom or any other country
where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS I1S"...WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-
INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
Some states do not allow disclaimer of express or implied warranties in certain transactions;
therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are
periodically made to the information herein; these changes will be incorporated in new
editions of the publication. IBM may make improvements and/or changes in the product(s)
and/or program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only
and do not in any manner serve as an endorsement of those Web sites. The materials at
those Web sites are not part of the materials for this IBM product and use of those Web sites
is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate
without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling:
(i) the exchange of information between independently created programs and other programs
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(including this one) and (ii) the mutual use of the information which has been exchanged,
should contact:

WebSphere Business Integration Lab Director
IBM RTP Laboratory

3039 Cornwallis Road

P.O. BOX 12195

Raleigh, NC 27709-2195

US.A

Such information may be available, subject to appropriate terms and conditions, including in
some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are
provided by IBM under terms of the IBM Customer Agreement, IBM International Program
License Agreement, or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment.
Therefore, the results obtained in other operating environments may vary significantly. Some
measurements may have been made on development-level systems and there is no
guarantee that these measurements will be the same on generally available systems.
Furthermore, some measurement may have been estimated through extrapolation. Actual
results may vary. Users of this document should verify the applicable data for their specific
environment.

Information concerning non-IBM products was obtained from the suppliers of those products,
their published announcements or other publicly available sources. IBM has not necessarily
tested those products and cannot confirm the accuracy of performance, compatibility or any
other claims related to non-IBM products. Questions on the capabilities of non-IBM products
should be addressed to the suppliers of those products.

This information may contain examples of data and reports used in daily business operations.
To illustrate them as completely as possible, the examples may include the names of
individuals, companies, brands, and products. All of these names are fictitious and any
similarity to the names and addresses used by an actual business enterprise is entirely
coincidental.

All statements regarding IBM'’s future direction or intent are subject to change or withdrawal
without notice, and represent goals and objectives only.

COPYRIGHT LICENSE:

This information may contain sample application programs in source language, which
illustrates programming techniques on various operating platforms. You may copy, modify,
and distribute these sample programs in any form without payment to IBM, for the purposes
of developing, using, marketing or distributing application programs conforming to the
application programming interface for the operating platform for which the sample programs
are written. These examples have not been thoroughly tested under all conditions. IBM,
therefore, cannot guarantee or imply reliability, serviceability, or function of these programs.
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Programming interface information

Programming interface information, if provided, is intended to help you create application
software using this program.

General-use programming interfaces allow you to write application software that obtain the
services of this program'’s tools.

However, this information may also contain diagnosis, modification, and tuning information.
Diagnosis, modification and tuning information is provided to help you debug your application
software.

Warning: Do not use this diagnosis, modification, and tuning information as a programming
interface because it is subject to change.

Trademarks and service marks

The following terms are trademarks or registered trademarks of International Business
Machines Corporation in the United States or other countries, or both:

IBM MQSeries
the IBM logo WebSphere
AIX 0S/2

AlIX 5L 0S/390
e-Business (Logo) z/0S
CrossWorlds Rational
DB2 RS/6000
DB2 Universal Database XDE

Lotus is a trademark of International Business Machines Corporation and Lotus Development
Corporation in the United States, other countries, or both.

Rational is a trademark of International Business Machines Corporation and Rational
Software Corporation, in the United States, other countries or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

MMX, Pentium and ProShare are trademarks of Intel Corporation in the United States, other
countries, or both.

Solaris, Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

Other company, product or service names may be trademarks or service marks of others.
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